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The following text conventions are used in this document:
Convention | Meaning |
---|---|
boldface | Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary. |
italic | Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values. |
monospace | Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter. |
monospce italic | Monospace italic type indicates variables or user-supplied names. |
[ ] | Brackets enclose optional clauses from which you can choose one or none. |
The supporting files for the reports you will build are available on the Oracle Technology Network (OTN): on the Oracle Reports page (http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Index. In the Topic list, choose Building and Developing Reports; in the Collateral Type list, choose Examples, then click Search. In the list of topics that displays, find Building Reports sample files and click the Download icon to download a zip file, called buildingreports_examples.zip
. This zip file contains subfolders that correspond to the names of each chapter. Each of the subfolders contains all the supporting files (example reports, images, SQL query code, and so on) necessary for building the individual reports. Extract this zip file into ORACLE_HOME
\examples
(for example, D:\orawin\examples
).
Additionally, the remaining examples in Getting Started with Oracle Reports provide a Web-based selection of examples in this manual, as well as examples not covered in this manual.
The data sources used in this manual are:
The SCOTT, Human Resources, Sales History, and Order Entry schemas are available with the Oracle Database. You can contact your database administrator for more information on where to find these schemas. You can download the SQL scripts to install the Summit Sporting Goods (SUMMIT) schema from the Oracle Technology Network (OTN): on the Oracle Reports page (http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Index. In the Topic list, choose Building and Developing Reports; in the Collateral Type list, choose Tools/Utilities, then click Search. In the list of tools and utilities that displays, click the Download icon to download the SQL scripts to install the SUMMIT sample schema.
This chapter introduces the fundamental concepts of the 11g Release 1 (11.1.1) component of Oracle Reports. Each topic in this chapter is also included in the Basic Concepts section of the Oracle Reports online Help (see Section 4.1.1, "Using the Oracle Reports online Help").
Topics are grouped into the following sections:
The topics in this section discuss the features and functionality in Oracle Reports Builder.
Oracle Reports Builder is the report-building component of Oracle Reports, a powerful enterprise reporting tool that enables you to rapidly develop and deploy sophisticated Web and paper reports against any data source (including an Oracle database, JDBC, XML, and text files). Leveraging Java EE technologies such as JSP and XML, you can publish your reports in a variety of formats (including HTML, XML, PDF, spreadsheet, delimited text, PostScript, and RTF) to any destination (including e-mail, Web browser, Oracle Portal, and file system) in a scalable, efficient manner. Recognizing the differences between Web publishing and paper publishing, Oracle Reports Builder provides the power to develop high quality output for the Web and e-business requirements, as well as high-fidelity printed reports Oracle Reports Builder includes:
Oracle Reports 11g Release 1 (11.1.1) provides many new features and enhancements. The primary themes of this release are:
The chapter titled "Introduction" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual, available on the Oracle Technology Network details the new functionality in Oracle Reports 11g Release 1 (11.1.1), along with the equivalent 10g Release 2 (10.1.2) functionality, when applicable.
For additional information, see the Oracle Reports 11g page on the Oracle Technology Network.
The topics in this section discuss basic concepts of reports; for more advanced concepts, see Section 2.1, "Reports".
A report consists of objects that collectively define the report:
Using the Property Inspector, you define report properties. The document taxonomy (classification) properties (Title, Author, Subject, and Keywords) assist in cataloging and searching a report document.
When you first start Oracle Reports Builder, you can choose to open an existing report, create a new report using the Report Wizard, or create a new report manually.
Note: Source Control is disabled by default. Therefore, the Administration option on the File menu is always disabled. |
Using the Report Wizard, you can quickly and easily accomplish the steps to build a report for both Web and paper layouts:
If you choose to create a new report manually, Oracle Reports Builder creates a new default report definition for you. The first window you see is called the Object Navigator. This window displays a comprehensive list of report objects. Initially, it shows all objects that Oracle Reports Builder has created for you, as part of the report definition. As you define your report, the Object Navigator provides a central location to access and modify all objects in your report(s), including attached libraries, triggers, and program units. You can change the Object Navigator view to list objects hierarchically or by object type.
See also
With a focus on Web publishing, Oracle Reports has moved more fully into its role as a universal publishing solution. In prior releases, Oracle Reports Builder's Web feature simply displayed paper reports (that is, multiple pages) in HTML or PDF. This moves corporate data onto the Web, but also results in large and somewhat inflexible HTML pages.
While all the prior Web report functionality remains for paper-based reports (see Section 4.6.10, "Adding Web links to paper-based reports"), Oracle Reports can also use JavaServer Pages (JSPs) as the underlying technology to enable you to enhance Web pages with information retrieved using Oracle Reports Builder. This introduces the Web Source view of a report, and enables you to have both JSP-based and paper-based definitions in a single report. In other words, you can either publish your paper reports to the Web in various output formats, or take more advantage of Web features by adding JSP coding in the Web Source view. For example, you can create a report that has a paper PDF version and a JSP-based Web version; what you choose depends on your needs and whether you are able to produce the desired results more easily in the Web Source view or in the Paper Design view.
Oracle Reports also includes servlet technology. Servlets provide a Java-based alternative to CGI programs. Servlets provide a platform-independent method for building Web-based applications, without the performance limitations of CGI programs.
You can create a Web report in any of the following ways:
To preview your report output in a Web browser, use Program > Run Web Layout. This enables you to immediately see the effect of your changes on the output.
Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry keyHKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
See also
Section 1.9.4, "About Parameter Forms for Web reports"
Section 2.8.8, "About HTML and HTMLCSS output"
Section 2.8.10, "About PDF output"
Section 4.6.1, "Creating a Web report"
Section 4.7.16.4, "Displaying report output in your Web browser"
The topics in this section describe the built-in report styles in Oracle Reports Builder.
A tabular report is the most basic type of report. Each column corresponds to a column selected from the database.
See also
A group above report contains multiple groups in its data model. It is a "master/detail" report, where there may be a lot of information in the master group. For every master group, the related values of the detail group(s) are fetched from the database and are displayed below the master information.
See also
A group left report also contains multiple groups in its data model, dividing the rows of a table based on a common value in one of the columns. Use this type of report to restrict a column from repeating the same value several times while values of related columns change. The data model for group above and group left reports is the same, but the layouts differ; group above reports display the master information at the top while group left reports display break columns to the side.
See also
A form-like report displays one record per page, displaying field values to the right of field labels.
See also
A form letter report contains database values embedded in boilerplate text (any text that you enter or import into a Report Editor.)
See also
A mailing label report prints mailing labels in multiple columns on each page. Using the Report Wizard, you can specify the format for your mailing labels.
See also
A matrix (cross-product) report is a cross-tabulation of four groups of data:
Thus, to create a matrix report, you need at least four groups in the data model: one group must be a cross-product group, two of the groups must be within the cross-product group to furnish the "labels", and at least one group must provide the information to fill the cells. The groups can belong to a single query or to multiple queries.
A distinguishing feature of matrix reports is that the number of columns is not known until the data is fetched from the database.
With Oracle Reports Builder, you can create many different matrix reports. The four general types of matrix reports are simple matrix, nested matrix, multiquery matrix with break, and matrix break, but you are not confined to these designs.
For a detailed example, see Chapter 25, "Building a Matrix Report".
In building your matrix data model, you should consider the following:
Although matrix reports always require at least four groups, they can be built with any number of queries. If you build a matrix report with only one query (usually the most efficient structure), you must create at least three groups in addition to the one created by default. If you build a matrix report with multiple (three or more) queries, you still need to create at least one additional group. The figure below illustrates the two types of query structures that you can use for your matrix data model.
One advantage to a one-query data model is that the resulting report is generally more efficient than a report based on a multiquery data model.
Multiquery matrix. You may consider using a multiquery data model, as it often has simple queries and can be easier to maintain than the equivalent one-query data model. In addition, a multiquery data model is required for some types of matrices (for example, some nested matrix reports).
Matrix reports are built with four or more groups:
The following figure shows graphical representations of how groups are related for both single and multiquery data models.
Notice that for each data model the cross product group is represented by the large rectangle, while the dimension groups are the smaller rectangles enclosed by it, and the cell group is shown outside of the cross product group.
Creating a summary for a matrix requires more information than creating a summary for other kinds of reports. When you create summary columns for your matrix, you need to indicate the following:
In Oracle Reports Builder, you specify this information by setting the Product Order property for your summary. All summaries that are owned by the cross product group require that a Product Order be specified. Suppose that you have a matrix report that looks something like the one below.
This is a nested matrix report. Assume that group G_YEAR contains the YEAR column, G_DEPT contains the DEPTNO column, G_JOB contains the JOB column, and G_CROSS is the cross product group.
To create the summary of salaries by job that appears at the bottom of the matrix for each job, you create a summary column in G_CROSS with the following property settings:
These settings specify that the summary should be calculated for each job in the G_JOB group and the summary should be reset to zero for each job in the G_JOB group.
To create the summary of salaries by year which appears at the right of the matrix directly underneath the boilerplate lines, you create a summary column in G_CROSS with the following property settings:
These settings specify that the summary should be calculated for each year in the G_YEAR group and the summary should be reset to zero for each year in the G_YEAR group. To create the summary of salaries by year and department that appears at the right of the matrix for each department row of the matrix that contains a value, you create a summary column in G_CROSS with the following property settings:
These settings specify that the summary should be calculated for each record of G_DEPT within each record of G_YEAR. G_DEPT comes after G_YEAR in the Product Order because, in this report, it changes more frequently than G_YEAR. If G_YEAR changed more frequently (that is, years were listed for each department), it would make more sense to have a Product Order of G_DEPT, G_YEAR.
This summary is reset to zero for each record in the G_DEPT group. When you have multiple groups listed in Product Order and you want a non-running summary, the reset group should be the same as the last group in Product Order. When you have multiple groups listed in the Product Order and you want a running summary, the reset group should be a group other than the last one in the Product Order.
The figure below shows the objects that make up a simple, two-dimensional matrix. All of these objects are necessary for a matrix, except for the boilerplate field labels.
A matrix layout model must consist of the following layout objects:
Note: When running a JSP-based Web report that includes a matrix object, the JSP<rw:include> tag expects the matrix object to format on only one page. However, if the cells in the across repeating frame expand, the column headers of the matrix may be forced onto a second page regardless of the page size. Therefore, these matrix headers will not appear in the report output. Additionally, in this situation, the paper layout does not display correctly as header fields move to subsequent pages where the cell values remain on the first page. To resolve this, it is important to carefully define in the Report Editor the space available to the across repeating frame to allow for displaying the largest values, then set the Vertical Elasticity property of the across repeating frame to Fixed. |
The matrix object defines the intersection of at least two repeating frames. The repeating frames are the dimensions of the matrix and the matrix object contains the repeating frame that will hold the "filler" or values of the cell group. You need one matrix object for each pair of intersecting repeating frames in the layout. One of the repeating frames must have the Print Direction property set to Down and the other must have the Print Direction property set to Across in order to form a matrix.
For more details, see Section 2.3.7, "About matrix objects".
Usage notes
You can improve the performance of matrix reports with:
Note: Cross-product groups always cause "fetching ahead." The reason for this is that to cross-tabulate the data in a cross-product group, Oracle Reports Builder must first fetch all of the data. |
See also
Section 2.3.7, "About matrix objects"
Section 2.1.7, "About nested matrix reports"
Section 2.1.8, "About matrix with group reports"
Oracle Reports Builder includes wizards to help you quickly and easily define a report and add objects to it. The topics in this section describe each Oracle Reports Builder wizard.
The Report Wizard helps you to quickly and easily define a single-query report for both Web and paper layouts. Oracle Reports Builder uses what you specify on each page of the wizard to create a data model and layout for your report. After the wizard has created the report, you can modify it using the Report Editor views. See Section 1.6.1, "About the Report Editor".
Re-entrancy
To re-enter the Report Wizard for an existing report:
Using the Report Wizard
For help on the fields on any tab page of the wizard, click Help at the bottom of the tab page.
The Report Block Wizard is a version of the Report Wizard. You can open an existing HTML document (Web page) and imbed a report in your Web page using the Report Block Wizard to specify the layout of the data.
Access
To display the Report Block Wizard:
Using the Report Block Wizard
For help on the fields on any tab page of the wizard, click Help at the bottom of the tab page.
The Data Wizard helps you to quickly and easily define a query, break groups, and totals for a multiquery report. After the wizard has created the data model, you can:
Access
To display the Data Wizard:
Note: The Data Wizard does not support creating links between queries. To define parent/child query relationships, you can create a data link manually. |
Re-entrancy
To re-enter the Data Wizard for an existing query, do either of the following:
Using the Data Wizard
For help on the fields on any tab page of the wizard, click Help at the bottom of the tab page.
The Graph Wizard provides an easy way for you to add a wide variety of graphs to both paper-based and JSP-based Web reports. Oracle Reports Builder uses the information you specify on each page of the wizard to create an XML definition that describes the graph and renders to resulting look-and-feel of the graph at runtime.
For more information, see Chapter 39, "Building a Report with Graphs".
The topics in this section discuss the Object Navigator in Oracle Reports Builder.
The Object Navigator provides a hierarchical display of all objects in a report or template, including attached libraries and program units.
Using the Object Navigator, you can:
Access
To display the Object Navigator:
See also
Section 4.2.4, "Setting preferences for the Object Navigator"
The Object Navigator enables you to view objects by ownership hierarchy or by object type.
See also
Section 4.2.4, "Setting preferences for the Object Navigator"
The topics in this section discuss the Report Editor and its different views of a report.
The Report Editor is a work area in which you can manipulate the objects in your report directly or by changing properties in the Property Inspector. In the Report Editor window, you can navigate between different views of your report: the Data Model view, Paper Layout view, Paper Design view, Paper Parameter Form view, and Web Source view.
Note: By default the File > Administration option is always disabled. |
The Report Editor's Data Model view is a work area in which you create, define, and modify data model objects (queries, groups, queries, groups, formula columns, summary columns, placeholder columns, system and user parameters, and data links) to be used in your report. In this view, objects and their property settings are represented symbolically to highlight their types and relationships. To create the query objects for your data model, you can use the Report Wizard, Data Wizard, or the Query tools in the tool palette.
Oracle Reports Builder uses the data model to determine what data to retrieve for the report. The data retrieved from the database may or may not appear in the report output.
Access
To display the Data Model view:
The Report Editor's Paper Layout view is a work area in which you can modify the format of your paper report. The default format for your report is defined by the information you specify in the Report Wizard. You can modify the format by working with layout objects (boilerplate text and graphic objects, frames, repeating frames, graphs, fields, anchors, file links, and report blocks). In this view, objects and their property settings are represented symbolically to highlight their types and relationships.
The Paper Layout view is similar to the Paper Design view, in that it is a work area in which you modify the format of your report. However, the Paper Design view displays only when you run your report, allowing you to preview your report and manipulate the actual, or live, data at the same time. In the Paper Design view, you can customize reports interactively, meaning that you can see the results immediately as you make each change.
Access
To display the Paper Layout view:
The Report Editor's Paper Design view is a work area in which you can preview your paper report and manipulate the actual, or live, data at the same time. In the Paper Design view, you can customize reports interactively, meaning that you can see the results immediately as you make each change.
To edit your report, such as changing column size, the Paper Design view must be in Flex mode.
Access
The Paper Design view is displayed whenever you run a report. To run a report from the Object Navigator or any editor, click the Run Paper Layout button in the toolbar or choose Program > Run Paper Layout. To run a report from the Report Wizard, click Finish.
You can also display the Paper Design view in these ways:
Note: In the Object Navigator, there is no Paper Design node; this view is displayed only after running a report. |
Usage notes
To speed the execution of your report, avoid "fetching ahead" when sending report output to the Paper Design view. The following items can result in fetching ahead when referenced before the data on which they rely:
Matrix (cross-product) groups also cause fetching ahead. In order to cross-tabulate the data, Oracle Reports Builder must first fetch all of the data.
It should be noted that while these items slow down the Paper Design view, they do not affect performance when writing to a file or some other destination.
Note: A column can cause fetching ahead even if it is not displayed. For example, a grand total may not appear in the report output, but since it is in the report, fetching ahead may still occur when Oracle Reports Builder calculates it. |
The Report Editor's Paper Parameter Form view is a work area in which you define the format of the report's Runtime Parameter Form. To do this, you define and modify parameter form objects (fields and boilerplate). You can select pre-defined system parameters for your report using the Parameter Form Builder, or you can create your own.
When you run a report, Oracle Reports Builder uses the Paper Parameter Form view as a template for the Runtime Parameter Form. Fields and boilerplate appear in the Runtime Parameter Form exactly as they appear in the Paper Parameter Form view. If you do not define a Runtime Parameter Form in the Paper Parameter Form view, Oracle Reports Builder displays a default Runtime Parameter Form for you at runtime.
Note: At runtime, the Runtime Parameter Form displays only when running the paper report layout. For JSP-based Web reports, the Runtime Parameter Form displays when you run your report within Oracle Reports Builder for debugging purposes, but will not display at runtime. For more information, see Section 1.9.4, "About Parameter Forms for Web reports". |
Access
To display the Paper Parameter Form view:
The Report Editor's Web Source view displays the source code for your JSP-based Web report, including HTML, JSP, and XML tags. It is a Web page where you can view and add dynamic report blocks using the Report Block Wizard, and graphs using the Graph Wizard. Experienced Web developers can edit the Web source directly in this view using JSP tags, HTML, Java, and XML.
Access
To display the Web Source view, do any of the following:
Usage notes
uifont.ali
(in ORACLE_INSTANCE
\config\FRCommonComponent\
frcommon\guicommon\tk\admin
) as follows: [rwbuilder]
.....AR8MSWIN1256="Courier New"
.....CL8MSWIN1251="Courier New"
.....EE8MSWIN1250="Courier New"
.....EL8MSWIN1253="Courier New"
.....IW8MSWIN1255="Courier New"
.....JA16SJIS="MS Gothic"
.....TH8TISASCII="Andale Duospace WT"
.....TR8MSWIN1254="Courier New"
You can download a copy of the Andale Duospace WT (fixed-width) font from Metalink (http://metalink.oracle.com
). The ARU number is 2638552.
See also
Section 1.2.2, "About Web Reports"
Section 2.2.1, "About JavaServer Pages (JSPs) and servlets"
Section 4.6.3, "Adding report data to an existing Web page (HTML file)"
Section 4.6.4, "Adding a report block to a Web page"
Section 4.9.8.2.2, "Adding a graph to a JSP-based Web report"
"Oracle Reports JSP tags" in the Reference section of the Oracle Reports online Help
The tool palette and toolbar contain tools used to manually create or manipulate objects in the Report Editor views (excluding the Web Source view). Each tool appears as an icon. Some tools, such as the Select tool, are common to tool palettes in all Report Editor views. Other tools are specific to the views in which they appear. In Oracle Reports Builder, run your cursor over a tool to display the hint text that identifies the tool.
Tool palette
The tool palette is positioned along the left side of the Report Editor views. Click a tool to activate it for a single operation, or double-click a tool to "lock" it for multiple operations. You can hide the tool palette by choosing View > Tool Palette to deselect it.
Toolbar
The toolbar is positioned along the top of the Report Editor views. To use the tools in the toolbar, click the desired tool to perform the action. All toolbar tools also have menu equivalents. If the tool is designed to perform an action on a group of objects, it appears grayed out until one or more objects are selected. Then clicking the tool performs the action on the selected object(s).
See also
The topics in this section discuss basic concepts of data model objects; for more advanced concepts, see Section 2.3, "Data Model Objects".
Queries provide the data for your report. You create a query using the Report Wizard, Data Wizard, or manually using the query tools in the Data Model tool palette. Queries can select data from any data source (Oracle, XML, JDBC, Text, or your own data source that you can access through the pluggable data source (PDS) API). You can also use a REF CURSOR
to create queries (see Section 2.6.10, "About REF CURSOR queries").
Single-query reports
Reports built using one query are the simplest reports. The most popular formats for single-query reports are tabular, mailing label, form letter, and break (either group above or group left). In one report, you can display one query's data any number of times, even in different formats. You can query data without including it in the report output. This is useful for establishing relationships between multiple queries, performing calculations, and so on.
The figure below shows the data of one query formatted various ways.
Notice that the last report style (group left break) seems to use an entirely different query for its data than the first three. However, the data it displays was hidden in the other reports, and vice versa. With Oracle Reports Builder, you can query data without including it in the report output. This is useful for establishing relationships between multiple queries, performing calculations, and so on.
Multiquery reports
A report may contain any number of queries. Multiquery reports are useful when you want to:
SELECT
statements and joins can also be created with multiple simple queries that are linked; the latter are often easier for others to understand and maintain). If you create a report with multiple queries, you can either leave the queries unrelated, or establish a relationship between them using a data link.
Multipart unrelated query reports
If you do not link the queries, you will produce a multipart unrelated query report (commonly called a master/master report). These types of reports display lists of unrelated data. For example, in the report below, one query selects products and another selects customers. Notice that there is no relationship between the products and customers.
Multipart related query reports
In many reports, the data fetched for one part of the report is determined by the data fetched for another part. This is termed a "master/detail," or "parent/child," relationship, and is defined with a data link between two queries. When you run a master/detail report, each row of the master (or parent) query will cause the detail (or child) query to be executed, retrieving only matching rows.
Usage notes
Rationale
For a single-query report, Oracle Reports Builder opens only one cursor to fetch all of the master and detail records. For a two-query report, Oracle Reports Builder opens two cursors--one for each query--after appending the detail query's link to the WHERE clause of the detail query. Therefore, for each master record fetched in the master query, Oracle Reports Builder must rebind, execute, and fetch data from the detail query.
See also
Groups are created to organize the columns in your report. Groups can do two things: separate a query's data into sets, and filter a query's data.
When you create a query, Oracle Reports Builder automatically creates a group that contains the columns selected by the query. You create additional groups to produce break levels in the report, either manually in the Data Model view or by using the Report Wizard to create a group above or group left report.
Create groups when you want to treat some columns differently than others. For example, you create groups to:
With the exception of cross-product groups, all user-created groups are called break groups.
Break groups
You create break groups to produce subtotals, print columns in a different direction, create breaks, and so on. A break group suppresses duplicate values in sequential records. For example, Oracle Reports Builder can select the department number for each record; however, the duplicate department numbers are not printed.
Cross-product groups
You create cross-product groups to perform mathematical cross products, which are generally used to create matrix reports.
Group filters
Filters enable you to conditionally remove records selected by your queries. Groups can have two types of filters:
See also
Section 2.3.6, "About links versus groups"
Section 2.6.9, "About group filters"
Section 1.3.2, "About group above reports"
Section 1.3.3, "About group left reports"
Section 2.1.8, "About matrix with group reports"
Section 4.5.1, "Creating a report"
Section 4.5.2, "Creating a multiquery group above report"
A database column represents a column that is selected by the query, containing the data values for a report. For each column that you select in your query, Oracle Reports Builder automatically creates a column in the data model of your report. If you want to perform summaries and computations on database column values, you can create new columns manually in the Data Model view (for summary and formula columns) or by using the Report Wizard (for summary columns). You can also reassign one or more columns to a group or groups you have created.
In addition to the traditional column types (for example, date, number, character), Oracle Reports Builder also supports graphics or images columns, which are columns whose values can be:
See also
Section 4.8.1, "Creating a query"
Section 4.8.5, "Selecting an image from the database"
Section 2.3.4, "About referencing columns and parameters"
Section 2.3.1, "About summary columns"
A data link (or parent-child relationship) relates the results of multiple queries. A data link can establish these relationships:
A data link causes the child query to be executed once for each instance of its parent group. The child query is executed with the values of the primary key used by the parent.
When a report with a data link is executed, the data link is converted into a SQL clause (as specified in the link's Property Inspector) and appended to the child query if Oracle Reports Builder is able to parse the query.
Important note: If the query cannot be parsed, the query is not modified (for example, Oracle Reports Builder has no way to modify how the data is fetched when the query is defined for a pluggable data source).
Although links are commonly equijoins (for example, WHERE DEPTNO=DEPTNO
), you can create links with various SQL clauses (that is, WHERE
, HAVING
, or START WITH
) and conditions. If your database has database constraints, you can create a data link that derives its SQL clause and condition from the constraints. You can view the SELECT
statements for the individual parent and child queries in Oracle Reports Builder, but cannot view the SELECT
statement that includes the clause created by the data link you define.
Example
For the report below, the following link was defined:
The default group of the master query (containing the columns "Order ID" and "Customer") is the parent group; the detail query (the query to which "Item", "Product", and "Amount" belong) is the child query.
Note: Oracle Reports Builder does not support data links between queries that contain column objects. If you attempt to create such a link, a message dialog box displays, which enables you to choose whether to create a group-to-group query instead (using the parent groups), or to cancel the operation. If you want to create a link between any type of column and a column object, you can manually modify the SQL statement in the child query, adding in the appropriate WHERE clause based on columns in the master query. |
See also
Section 2.3.6, "About links versus groups"
Query Builder is an easy-to-use data access tool designed for analysts, managers, and other business professionals. It provides a logical and intuitive means to access information from your organization's databases for analysis and reporting.
Query Builder is designed for professionals who do not have a computer programming or database background. Because of its powerful query features and its support of Structured Query Language (SQL) statements, experienced database users and programmers will find that Query Builder serves many of their needs as well.
In Query Builder's graphical Query window, you can specify a request for data from your organization's database(s). The request for data is called a query.
You can use Query Builder to define almost any query that you would build using a SQL SELECT
statement. Query Builder automatically generates the appropriate SELECT FROM [table.column]
clause based on columns displayed in the Query Builder workspace.
See also
The topics in this section discuss basic concepts of layout objects; for more advanced concepts, see Section 2.4, "Layout Objects".
Frames surround other objects and protect them from being overwritten or pushed by other objects. For example, a frame might be used to surround all objects owned by a group, to surround column headings, or to surround summaries.
When you default the layout for a report, Oracle Reports Builder creates frames around report objects as needed; you can also create a frame manually in the Paper Layout view. See Section 1.6.3, "About the Paper Layout view".
Create frames when you want to:
Example: You want the top of each page to have a tabular format, but the bottom of each page to have a matrix format.
Example: A summary is centered under two repeating frames. Defaulting rules state that the summary must remain at a fixed distance from only the first object that can overwrite it; therefore, the summary is in danger of being overwritten by the second repeating frame. Enclosing both repeating frames with a frame will force the summary to maintain a fixed distance from both of them, and it will not be overwritten.
Example: A summary is centered under two repeating frames. According to defaulting rules, the summary will print as soon as the first repeating frame finishes printing. Create a frame around the two repeating frames to ensure the summary prints after both repeating frames have finished printing.
See also
Repeating frames surround all of the fields that are created for a group's columns. The repeating frame prints (is fired) once for each record of the group.
When you default the layout for a report, Oracle Reports Builder generates one repeating frame for each group in the data model, and places one field inside it for each of the group's columns. Repeating frames can enclose any layout object, including other repeating frames. Nested repeating frames are typically used to produce master/detail and break reports. For each record of the outer repeating frame, Oracle Reports Builder will format all related records of the enclosed repeating frame.
You can also create a repeating frame manually in the Paper Layout view. See Section 1.6.3, "About the Paper Layout view".
See also
For each object or record, a frame or repeating frame's size can be expandable, contractible, variable, or fixed (specified by the Horizontal Elasticity and Vertical Elasticity properties). For example, you can set the properties to specify that it should be fixed in size horizontally, but expand vertically if a record requires more space.
In the figure below, notice that there are four records for department 20, but only one record each for departments 10 and 30. The repeating frame has expanded vertically to accommodate department 20's additional records.
Frames or repeating frames that contract horizontally or vertically reduce in size when an object or record requires less space than the frame or repeating frame's initial size. A frame or repeating frame may also be variable in size: it expands or contracts based on the size of the value it displays. Also, if a frame or repeating frame is fixed in size and an object or record's data requires a larger field than it can contain, the remaining data will be pushed onto the following page(s) in the same x and y coordinates.
See also
Fields are placeholders for parameters, columns, and such values as the page number, current date, and so on. If a parameter or column does not have an associated field, its values will not appear in the report output. A field is owned by the object surrounding it, which is the first enclosing object (either a frame or repeating frame).
When you default the layout for a report, Oracle Reports Builder generates one field for each column, and places each field inside of a repeating frame. You can also create a field manually in the Paper Design view, Paper Layout view or Paper Parameter Form view.
Note: If you create a field object in a template, the field is renamed when the template is applied to a report. For example, if you create a field namedF_1 , the field is renamed to F_1_SEC2 when the template is applied to a report. Thus, if you reference F_1 in boilerplate (&F_1 ), these references will need to be updated. |
See also
Section 1.9.2, "About Parameter Form fields"
A boilerplate object is any text, lines, or graphics that appear in a report every time it is run.
Oracle Reports Builder creates one boilerplate object for each label selected in the Report Wizard (it is named B_columnname
). For example, if a column is named ENAME
, a boilerplate object containing ENAME
is generated for the column. For some report types, Oracle Reports Builder also generates lines under the labels.
You can also create a boilerplate objects manually in the Paper Design view, Paper Layout view, or Paper Parameter Form view using any of the following tools in the tool palette:
Boilerplate from files
If you have text, graphics, or HTML in a file that you would like to display as boilerplate in your report, you can link to the file, as described in the following procedures:
Linking to a file means that the contents of the file are pulled into the boilerplate object each time the report is run. In this way, you can ensure that your output includes the most recent changes to the file.
You can also link a boilerplate image object to a URL where the image is located. See Section 4.9.8.1.3, "Linking an image object to a URL".
Note: These procedures are for paper-based reports only. File Link objects are not implemented in JSP-based Web reports. |
See also
Section 1.9.3, "About Parameter Form boilerplate"
Section 4.9.2.1, "Creating a boilerplate object for text"
Section 4.9.2.2, "Creating a boilerplate object for text that displays every other page"
The topics in this section discuss basic concepts of Parameter Form objects; for more advanced concepts, see Section 2.5, "Parameter Form Objects".
A parameter is a variable whose value can be set at runtime (for example, from the Runtime Parameter Form or the command line). Parameters are especially useful for modifying SELECT
statements and setting PL/SQL variables at runtime.
Oracle Reports Builder automatically creates a set of system parameters at runtime, but you can create your own as well. You can create parameters to replace either single literal values or entire expressions in any part of a query. You can reference parameters elsewhere in the report, such as in PL/SQL constructs providing conditional logic for the report.
Note: While you can delete or rename a user parameter, you cannot delete or rename a system parameter. |
Parameter values can be specified in these ways:
Oracle Reports is shipped with the following system parameters. You can change their default values as described above.
Table 1-1 System parameter descriptions
System Parameter | Description |
---|---|
Is the number of report copies that should be made when the report is printed. | |
Is either:
| |
Is the name of the output device (for example, the file name, printer's name, mail user ID). | |
Is the type of device that will receive the report output (for example, | |
Is whether the report should run in | |
Is the print direction for the report ( | |
Is whether the Print Job dialog box should appear before the report is run. |
User parameters
You can create a user parameter in the following ways:
See also
Section 2.3.4, "About referencing columns and parameters"
Section 4.11.1, "Using a pre-defined system parameter"
Section 4.11.2, "Creating a user parameter"
Section 4.11.3, "Creating a list of values (LOV) for a parameter"
Section 4.11.4, "Validating a parameter value at runtime"
Section 4.11.6, "Selecting parameters to include in the Runtime Parameter Form"
Section 4.11.9, "Passing parameters to reports running in batch mode"
Fields in the Paper Parameter Form view (Section 1.6.5, "About the Paper Parameter Form view") act as placeholders for parameters. They define the formatting attributes for the parameters displayed in the Runtime Parameter Form. By default, one field is created for each parameter that you select in the Parameter Form Builder.
See also
Boilerplate in the Paper Parameter Form view refers to text and graphics that appear in the Runtime Parameter Form each time it is run; for example, a label denoting a particular parameter is boilerplate text created by Oracle Reports Builder. Lines or boxes that you create in the layout are also considered boilerplate, as well as any added text.
Boilerplate enables you to customize the Runtime Parameter Form. By default, a boilerplate label is produced for each field that appears on the Runtime Parameter Form.
See also
Section 1.8.5, "About boilerplate objects"
You can design a Parameter Form for both Web and paper reports. However, at runtime, the Runtime Parameter Form displays only when running the paper report layout. For JSP-based Web reports, the Runtime Parameter Form displays when you run your report within Oracle Reports Builder for debugging purposes, but will not display at runtime.
Because you now have the flexibility to display your reports on any Web page, the report may be just one object on a Web page containing many other portlets and objects, and parameters for the report may be retrieved from sources other than the Parameter Form. For example, parameters might be provided by the Web page to all portlets on the page. Therefore, it does not make sense to display a Runtime Parameter Form for JSP-based Web reports before the report is formatted.
In the absence of the Runtime Parameter Form, you will need to use an alternate method to provide required parameters to a JSP-based Web report designed with a Parameter Form. For example:
<rw:reports id="
myReport
" parameters="
yourParameterList
">
, where yourParameterList
can be a Java variable. For example: For more information on creating a Parameter Form for a JSP-based Web report, see Chapter 42, "Building a Simple Parameter Form for a JSP-based Web Report".
Note: If you display your paper-based report on the Web, you can create an HTML Parameter Form by adding HTML header and footer tags using either: |
See also
Section 1.2.2, "About Web Reports"
Section 1.6.5, "About the Paper Parameter Form view"
The topics in this section discuss the Property Inspector in Oracle Reports Builder.
The Property Inspector is a window that enables you to access the properties of the currently selected object(s) in the Object Navigator, Report Editor, and Template Editor.
Every Oracle Reports Builder object (query, group, frame, parameter, and so on.) has associated properties that can be viewed using the Property Inspector. To get help on any property, click the property in the Property Inspector and press F1.
You can select multiple objects at the same time by using Shift+Click or Ctrl+Click in the navigators or the editors. When two or more objects are selected, a list of object names is displayed at the top of the Property Inspector.
The Intersection/Union button on the Property Inspector toolbar determines which properties are displayed in the property list when more than one object is selected. Toggling between Intersection and Union changes the list of properties displayed in the Property Inspector, but does not affect the setting of any property.
Table 1-2 Property Inspector Intersection/Union
Button | Description |
---|---|
Intersection | The default. Only properties common to all selected objects are displayed. |
Union | All properties of every object selected are displayed. |
Properties that are common to two or more objects in a multiple selection are listed only once, and the property setting is displayed as follows:
See also
Section 4.2.2, "Setting report properties"
Section 4.2.5, "Setting properties for an ASCII (character-mode) report"
Section 4.2.7, "Setting properties of multiple objects"
Section 4.2.8, "Comparing the properties of one object to another"
The topic in this section discuss the views of a report shown at runtime.
The Runtime Parameter Form is a dialog box that optionally displays at runtime in which you can override default parameter values (for example, values that modify SELECT
statements, route the report output to a specified device, and so on). You define the format of the Runtime Parameter Form in the Paper Parameter Form view. If you do not define a Runtime Parameter Form in the Paper Parameter Form view, Oracle Reports Builder displays a default Runtime Parameter Form for you at runtime.
Change the parameters as desired and then click the Run Paper Layout button in the toolbar to run the report.
Alternatively, you can click the Cancel Run button in the toolbar to cancel.
See also
Section 1.6.5, "About the Paper Parameter Form view"
The Previewer displays on your screen how the printed version of your report will look. In the Previewer, you can scroll though a single page of report output, page through the entire report, and split the screen to view different sections of the same report concurrently. You can also perform the following actions:
Table 1-3 Print previewer actions
To... | Click in the toolbar... |
---|---|
Print the report | the Print button |
Specify page setup settings | the Page Setup button |
Open a new Previewer | the New Previewer button |
Close the Previewer | the Close Previewer button |
Zoom in | the Zoom In button |
Zoom out | the Zoom Out button |
A physical page (or panel) is the size of a page that will be output by your printer. A logical page is the size of one page of your actual report (it can be any number of physical pages wide or long). The Previewer displays the logical pages of your report output, one at a time.
Access
To display the Previewer:
Usage notes
To speed the execution of your report, avoid "fetching ahead" when sending report output to the Previewer or Paper Design view. The following items can result in fetching ahead when referenced before the data on which they rely:
Matrix (cross-product) groups also cause fetching ahead. To cross-tabulate the data, Oracle Reports must first fetch all of the data.
It should be noted that while these items slow down the Previewer or Paper Design view, they do not affect performance when writing to a file or some other destination.
Note: A column can cause fetching ahead even if it is not displayed. For example, a grand total may not appear in the report output, but since it is in the report, fetching ahead may still occur when Oracle Reports calculates it. |
See also
Section 4.7.16.3, "Displaying report output in the Previewer"
The Oracle Reports components are:
Table 1-4 Oracle reports Component Descriptions
All components listed in Table 1-4, except rwclient
and rwserver
, can be run from the command line. See the Reference > Command Line section of the Oracle Reports online Help for detailed information about the components and command line keywords. Refer to Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services for information about managing and monitoring Reports Server, Reports Tools and Oracle Reports Bridge through Oracle Enterprise Manager or OPMN commands.
See also
This chapter introduces the concepts for advanced users of Oracle Reports. Each topic in this chapter is also included in the Advanced Concepts section of the Oracle Reports online Help.
Topics are grouped into the following sections:
The topics in this section build on the basic concepts discussed in Section 1.2, "Reports".
You can add a title to a report in either of the following ways:
When you use the Report Wizard to add a title and do not select a template for your report output, the title is inserted into the margin of the report with default attributes defined by Oracle Reports Builder. You can modify the attributes in the Paper Layout view.
When you use the Report Wizard to add a title, and do select a predefined template or a user-defined template file for your report output, Reports Builder looks for a boilerplate text object named B_OR$REPORT_TITLE
defined for the selected template:
B_OR$REPORT_TITLE
exists, the title is displayed using the attributes of this object, with the text you typed in the Report Wizard. B_OR$REPORT_TITLE
is not found, the title is displayed using the attributes defined by the Default properties (under the Title node in the Property Inspector) of the selected template. Note: If you do not specify a title in the Report Wizard, theB_OR$REPORT_TITLE object is not copied to your report. |
For layouts created using the Report Block Wizard, the title is inserted into the new layout as a group title rather than into the margin of the report. In this case, the attributes are set per the Default properties (under the Title node in the Property Inspector) of the selected template, and B_OR$REPORT_TITLE
is ignored. If you do not select a template, the title uses the default attributes defined by Oracle Reports Builder.
See also
Section 4.5.6, "Adding a title to a report"
Report sectioning enables you to define multiple layouts in the same report, each with a different target audience, output format, page layout, page size, or orientation. You can define up to three report sections, each with a body area and a margin area: the names of the sections are Header, Main, and Trailer. By default, a report is defined in the Main section. In the other sections, you can define different layouts, rather than creating multiple separate reports. If you wish, you can use the margin and body of the Header and Trailer sections to create a Header and Trailer page for your reports.
In the Object Navigator, the report sections are exposed in the Object Navigator under the Paper Layout node as Header Section, Main Section, and Trailer Section.
You can specify the order in which the three sections of a report (Header, Main, and Trailer) are formatted using SRW.SET_FORMAT_ORDER
or the Format Order of Sections property. This capability allows Oracle Reports to format any section first to create information that is only known at the time of formatting, such as page numbers, then use that information in the formatting of another section. As an example, this property can be used to create a table of contents. For an example of using SRW.SET_FORMAT_ORDER
for this purpose, see Chapter 35, "Building a Paper Report with a Simple Table of Contents and Index" and Chapter 36, "Building a Paper Report with a Multilevel Table of Contents".
For an example of using section-level distribution, see Chapter 37, "Bursting and Distributing a Report". This chapter covers defining distribution of a single section to multiple destinations, using the Repeat On property and a sample distribution XML file. For information about advanced section-level distribution and creating your own distribution XML file, see the chapter "Creating Advanced Distributions" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services .
Examples
Example 1
You can use sectioning and distribution to publish your report output in HTML, and also send a PostScript version to the printer.
Example 2
You can send an executive summary of the report to senior management, and also e-mail detailed breakdowns to individual managers. In this example, a single report with two report sections needs to be created: a portrait-sized summary section and a landscape-sized detail section. Use the Repeat On property to associate the detail section with a data model group that lists the managers and then alter the destination on each instance of the data model group to send the output to the appropriate managers.
See also
Section 2.8.3, "About report distribution"
A report can be defined using inches, centimeters, or points. The unit of measurement is independent of the device on which you build the report. As a result, you can design reports that will run on any platform on which Reports Builder runs. You can change a report's unit of measurement in these ways:
A report page can have any length and any width. Because printer pages may be smaller or larger than your paper report's "page," the concept of physical and logical pages is used. A physical page is the size of a page that is output by your printer. A logical page is the size of one page of your report; one logical page may be made up of multiple physical pages.
For each section (header, main, trailer) of a report:
In this example, one logical page is made up of six physical pages. The logical page is three physical pages wide and two physical pages high. Consequently, Horizontal Panels per Page size is 3 and Vertical Panels per Page size is 2. If you wanted the logical page to be two physical pages wide and three physical pages high, you would specify a Horizontal Panels per Page size of 2 and a Vertical Panels per Page size of 3.
For detailed information about using and adding fonts in Oracle Reports, including font configuration files, font aliasing, troubleshooting font issues, and font types, refer to the chapter "Managing Fonts in Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
Using the Conditional Formatting and Format Exception dialog boxes, you can specify output formatting attributes (font and color) for a selected layout object based on conditions that exist. The conditions that you define are called format exceptions.
You can display the Conditional Formatting dialog box from the Paper Layout view or Paper Design view in any of the following ways:
The Format Exception dialog box displays when you click New or Edit in the Conditional Formatting dialog box, and enables you to quickly and easily specify output formatting attributes for a selected layout object based on defined conditions. After you specify conditions and formatting for the current layout object in the Format Exception dialog box, the entire definition is exported to a PL/SQL format trigger. If a format trigger already exists for the layout object, the definition in the Format Exception dialog box overwrites the existing trigger code when you confirm the Oracle Reports Builder prompt.
You can edit the format trigger manually through the PL/SQL Editor; however, if you subsequently modify the definition using the Format Exception dialog box, Oracle Reports Builder displays a prompt to overwrite the existing format trigger.
See also
Section 4.9.1.5, "Applying conditional formatting to a layout object"
A nested matrix report is a matrix report in which at least one parent/child relationship appears within the matrix grid.
A nested matrix report has more than two dimensions; therefore, it has multiple dimensions going across or down the page. For example, see . Notice that for each year there is a nested list of related departments. Also notice that the list of jobs (the across values) appears only once. Because the job values appear only once, a summary of each category of jobs can be made to line up with the values it summarizes.
Note: In a nested matrix report, where you create a matrix query that has a child matrix query, the fields on which you join should be separated into a separate group in your master matrix. Otherwise, on some platforms, only the first group prints. |
For a detailed example, see Chapter 26, "Building a Nested Matrix Report".
See also
A matrix with group report is a group above report with a separate matrix for each value of the master group. For example, for each year (master) in the report below there is a unique matrix that contains only that year's departments and jobs. This means that a summary of each job category may not line up with the values it summarizes because the position of each job category in the matrix may vary for each year.
A multiquery matrix with group report is similar to a nested matrix report in that it has more than two dimensions. For example, in the following report, notice that for each year there is a nested list of related departments.
The advantage of using multiple queries is that you get a real break, or master/detail relationship, for the nesting groups (for example, notice that in the multiquery example above, Year 80 shows only record 20; with a single query, Year 80 would show all records whether or not they contain data for Year 80). If you want to suppress detail records that do not contain data for a particular master record, you must use multiple queries.
For a complete example, see the example report in Chapter 27, "Building a Matrix with Group Above Report".
See also
The topics in this section build on the basic concepts discussed in Section 1.2.2, "About Web Reports".
See also
Section 1.2.2, "About Web Reports"
JavaServer Pages (JSPs) technology is an extension to the Java servlet technology from Sun Microsystems that provides a simple programming vehicle for displaying dynamic content on a Web page. A JSP is an HTML page with embedded Java source code that is executed in the Web server or application server. The HTML provides the page layout that is returned to the Web browser, and Java provides the business logic.
JSPs keep static page presentation and dynamic content generation separate. Because JSPs cleanly separate dynamic application logic from static HTML content, Web page designers who have limited or no Java programming expertise can modify the appearance of the JSP page without affecting the generation of its content, simply using HTML or XML tags to design and format the dynamically-generated Web page. JSP-specific tags or Java-based scriptlets can be utilized to call other components that generate the dynamic content on the page.
JSPs have the .jsp
extension. This extension notifies the Web server that the page should be processed by a JSP container. The JSP container interprets the JSP tags and scriptlets, compiles the JSP into a Java servlet and executes it, which generates the content required, and sends the results back to the browser as an HTML or XML page.
A JSP can be accessed and run from a browser-based client, typically over the Internet or a corporate intranet. Unlike traditional client-server applications, JSP applications:
When a JSP is called for the first time, it is compiled into a Java servlet class and stored in the Web server's memory. Because it is stored in memory, subsequent calls to that page are very fast, thereby avoiding the performance limitations seen with traditional Common Gateway Interface (CGI) programs, which spawn a new process for each HTTP request.
For additional background information about JSP technology, see the Sun Microsystems Java and Java EE Web site at http://java.sun.com
.
Oracle Reports supports JavaServer Pages (JSPs) as the underlying technology to enable you to enhance Web pages with information retrieved using Oracle Reports Builder.
In Oracle Reports, you use JSPs to embed data retrieved using the data model into an existing Web page to create a JSP-based Web report. You can create new JSP reports, or save existing reports as JSP reports. New reports are by default saved as JSP reports. The benefit of saving reports as JSPs is that JSPs are text files that are easy to edit as opposed to, for example, the binary .rdf
format. When a report is saved as a JSP file, the data model is embedded using XML tags. The entire report can now be defined using XML tags and saved as an XML file.
Using the Oracle Reports custom JSP tags, you can easily add report blocks and graphs to existing JSP files. These tags can be used as templates to enable you to build and insert your own data-driven Java component into a JSP-based Web report. Not only can you edit the HTML or XML code that encapsulates the report block, but you can also edit the report block in the JSP itself, by modifying, adding or deleting their bodies and attributes.
The Report Editor's Web Source view displays the source code for your Web report, including HTML, XML, and JSP tags.
By default, a new JSP created in Oracle Reports Builder contains the following:
<%@ page contentType="text/html;charset=ISO-8859-1" %>
If you are creating your JSP outside Oracle Reports Builder, you should ensure that it contains similar encoding information.
In prior releases, Oracle Reports introduced Web links that you can add to paper-based reports, which become active when you display your paper report in a Web browser or PDF viewer. For JSP reports, hyperlinks have to be created manually, and if the hyperlinks need to substitute data values, the data values must be provided through the rw:field
JSP tag. For example:
If your JSP-based Web report's character encoding (for example, EUC-JP) differs from the character set portion of the NLS_LANG environment variable (for example, JA16SJIS), you will get the following errors:
REP-6106
or REP-6104
with javax.servlet.jsp.JspException (multibyte)
REP-0495 Unable to tokenize the query (singlebyte)
REP-0069 Internal Error or REP-6106
To work around this issue, you must ensure that your JSP-based Web report's character encoding matches the IANA encoding corresponding to Oracle Reports Builder's character set portion of the NLS_LANG
environment variable.
For example:
<%@ page contentType="text/html;charset=EUC-JP" %>
<META http-equiv="Content-Type" content="text/html;charset=EUC-JP">
This JSP file needs to be encoded in the character set (EUC-JP
).
NLS_LANG=JAPANESE_JAPAN.JA16EUC
In this example, the JSP-based Web report's encoding (EUC-JP
) matches Oracle Reports Builder's character set portion of NLS_LANG
; that is, JA16EUC
.
In Oracle Reports, Web report templates are configured for Western European character encoding by default. However, for other languages, you can specify the character encoding for every JSP file by using both the charset
attribute of the <Meta>
tag and the <%@page%>
page directive.
To dynamically associate the appropriate character encoding with the JSP file, you can make the following modifications:
rw*.html
files and the blank_template.jsp
file, as follows: <%@ page contentType="text/html;charset=
yourIANAencoding
" %>
where:
yourIANAencoding
is the IANA encoding name that corresponds to the NLS_CHARACTERSET
portion of the NLS_LANG
variable.
<Meta>
tag inside the <Head>
tag to read: <meta http-equiv="Content-Type" content="text/html;charset=
yourIANAencoding
" />
template.xsl
(ORACLE_HOME
/reports/templates/
) file, as follows: <xsl:output>
tag to read: <xsl:output
method="jsp"
indent="yes"
encoding="yourIANAencoding
"
/>
where:
yourIANAencoding
is the IANA encoding name that corresponds to the NLS_CHARACTERSET
portion of the NLS_LANG
variable.
<%@ page contentType="text/html;charset=yourIANAencoding" %>
<META>
tag inside the tag: <meta http-equiv="Content-Type" content="text/html;charset=yourIANAencoding" />
where:
yourIANAencoding
is the IANA encoding name that corresponds to the NLS_CHARACTERSET
portion of the NLS_LANG
variable.
See also
Topics "Oracle Reports JSP tags" and "Oracle Reports XML tags" in the Reference section of the Oracle Reports online Help
You can preview a JSP-based Web report by clicking the Run Web Layout button in the toolbar, or by choosing Program > Run Web Layout, to run the Web Source. Reports Builder displays Web reports in your default browser.
Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry keyHKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
It is not necessary that you have Reports Server configured to use this functionality. Oracle Reports Builder uses the standalone Oracle WebLogic Server for running a report to Web layout.
Document Root
By default, the Oracle Reports Builder document root directory is
. This can be configured in the Oracle Reports Builder configuration file (
$DOMAIN_HOME/servers/<MANAGED_SERVER_NAME>/stage/reports/reports/web.war/rwbuilder.conf
) as follows:
The end user can also override this configurable docroot
from the command line using the WEBSERVER_DOCROOT
command line keyword. If your JSP depends on external files, such as images, style sheets, and so on, make sure you copy them into the docroot
directory. The docroot
should point to any Oracle WebLogic Server component, $DOMAIN_HOME/servers/<MANAGED_SERVER_NAME>/stage/reports/reports/web.war/
directory where Reports Application has been deployed.
Web Server Port
By default, the OHS port is considered to be the Web server port. This can be configured in the Oracle Oracle Reports Builder configuration file (rwbuilder.conf
) as follows:
The end user can override this configurable port parameter from the command line using the WEBSERVER_PORT
command line keyword.
Usage notes
emp012345678.jsp
). See also
Section 4.7.16.4, "Displaying report output in your Web browser"
This topic discusses the Web links that you can add to paper-based reports that will become active when you generate your report to an HTML file and display it in a Web browser.
In most cases, you can define Web links in an object's Property Inspector. You can specify column and field names in the link value to create dynamic links at runtime. If you require more complex implementation of Web links, such as conditional settings, you must specify the link using PL/SQL and the Oracle Reports Builder built-in packaged procedure SRW.SET_ATTR.
Reports output in HTML format can include the following types of Web links:
Additionally, your report can include the following headers and footers that use escapes to add HTML tags to your paper-based report:
This topic discusses the Web links that you can add to paper-based reports that will become active when you run your report to a PDF file and display it in a PDF viewer.
Reports output in PDF format can include the following types of Web links:
In most cases, you can define Web links in an object's Property Inspector. You can specify column and field names in the link value to create dynamic links at runtime. If you require more complex implementation of Web links, such as conditional settings, you must specify the link using PL/SQL.
A hyperlink is an attribute of an object that specifies a hypertext link to either of the following destinations:
You can set the Additional Hyperlink Attributes property to specify additional HTML to be applied to the hyperlink.
See also
Section 4.6.10.1.8, "Creating a hyperlink using the Property Inspector"
A graph hyperlink provides an active link from an area of a graph to a specified destination in a Web report. When end users display the report on the Web (JSP-based, or paper-based PDF or HTML), they can click one or more areas of the graph to drill down to additional linked information.
See also
A hyperlink destination is an attribute of an object that identifies the destination of a hypertext link.
See also
Section 4.6.10.1.7, "Creating a hyperlink destination using the Property Inspector"
Section 4.6.10.2.8, "Creating a hyperlink destination using PL/SQL"
A bookmark is an attribute of an object that specifies a string that is a link to the object.
See also
Section 4.6.10.1.10, "Creating a bookmark using the Property Inspector"
Section 4.6.10.2.10, "Creating a bookmark using PL/SQL"
Section 4.6.10.1.11, "Creating a bookmark on break columns using the Property Inspector"
(PDF output only) An application command line link is an attribute of an object that specifies a command line to be executed when the object is clicked.
Restrictions
An object that is associated with a application command line link cannot also be the source of a Web link (a hyperlink).
See also
Section 4.6.10.1.9, "Creating an application command line link using the Property Inspector"
Section 4.6.10.2.9, "Creating an application command line link using PL/SQL"
Limitations
In an after report escape (see Section 2.2.10, "About before and after escapes"), adding an HTML command outside the body does not reflect when the report is generated to spreadsheet output, even though the HTML command is written in output properly. For example:
</body><table><tr><td><B> the text to be bolded </B></td><tr></table> </html>
Adding the HTML command before the closing body tag reflect correctly when the report is generated to spreadsheet output. For example:
<table><tr><td><B> the text to be bolded </B></td><tr></table></body></html>
For more information about spreadsheet output, see Section 2.8.13, "About Enhanced Spreadsheet output".
See also
Section 4.6.10.1.1, "Creating an HTML document header using the Property Inspector"
Section 4.6.10.2.1, "Creating an HTML document header using PL/SQL"
Section 4.6.10.1.2, "Creating an HTML document footer using the Property Inspector"
Section 4.6.10.2.2, "Creating an HTML document footer using PL/SQL"
Section 4.6.10.1.3, "Creating an HTML page header using the Property Inspector"
Section 4.6.10.2.3, "Creating an HTML page header using PL/SQL"
Section 4.6.10.1.4, "Creating an HTML page footer using the Property Inspector"
Section 4.6.10.2.4, "Creating an HTML page footer using PL/SQL"
Section 4.6.10.1.5, "Creating an HTML Parameter Form header using the Property Inspector"
Section 4.6.10.2.5, "Creating an HTML Parameter Form header using PL/SQL"
Section 4.6.10.1.6, "Creating an HTML Parameter Form footer using the Property Inspector"
Section 4.6.10.2.6, "Creating an HTML Parameter Form footer using PL/SQL"
Style sheets (or Cascading Style Sheets) refer to HTML extensions that provide powerful formatting flexibility. With style sheet support, your HTML documents can include any of the following:
This means that the sophisticated formatting in a report is preserved when you format the report as an HTMLCSS document. Without style sheet extensions, your HTML documents display only basic text formats and imported images. With style sheets, images of highly formatted text can be replaced with text objects of equivalent style, color, and font. Text objects can be positioned to overlay image objects. All text is fully searchable, and fewer images have to be downloaded.
To view an HTML document that takes advantage of style sheets, you must display it in a browser that supports style sheets.
Using external style sheets for HTMLCSS output
Every corporate Web site today uses style sheets to enforce the corporate look-and-feel across Web pages. External style sheets are Cascading Style Sheet (CSS) files that are referenced by these Web pages. End users typically want the same style used in pages on their Web site applied to their Web reports.
In prior releases, applying style sheets and user-defined styles to reports involved manually editing the HTMLCSS output.
You can specify user-defined styles and style sheets for HTMLCSS output using Oracle Reports Builder. Styles can be applied to report, field, text, frame, and repeating frame objects using the new properties Style Sheets, CSS Class Name, and CSS ID properties (see the Oracle Reports online Help for descriptions of these properties). The generated HTMLCSS output includes links to the style sheets and the user-defined styles are applied to the objects.
Restrictions
The following elements are not supported by HTML style sheet extensions:
See also
Section 4.7.16.4, "Displaying report output in your Web browser"
The topics in this section build on the basic concepts discussed in Section 1.7, "Data Model Objects".
A summary column performs a computation on another column's data. Using the Report Wizard or Data Wizard, you can create the following summaries: sum, average, count, minimum, maximum,% total. You can also create a summary column manually in the Data Model view, and use the Property Inspector to create the following additional summaries: first, last, standard deviation, variance.
If your report requires a customized computation, for example, one that computes sales tax, create a formula column (see Section 4.8.10, "Creating or editing a formula column").
Note: For group reports, the Report Wizard and Data Wizard create n summary fields in the data model for each summary column you define: one at each group level above the column being summarized, and one at the report level. For example, if a report is grouped by division, and further grouped by department, then a summary column defined for a salary total would create fields for the sum of salaries for each division and each department group (group-level summaries), and the sum of all salaries (report-level summary). |
See also
A formula column performs a user-defined computation on the data of one or more column(s), including placeholder columns. For example, :ITEMTOT *.07 is a formula that performs a computation on one column, while :SAL + :COMM performs a computation using two columns in a record. You create formulas in PL/SQL using the PL/SQL Editor.
Note: Formula columns should not be used to set values for parameters. |
See also
A placeholder is a column for which you set the datatype and value in PL/SQL that you define. Placeholder columns are useful when you want to selectively set the value of a column (for example, each time the nth record is fetched, or each time a record containing a specific value is fetched, and so on). You can set the value of a placeholder column in the following places:
See also
You can reference user parameters, system parameters and columns as either bind references or lexical references.
Bind references (or bind variables) are used to replace a single value in SQL or PL/SQL, such as a character string, number, or date. Specifically, bind references may be used to replace expressions in SELECT
, WHERE
, GROUP BY
, ORDER BY
, HAVING
, CONNECT BY
, and START WITH
clauses of queries. Bind references may not be referenced in FROM
clauses or in place of reserved words or clauses.
You create a bind reference by typing a colon (:) followed immediately by the column or parameter name. If you do not create a column or parameter before making a bind reference to it in a SELECT
statement, Oracle Reports Builder will create a parameter for you by default.
Restrictions
Bind references must not be the same name as any reserved SQL keywords. For more information, see the Oracle Server SQL Language Reference manual.
Examples
Example 1: SELECT clause
In the following example, the value of DFLTCOMM
replaces null values of COMMPLAN
in the rows selected.
Example 2: WHERE clause
The value of CUST
is used to select a single customer.
Example 3: GROUP BY clause
All non-aggregate expressions such as NVL(COMMPLAN, :DFLTCOMM)
in the SELECT
clause must be replicated in the GROUP BY
clause.
Example 4: HAVING clause
The value of MINTOTAL
is used to select customers with a minimum total of orders.
Example 5: ORDER BY clause
The value of SORT
is used to select either SHIPDATE
or ORDERDATE
as the sort criterion. Note that this is not the same as ORDER BY 1
because :SORT
is used as a value rather than to identify the position of an expression in the SELECT
list. Note that DECODE
is required in this example. You cannot use a bind variable in an ORDER BY
clause unless it is with DECODE
.
Example 6: CONNECT BY and START WITH clauses
References in CONNECT BY
and START WITH
clauses are used in the same way as they are in the WHERE
and HAVING
clauses.
Example 7: PL/SQL
The value of myparam
is multiplied by two and assigned to myparam
.
Lexical references are placeholders for columns or parameters that you embed in a SELECT
statement. You can use lexical references to replace the clauses appearing after SELECT
, FROM
, WHERE
, GROUP BY
, ORDER BY
, HAVING
, CONNECT BY
, and START WITH
. Use a lexical reference when you want the parameter to substitute multiple values at runtime.
You cannot make lexical references in a PL/SQL statement. You can, however, use a bind reference in PL/SQL to set the value of a parameter that is then referenced lexically in SQL, as shown in the example below.
You create a lexical reference by typing an ampersand (&
) followed immediately by the column or parameter name. A default definition is not provided for lexical references. Therefore, you must do the following:
Restrictions
SELECT
clause, you should create a separate lexical reference for each column you will substitute. In addition, you should assign an alias to each lexical reference. This enables you to use the same layout field and boilerplate label for whatever value you enter for the lexical reference on the Runtime Parameter Form. SELECT
clause, you must specify the same number of items at runtime as were specified in the report's data model. Each value you specify for your lexical references at runtime must have the same datatype as its Initial Value. SELECT
clause, the width of the column is derived from the Initial Value property of the parameter. Consequently, you should ensure that the Initial Value of the parameter corresponds to the widest column that you intend to use. WHERE
) for the link directly in the query. For example, your parent and child queries might be written as follows: Parent Query:
Child Query:
Note how the WHERE
clause makes a bind reference to DEPTNO
, which was selected in the parent query. Also, this example assumes that you have created a link between the queries in the Data Model view with no columns specified.
WHERE
clause is replaced by a lexical reference): If the value of the where_clause
parameter contains a reference to a bind variable, you must specify the value in the After Form trigger or earlier. You would get an error if you supplied the following value for the parameter in the Before Report trigger:
If you supplied this same value in the After Form trigger, the report would run.
Examples
Example 1: SELECT clause
P_ENAME
, P_EMPNO
, and P_JOB
can be used to change the columns selected at runtime. For example, you could enter DEPTNO
as the value for P_EMPNO
on the Runtime Parameter Form. Note that in this case, you should use aliases for your columns. Otherwise, if you change the columns selected at runtime, the column names in the SELECT
list will not match the Oracle Reports Builder columns and the report will not run.
Example 2: FROM clause
ATABLE
can be used to change the table from which columns are selected at runtime. For example, you could enter ORD
for ATABLE
at runtime. If you dynamically change the table name in this way, you may also want to use lexical references for the SELECT
clause (look at the previous example) in case the column names differ between tables.
Example 3: WHERE clause
CUST
can be used to restrict records retrieved from ORD
. Any form of the WHERE
clause can be specified at runtime.
Example 4: GROUP BY clause
The value of NEWCOMM
can be used to define the GROUP BY
clause.
Example 5: HAVING clause
The value of MINTOTAL
could, for example, be used to select customers with a minimum total of orders.
Example 6: ORDER BY clause
The value of SORT
can be used to select SHIPDATE
, ORDERDATE
, ORDID
, or any combination as the sort criterion. It could also be used to add on to the query, for example to add a CONNECT BY
and START WITH
clause.
Example 7: CONNECT BY and START WITH clauses
Parameters in CONNECT BY
and START WITH
clauses are used in the same way as they are in the WHERE
and HAVING
clauses.
Example 8: Multiple clauses
COLSTABLE
could be used to change both the SELECT
and FROM
clauses at runtime. For example, you could enter DNAME ENAME, LOC SAL FROM DEPT
for COLSTABLE
at runtime.
WHEREORD
could be used to change both the WHERE
and ORDER BY
clauses at runtime. For example, you could enter WHERE SAL > 1000 ORDER BY DEPTNO
for &WHEREORD
at runtime.
Example 9: PL/SQL and SQL
BREAK_COL
is used to change both the SELECT
list and the GROUP BY
clause at runtime. The Initial Value of the parameter &BREAK_COL
is JOB
. At runtime, the user of the report can provide a value for a parameter called GROUP_BY_COLUMN
(of data type Character).
In the Validation Trigger for GROUP_BY_COLUMN
, you call the following PL/SQL procedure and pass it the value of GROUP_BY_COLUMN
:
This PL/SQL ensures that, if necessary, a TO_CHAR
is placed around the break column the user chooses. Notice how in SQL, you make a lexical reference to BREAK_COL
. In PL/SQL, you must make a bind reference to BREAK_COL
because lexical references are not allowed in PL/SQL.
Bind references are used to replace a single value in SQL or PL/SQL. Specifically, bind references may be used to replace expressions in SELECT
, WHERE
, GROUP BY
, ORDER BY
, HAVING
, CONNECT BY
, and START WITH
clauses of queries. Bind references may not be referenced in the FROM
clause. An example is:
Lexical references are placeholders for text that you embed in a SELECT
statement, when you want the parameter to substitute multiple values at runtime. You can use lexical references to replace the clauses appearing after SELECT
, FROM
, WHERE
, GROUP BY
, ORDER BY
, HAVING
, CONNECT BY
, and START WITH
. You cannot make lexical references in PL/SQL. Before you reference a lexical parameter for a column or table, you must have predefined the parameter and given it an initial value. An example is:
A non-linkable query is a detail query that contains column objects that prevent the query from being linked to through a column-to-column link (when you create a column-to-column link, Oracle Reports Builder adds a WHERE
clause to your query). If you attempt to create such a link, a message dialog box displays, which prompts you to choose whether to create a group-to-group query (using the parent groups), or to cancel the operation. A non-linkable query displays the non-linkable query icon in its title bar.
Instead, you can create a group-to-group link (when you create a group-to-group link, Oracle Reports Builder does not add a WHERE
clause to your query) between the two queries and add a WHERE
clause to the child query's SELECT
statement, using a bind variable to reference the parent column. See Section 4.8.9, "Creating a data link".
For example, suppose you want to create a column-to-column link between the ADDRESS.STREET
column in your child query and the LOC1
column in your parent query. You can create a group-to-group link, and then modify the child query SQL statement to say:
See also
Section 1.7.4, "About data links"
In Oracle Reports Builder, data is defined independent of format (layout). Therefore, you should be aware of when to use data links instead of groups.
The layouts of a master/detail report that uses two queries and a data link, and a group report that uses one query and two groups can be identical. Following is an example of a default master/detail report and a group report that query the same data. Notice the difference between the two reports: unlike the group report, the master/detail report displays department 40. This is because the data link in the master/detail report causes an outer-join: the link automatically fetches unrelated data. If you are designing a group report that requires an outer-join, explicitly add it to your SELECT
statement with (+).
A master/detail/detail report, as shown in the figure below, is a report that contains three groups of data: for each master group, two unrelated detail groups are displayed. To produce a master/detail/detail report or any variation of it, you must use data links. If you try to produce this report with a control break using a single query and three groups the query will establish a relationship between the two detail groups.
See also
A matrix object merely defines a relationship between two repeating frames: it isn't really owned by any object, nor does it own any object. A matrix object is created only for layouts with a Matrix layout style. A report may have multiple matrices within it, provided that the data model contains the necessary groups. Oracle Reports Builder creates one matrix object for each pair of intersecting, perpendicular repeating frames.
The repeating frames are the dimensions of the matrix and the matrix object contains the field that will hold the "filler" or values of the cell group. One of the repeating frames must have the Print Direction property set to Down and the other must have the Print Direction property set to Across in order to form a matrix.
Note: When running a JSP-based Web report that includes a matrix object, the JSP<rw:include> tag expects the matrix object to format on only one page. However, if the cells in the across repeating frame expand, the column headers of the matrix may be forced onto a second page regardless of the page size. Therefore, these matrix headers will not appear in the report output. Additionally, in this situation, the paper layout does not display correctly as header fields move to subsequent pages where the cell values remain on the first page. To resolve this, it is important to carefully define in the Report Editor the space available to the across repeating frame to allow for displaying the largest values, then set the Vertical Elasticity property of the across repeating frame to Fixed. |
Restrictions
Example
Suppose that you have a group named Group1 that contains a column called C_DEPTNO, which gets its values from the database column DEPTNO. A group called Group2, contains column C_JOB, which gets its values from the database column JOB, and column C_DEPTNO1, which is used for linking to Group1's query. A group called Group3 contains a column called SUMSAL, which is a summary of the database column SAL.
In this example:
If you need to build a more complex matrix, you can do so by adding more columns to Group1 and Group2. For example, instead of having Group1 just contain department numbers, it could also contain the locations (LOC) of the departments. The matrix might then look something like this:
See also
Section 1.3.7, "About matrix reports"
Section 2.1.7, "About nested matrix reports"
Section 2.1.8, "About matrix with group reports"
Section 4.9.1.3, "Creating a matrix object"
The topics in this section build on the basic concepts discussed in Section 1.8, "Layout Objects".
Several important concepts and properties apply to layout objects:
See also
Section 4.5.4, "Creating a default layout for a report"
Section 4.10.2, "Creating a default layout for a section"
Section 2.6.13.2, "About format triggers"
The Properties section of the Oracle Reports online Help
When you select one of the default layout styles in the Report Wizard, Oracle Reports Builder creates the necessary layout objects, based upon the report's data model. For example, if you want to build a mailing label report and have defined an appropriate data model, simply choose the mailing label default style. Oracle Reports Builder automatically creates the report's layout objects and displays them in the Layout Model view. You can completely customize any default layout you create. You can cut, copy, paste, move, resize, and edit each layout object that Oracle Reports Builder generates for you.
Layout defaulting is governed by the following rules:
Oracle Reports Builder defaults report layout according to the following rules:
Exception: For tabular, form-like, group left/above, and matrix reports, the default for CHAR (if you reduce the default width) and LONG fields have a Horizontal Elasticity property setting of Fixed and a Vertical Elasticity property setting of Variable. As a result, all of the field's value will be displayed, instead of truncated, by word-wrapping any data to the next lines.
Caution: For form letter and mailing label reports, the default for CHAR (if you reduce the default width) and LONG fields have a Horizontal Elasticity and Vertical Elasticity property setting of Fixed. As a result, the field value will be truncated if the size of the data is greater than the size of the field. |
See also
You can add an image to a report by:
The first method (using the Import Image dialog box) provides for including images in the following formats: TIFF, JFIF, BMP, TGA, PCX, PICT, GIF, CALS, RAS, OIF, PCD.
The other two methods (creating a file link object, and selecting a column in the database) provide for including additional formats supported by Oracle Reports, including JPEG (all types, such as Progressive JPEG and Exif JPEG), PNG, BMP, TIFF, GIF, and CGM.
By default, images display in fields so that they appear in the printed report, not only in the Previewer.
Enhanced imaging support is provided by the REPORTS_OUTPUTIMAGEFORMAT environment variable and OUTPUTIMAGEFORMAT command line keyword. The enhancements in imaging support provide the capability to generate complex graphics-intensive reports with high fidelity image output. Additionally on UNIX, the dependency on a windowing system for displaying images is removed; the PostScript printer driver screenprinter.ppd
provides surface resolution for images.
You can include an unlimited number of image objects without running out of local disk space by using non-caching references. A non-caching reference causes objects to be read from the database only when needed while a report is processing. You must be connected to an ORACLE V7.1 or later database to use this feature.
If you reference a URL for an image, the image is displayed when you format your report for HTML output. For other output formats, the URL text displays in the Paper Design view; in the output destination (for example, a file or PDF document), nothing is displayed. It is your responsibility to verify that the URL exists; Oracle Reports Builder does not validate the existence of the resource nor the syntax of the protocol. The size of the object that contains the URL defines the size of the image in the HTML output. Any elasticity properties applied to the object are ignored.
Limitations
Anchors fasten an edge of one object to an edge of another object, ensuring that they maintain their relative positions. For example, you can anchor boilerplate text to the edge of a variable-sized repeating frame, guaranteeing the boilerplate's distance and position in relation to the repeating frame, no matter how the frame's size might change.
Anchors determine the vertical and horizontal positioning of a child object relative to its parent. The child object may be either outside of or contained within the parent.
Since the size of some layout objects may change when the report runs (and data is actually fetched), you need anchors to define where you want objects to appear relative to one another. An anchor defines the relative position of an object to the object to which it is anchored. Positioning is based on the size of the objects after the data has been fetched rather than on their size in the editor. It should also be noted that the position of the object in the Paper Layout view affects the final position in the report output. Any physical offset in the layout is incorporated into the percentage position specified in the Anchor properties.
There are two types of anchors:
Relative positioning of anchors
When you anchor a child object to a parent object, the x and y coordinates of the anchor's attachments are important.
If the parent object is located above or below the child object:
If the parent object is located to the right or left of the child object:
If you need to position an object outside a repeating frame or frame, but you want the object to be "owned" by the repeating frame or frame (that is, to be formatted when its "owner" is formatted), create an anchor that is attached to an object inside the frame or repeating frame.
Collapsing Anchors
You can create anchors to be "collapsible." Collapsing anchors help avoid unnecessary empty space in your report. Such empty space can occur when the parent object does not print on the same page as the child object, either because the parent and child cannot fit on the same page or because of an assigned Print Condition. A collapsing anchor allows the child object to move into the position that would have been taken by the parent had it printed. The child object will also maintain its relative position as defined by the anchor.
Oracle Reports Builder creates implicit anchors at runtime in the body region. The margin algorithm differs slightly.
Body algorithm
If the "push path" direction is Down, anchor the pushee object's top 0% to the pusher object's bottom 0%.
If the "push path" direction is Across, anchor the pushee object's left 0% to the pushed object's right 0%.
Rules:
In the first case, M_Sums is in the "push path" of both B_Text1 and R_Ename. Because M_Sums is equidistant from B_Text1 and R_Ename, though, the normal criteria (shortest distance) for determining implicit anchors does not work in this case. Consequently, the formatting algorithm will randomly create an implicit anchor between M_Sums and either B_Text1 or R_Ename at runtime. To avoid this behavior, you could create an explicit anchor between M_Sums and B_Text1 or R_Ename.
In the second case, B_Text3 is in the "push path" of M_Emp. Since the bottom edges of M_Emp and R_Mgr are virtually in the same position, though, B_Text3 could be implicitly anchored to either M_Emp or R_Mgr. Consequently, the formatting algorithm will randomly create an implicit anchor between B_Text3 and either M_Emp or R_Mgr at runtime. To avoid this behavior, you could create an explicit anchor from B_Text3 to one of the objects or remove the explicit anchor between R_Ename and B_Text2. Removing the explicit anchor would cause R_Mgr to be treated as a descendant of M_Emp and, therefore, the implicit anchor would always be created between B_Text3 and M_Emp.
(Note that Case 2 is most likely to occur in character mode, where it is common to have the edges of objects overlap in the Paper Layout view.)
Margin algorithm
Oracle Reports Builder creates implicit anchors for all Type B objects in the margin region using the Body algorithm. For each Type A object, however, Oracle Reports Builder creates an implicit anchor from the top-left corner of the object to the top-left corner of the margin. No Type A object will be implicitly anchored to another Type A object. (This ensures that Type A objects will not be pushed off the page. However, they may be overwritten by another Type A object, if they are found on the same layer.)
See also
Section 4.9.5.1, "Anchoring objects together"
Color and pattern selections are applied to an entire object (for example, you can apply a color to all the text in the object but not to a segment of the text).
You can change colors and patterns in your report in the following ways:
Note: The Windows platform does not support a border pattern (that is, patterns for the Line Color tool). |
Note: The Windows platform does not support a border pattern. |
Additionally, you can set color palette preferences to specify how it is used by a report (see Section 4.2.6, "Setting color palette preferences") and modify the color palette to change the definition of individual colors (see Section 4.9.6.5, "Modifying the color palette").
To change the color palette being used by the current report, you can import a new color palette. You can also export the current color palette for use by other reports. (See Section 4.9.6.6, "Importing or exporting a color palette".)
See also
Section 4.9.6.2, "Changing colors"
Section 4.9.6.3, "Changing patterns"
Section 4.9.6.4, "Changing colors and patterns using PL/SQL"
Section 4.9.4.2, "Changing object border attributes"
Topics "Oracle CDE1 color palette", "Default color palette", "Grayscale color palette", and "Pattern color palette" in the Reference > Color and Pattern Palettes section of the Oracle Reports online Help
Topic "SRW built-in package" in the Reference > PL/SQL Reference > Built-in Packages section of the Oracle Reports online Help
Topic "Template properties" in the Properties section of the Oracle Reports online Help
You can resize queries, groups, frames, repeating frames, fields, matrix objects, and boilerplate objects. You cannot resize anchors. However, an anchor is automatically resized if you move one of the objects it anchors.
Caution: When you resize boilerplate text, be very careful that all of the text fits within the object. If font descends (the space left for the lower parts of letters like g and q) do not fit, the line of text will appear in the Report Editor view, but, when the report is run, the line will not appear in the output. When you click a handle and drag it, the two edges that join at the corner will be resized; that is, the object will grow or reduce in both the x and y directions. |
See also
Section 4.9.12.1, "Resizing objects"
In the Paper Layout view, objects must be on a layer above the objects that enclose them. For example, the fields that belong to a repeating frame must be at least one layer above the repeating frame in the Paper Layout view. If not, then they are not considered to be enclosed by the repeating frame any longer and will cause a frequency error at runtime. When you move or group objects in the Paper Layout view, it is possible to change the layering such that you will get frequency errors when you run the report. To avoid this problem, you should take advantage of Confine or Flex mode when moving objects in the Paper Layout view.
See also
Section 4.9.4.3, "Changing the current mode (Confine or Flex)"
Section 4.9.11.7, "Changing object layering"
Section 4.9.11.2, "Moving an object outside its parent"
The topic in this section builds on the basic concepts discussed in Section 1.9, "Parameter Form Objects".
Parameter Form HTML extensions enable you to enhance your Runtime Parameter Form with HTML tagged text and JavaScript when your paper reports are run through the Web. To enhance your Paper Parameter Form for displaying on the Web, you can:
You can access the Parameter Form Builder from the Object Navigator or by choosing Tools > Parameter Form Builder.
See also
Section 1.2.2, "About Web Reports"
The topics in this section discuss the use of PL/SQL in Oracle Reports Builder.
The PL/SQL Editor enables you to create and edit PL/SQL program units.
Usage notes
When you make changes to a program unit, dependent program units lose their compiled status, which is indicated by an asterisk (*) after their name under the Program Units node in the Object Navigator. You can navigate to those program units directly in the PL/SQL Editor using the Name list to recompile them.
Restrictions
See also
The Stored PL/SQL Editor enables you to create and edit stored PL/SQL program units in a database (listed under the Database Objects node in the Object Navigator).
See also
The Syntax Palette is a programming tool that enables you to display and copy the constructs of PL/SQL language elements and built-in packages into the PL/SQL Editor and Stored PL/SQL Editor.
See also
Program units are packages, functions, or procedures that you can reference from any PL/SQL within the current report.
Note: Program units cannot be referenced from other documents. If you want to create a package, function, or procedure that can be referenced from multiple documents, create an external PL/SQL library (see Section 4.13.5.1, "Creating an external PL/SQL library"). |
For a detailed example of using PL/SQL in a report, see Chapter 40, "Building a Report that Includes PL/SQL".
Restrictions
Example: Referencing a PL/SQL function in formulas
Suppose that you have a report with the following groups and columns:
Given these groups and columns, you might create multiple formulas that apply the cost of living factor (COSTOFLIVING
) to salaries. To avoid duplication of effort, you could create the following PL/SQL function and reference it from the formulas:
Following are some examples of how you might reference the PL/SQL function in formulas:
See also
Stored program units (also known as stored subprograms, or stored procedures) can be compiled separately and stored permanently in an Oracle database, ready to be executed. Once compiled and stored in the data dictionary, they are schema objects, which can be referenced by any number of applications connected to that database.
Stored program units offer higher productivity, better performance, memory savings, application integrity, and tighter security. For example, by designing applications around a library of stored procedures and functions, you can avoid redundant coding and increase your productivity.
Stored program units are stored in parsed, compiled form. So, when called, they are loaded and passed to the PL/SQL engine immediately. Also, they take advantage of shared memory. So, only one copy of a program unit need be loaded into memory for execution by multiple users.
Because stored program units run in ORACLE, they can perform database operations more quickly than PL/SQL that is local to your report. Therefore, in general, use stored program units for PL/SQL that performs database operations. Use local program units for PL/SQL that does not involve database operations. However, if you are on a heavily loaded network with very slow response time, using stored program units may not be faster for database operations. Similarly, if your server is significantly faster than your local machine, then using local program units may not be faster for non-database operations.
See also
External PL/SQL libraries are collections of PL/SQL procedures, functions, and packages that are independent of a report definition. By attaching an external library to a report, you can reference its contents any number of times. For example, you could reference a procedure in an attached library from both a Before Report trigger and a format trigger. This eliminates the need to re-enter the same PL/SQL for each application.
When you associate an external PL/SQL library with a report or another external library, it is called an attached library.
See also
Attached libraries are external PL/SQL libraries that you have associated with a report or another external library. When an external library is attached, you can reference its packages, functions, and procedures from within your report. For example, if you attached an external library name MYLIB to your report and it contained a function named ADDXY, then you could reference ADDXY from any PL/SQL in the report.
External PL/SQL libraries are independent of a report definition.
Usage notes
Local PL/SQL executes more quickly than a reference to a procedure or function in an external PL/SQL library. As a result, you should only use external PL/SQL libraries when the benefits of sharing the code across many applications outweigh the performance overhead.
Restrictions
See also
Formulas are PL/SQL functions that populate formula or placeholder columns. You can access the PL/SQL for formulas from the Object Navigator, the PL/SQL Editor, or the Property Inspector (that is, the PL/SQL Formula property).
A column with Datatype property set to Number can only have a formula that returns a value of datatype NUMBER
. A column with Datatype property set to Date can only have a formula that returns a value of datatype DATE
. A column with Datatype property set to Character can only have a formula that returns a value of datatype CHARACTER
, VARCHAR
, or VARCHAR2
.
Restrictions
COMP
in a condition (for example, IF :COMP = 10
) and you can directly set its value in an assignment statement (for example,:COMP:= 15
). SRW.DO_SQL
, we recommend that you do not read database values that are updated or inserted in the same report. There is no guarantee of the exact time Oracle Reports Builder will fetch records from the database for formatting the output. Oracle Reports Builder does internal "data look-ahead" to optimize performance. Thus, a particular record might already have been accessed before an update is issued to the same record. Oracle Reports Builder builds internal dependency lists which guarantee that events, such as invocation of user exits, calculation of summaries, and so on, happen in the correct order. However, Oracle Reports Builder cannot guarantee these events will be synchronized with its internal data access or with the formatting of data. Examples
Example 1: Adding values
The following example populates the column with the value of the salary plus the commission.
Example 2: Using conditions
The following code adds the commission to the salary if the value for the commission is not null.
See also
Section 2.3.2, "About formula columns"
A group filter determines which records to include in a group. You can use the packaged filters, First and Last, to display the first n or last n records for the group, or you can create your own filters using PL/SQL. You can access group filters from the Object Navigator, the Property Inspector (the PL/SQL Filter property), or the PL/SQL Editor.
The function must return a boolean value (TRUE
or FALSE
). Depending on whether the function returns TRUE
or FALSE
, the current record is included or excluded from the report.
Difference between group filters and Maximum Rows to Fetch property
The Maximum Rows to Fetch property restricts the actual number of records fetched by the query. A group filter determines which records to include or exclude, after all the records have been fetched by the query. Since Maximum Rows to Fetch actually restricts the amount of data retrieved, it is faster than a group filter in most cases. If you set the Filter Type property to Last or Conditional, Oracle Reports Builder must retrieve all of the records in the group before applying the filter. Also, you should be aware that when using Maximum Rows to Fetch for queries, it can affect summaries in other groups that depend on this query. For example, if you set the Maximum Rows to Fetch property to 8, any summaries based on that query will only use the 8 records retrieved.
Restrictions
Group filters cannot be added to cross-product groups.
COUNT1
in a condition (for example, IF :COUNT1 = 10
), but you cannot directly set its value in an assignment statement (for example, :COUNT1:= 10
). Note also that the use of PL/SQL global variables to indirectly set the values of columns or parameters is not supported. If you do this, you may get unpredictable results. You also cannot reference any page-dependent columns (that is, Reset At of Page) or columns that rely on page-dependent columns in a group filter. Example
See also
A REF CURSOR
query uses PL/SQL to fetch data. Each REF CURSOR
query is associated with a PL/SQL function that returns a cursor value from a cursor variable. The function must ensure that the REF CURSOR
is opened and associated with a SELECT
statement that has a SELECT
list that matches the type of the REF CURSOR
.
Note: The use ofREF CURSOR queries in Oracle Reports 11g Release 1 (11.1.1) requires that your database version is 10.1.0.5 (for 10.1) or 10.2.0.2 (for 10.2) or higher. Interoperability between a 11g Release 1 (11.1.1) database or Oracle Forms Services client and a 10.1/10.2 database requires a minimum patchset level of 10.1.0.5 (for 10.1) or 10.2.0.2 (for 10.2). An attempt to reference a 10.1 or 10.2 PL/SQL unit or view under the following circumstances will fail with a
|
Oracle Reports supports both static and dynamic REF CURSOR
s. For example:
Static REF CURSOR
:
Dynamic REF CURSOR
:
Note: TheSELECT statement must be explicitly set for dynamic REF CURSOR s. |
For a detailed example, see Chapter 41, "Building a Paper Report with REF CURSORs".
Usage notes
REF CURSOR
s. For example: REF CURSOR
query the child in a data link, the link can only be a group to group link. It cannot be a column to column link. REF CURSOR
s, you receive the added benefits that go along with storing your program units in the Oracle database. REF CURSOR
when you want to: Furthermore, if you use a stored program unit to implement REF CURSOR
s, you receive the added benefits that go along with storing your program units in the Oracle database.
For more information about REF CURSOR
s and stored subprograms, refer to the PL/SQL User's Guide and Reference.
Examples
Example 1: Package with REF CURSOR
example
Example 2: Package with REF CURSOR
and function
Example 3: REF CURSOR
query
Example 4: REF CURSOR
query calling function
See also
If you want to use Data Manipulation Language (DML) or Data Definition Language (DDL) in your PL/SQL, you can use the SRW.DO_SQL built-in procedure. Note that SRW.DO_SQL should only be used for DML and DDL; you should not use it to fetch data. For more information on DML and DDL, see the Oracle Server SQL Language Reference manual.
Because of Oracle Reports' processing model, it is recommended that you only use DDL in the Before Parameter Form and After Parameter Form triggers. DML can be entered any place that accepts PL/SQL.
Any DML or DDL that will reported on with this report's processing should be done in (or before) the After Parameter Form trigger. Consistency cannot be guaranteed in the Before Report trigger, since Oracle Reports may have to start some work on data cursors before that trigger based on the definition of the report. One thing Oracle Reports Builder always does before the Before Report trigger is to describe the tables involved and open cursors. Any change to the tables after that will not be seen by the report.
See also
A built-in package is a group of logically related PL/SQL types, objects, and functions or procedures. It generally consists of two parts: the package spec (including data declarations) and the package body. Packages are especially useful because they allow you to create global variables.
Oracle provides several packaged procedures that you can use when building or debugging your PL/SQL-based applications. Your PL/SQL code can make use of the procedures, functions, and exceptions in the Oracle Reports Builder built-in package (SRW), and numerous Tools built-in packages, as described below.
Oracle Reports Builder is shipped with a built-in package (SRW), a collection of PL/SQL constructs that include many functions, procedures, and exceptions you can reference in any of your libraries or reports.
The PL/SQL provided by the SRW package enables you to perform such actions as change the formatting of fields, run reports from within other reports, create customized messages to display in the event of report error, and execute SQL statements.
You can reference the contents of the SRW package from any of your libraries or reports without having to attach it. However, you cannot reference its contents from within another product, for example, from SQL*Plus.
Constructs found in a package are commonly referred to as "packaged" (that is, packaged functions, packaged procedures, and packaged exceptions).
See also
Topic "SRW built-in package" in the Reference section of the Oracle Reports online Help
Several client-side built-in packages are provided that contain many PL/SQL constructs you can reference while building applications or debugging your application code. These built-in packages are not installed as extensions to the package STANDARD. As a result, any time you reference a construct in one of the packages, you must prefix it with the package name (for example, TEXT_IO.PUT_LINE).
The Tools built-in packages are:
Provides Dynamic Data Exchange support within Oracle Reports Builder components.
Provides procedures, functions, and exceptions for when debugging your PL/SQL program units. Use these built-in subprograms to create debug triggers and set breakpoints with triggers.
Provides procedures and functions for executing dynamic SQL within PL/SQL code written for Oracle Reports Builder applications.
Provides procedures, functions, and exceptions you can use to create and maintain lists of character strings (VARCHAR2). This provides a means of creating arrays in PL/SQL Version 1.
Provides a foreign function interface for invoking C functions in a dynamic library.
Provides an interface for invoking Java classes from PL/SQL.
Enables you to extract high-level information about your current language environment. This information can be used to inspect attributes of the language, enabling you to customize your applications to use local date and number format. Information about character set collation and the character set in general can also be obtained. Facilities are also provided for retrieving the name of the current language and character set, allowing you to create applications that test for and take advantage of special cases.
Provides procedures, functions, and exceptions you can use for tuning your PL/SQL program units (for example, examining how much time a specific piece of code takes to run).
Provides constructs that allow you to read and write information from and to files. There are several procedures and functions available in Text_IO, falling into the following categories:
Enables you to interact with Oracle environment variables by retrieving their values for use in subprograms.
Enables you to access and manipulate the error stack created by other built-in packages such as DEBUG.
In addition to using exceptions to signal errors, some built-in packages (for example, the DEBUG package) provide additional error information. This information is maintained in the form of an "error stack".
The error stack contains detailed error codes and associated error messages. Errors on the stack are indexed from zero (oldest) to n-1 (newest), where n is the number of errors currently on the stack. Using the services provided by the TOOL_ERR package, you can access and manipulate the error stack.
Provides a means of extracting string resources from a resource file with the goal of making PL/SQL code more portable by isolating all textual data in the resource file.
The following packages are used only internally by Oracle Reports. There are no subprograms available for external use with these packages.
Contains constructs used by Reports for private PL/SQL services.
Calls subprograms stored in the database. Calls to this package are automatically generated Note: STPROC is obsoleted in Oracle Reports 11g Release 1 (11.1.1).
Facilitates calling Java from PL/SQL.
See also
Topics for each of the Tools built-in packages under in the Reference > PL/SQL Reference > Built-in Packages section of the Oracle Reports online Help.
Triggers check for an event. When the event occurs they run the PL/SQL code associated with the trigger.
Report triggers are activated in response to report events such as the report opening and closing rather that the data that is contained in the report. They are activated in a predefined order for all reports.
Format triggers are executed before an object is formatted. A format trigger can be used to dynamically change the formatting attributes of the object.
Validation triggers are PL/SQL functions that are executed when parameter values are specified on the command line and when you accept the Runtime Parameter Form.
Database triggers are procedures that are stored in the database and implicitly executed when a triggering statement such as INSERT
, UPDATE
, or DELETE
is issued against the associated table.
Report triggers execute PL/SQL functions at specific times during the execution and formatting of your report. Using the conditional processing capabilities of PL/SQL for these triggers, you can do things such as customize the formatting of your report, perform initialization tasks, and access the database. To create or modify a report trigger, you use the Report Triggers node in the Object Navigator. Report triggers must explicitly return TRUE or FALSE.
Oracle Reports has five global report triggers. You cannot create new global report triggers. The trigger names indicate at what point the trigger fires:
Order of report trigger execution
The order of events when a report is executed is as follows:
Note: If the Parameter Form is used on the Web, the Before Parameter Form trigger fires twice: once when the Parameter Form is displayed, and a second time when the parameters are submitted. This is because Oracle Reports executes in a stateless fashion. There is no session to return to, so the Before Parameter Form trigger has to fire the second time to ensure that the parameters selected on the Parameter Form and passed on the command line are valid. |
Usage notes
Restrictions
WHERE
clause is replaced by a lexical reference): SELECT ENAME, SAL FROM EMP
&WHERE_CLAUSE
If the value of the WHERE_CLAUSE
parameter contains a reference to a bind variable, you must specify the value in the After Parameter Form trigger or earlier. You would get an error if you supplied the following value for the parameter in the Before Report trigger. If you supplied this same value in the After Parameter Form trigger, the report would run.
WHERE SAL = :new_bind
See also
A format trigger is a PL/SQL function executed before an object is formatted. A trigger can be used to dynamically change the formatting attributes of the object. For example, you can use a format trigger to cause a value to display in bold if it is less than zero. Another example is to use a format trigger to use scientific notation for a field if its value is greater than 1,000,000.
A format trigger can fire multiple times for a given object, whenever Oracle Reports Builder attempts to format the object. Consider the case where Oracle Reports Builder starts to format the object at the bottom of a page. If the object does not fit on the page, Oracle Reports Builder stops formatting and reformats on the following page. In this case, the format trigger will fire twice. It is therefore not advisable to do any kind of "persistence" operation, such as logging, in this trigger.
The Oracle Reports Builder SRW built-in package contains PL/SQL procedures with which you can quickly change the format attributes of an object. These include procedures to:
Examples
See the topic "Format trigger" in the Reference section of the Oracle Reports online Help.
See also
Validation triggers are PL/SQL functions that are executed when parameter values are specified on the command line and when you accept the Runtime Parameter Form.
Note: For JSP-based Web reports, the Runtime Parameter Form displays when you run a report in Oracle Reports Builder, but does not display in the runtime environment. If parameters are not specified on the Runtime Parameter Form, the validation trigger returns false and generates error messagerep-546 Invalid Parameter Input error . Thus, you need to provide the parameters in an alternate way, as described in Section 1.9.4, "About Parameter Forms for Web reports". |
Validation triggers are also used to validate the Initial Value property of the parameter. Depending on whether the function returns TRUE or FALSE, the user is returned to the Runtime Parameter Form.
Example
See the topic "Validation trigger" in the Reference section of the Oracle Reports online Help.
See also
Database triggers are procedures that are stored in the database and implicitly executed when a triggering statement such as INSERT, UPDATE, or DELETE is issued against the associated table. Triggers can be defined only on tables, not on views. However, triggers on the base table of a view are fired if an INSERT, UPDATE, or DELETE statement is issued against a view.
A trigger can include SQL and PL/SQL statements that execute as a unit, and can invoke other stored procedures. Use triggers only when necessary. Excessive use of triggers can result in cascading or recursive triggers. For example, when a trigger is fired, a SQL statement in the trigger body potentially can fire other triggers.
By using database triggers, you can enforce complex business rules and ensure that all applications behave in a uniform manner. Use the following guidelines when creating triggers:
For additional information about how triggers are used in applications, see the Oracle Application Developer's Guide. See the Oracle Concepts Manual for more information about the different types of triggers.
See also
The topics in this section discuss the use of templates in Oracle Reports Builder.
Templates define common characteristics and objects that you want to apply to multiple paper-based reports. For example, you can define a template that includes the company logo and sets fonts and colors for selected areas of a report.
When you use the Report Wizard to create a paper-based report, you use the Templates page of the wizard to apply a template (.tdf file) to the report. The Templates page lists the default templates, as well as any templates that you have created.
Note: If the list of templates does not appear, make sure that the REPORTS_PATH environment variable includes the location of the templates (for example,ORACLE_HOME \reports\templates ). |
When you choose a template, objects in the margin area of a template are imported into the same locations in the current report section, overwriting any existing objects. The characteristics (formatting, fonts, colors, and so on) of objects in the body area of the template are applied to objects in the body area of the current report section. Any template properties, parameters, report triggers, program units, and attached libraries you have defined are also applied. You can apply different templates to each section of the report. However, if you are applying one of the default templates, you cannot combine two report blocks that use different default templates in a single report. All of your report blocks in any one report must use the same default template.
If you later apply another template to a report, the existing template objects will be deleted in the current report section.
See also
In the Layout Body area of a template, you can define Default and Override attributes under the following Object Navigator nodes:
Default attributes
The Default node in the Object Navigator defines the default visual attributes (formatting, fonts, colors, and so on) for all report styles. If you want to define attributes for individual report styles, you do so under the Override node. When you apply a template to a report, all Default attributes are applied to the report, except for attributes that are localized under the Override node.
Override attributes
Under the Override node in the Object Navigator, you can define attributes for individual report styles. Each report style contains one or more sections that map to groups in the report:
Single-section report styles: Tabular, Form, Mailing Label, Form Letter
Multiple section report styles: Group Left, Group Above, Matrix, Matrix with Group
For the report styles that support multiple groups, you can create additional sections as needed. Sections are mapped to groups as follows:
Same number of groups as sections: one-to-one mapping (the first section is mapped to the first group, the second section to the second group, and so on).
More groups than sections: one-to-one mapping until the next-to-last section. Then, all subsequent groups are mapped to the next-to-last section, and the last group is mapped to the last section. If only one section exists, all groups are mapped to it.
More sections than groups: one-to-one mapping until the next-to-last group. Then, the last group is mapped to the last section.
See also
When you apply a template to a report, all of the following objects, properties, and attributes from the template are applied to the current report section:
In addition, all of the layout objects in the margin of the template are copied into the same location in the current report section.
Usage notes
See also
In templates, Sections, Frames, Fields, Labels, Headings, and Summaries properties all may inherit their values.
Default properties
The Default properties inherit the values preset by Oracle Reports Builder. When a property is set to its default Oracle Reports Builder value, the icon next to it in the Property Inspector is a small circle. Default properties become localized when you change their values, or select them and click the Localize Property button in the toolbar. When a property is localized, the icon next to it changes to a square. To return the properties to their inherited values, select the properties and click the Inherit Property button in the toolbar.
Override properties
The properties of Override Sections inherit their values from the Default properties. When a property inherits from a Default property, the icon next to it in the Property Inspector is an arrow. Properties in the Override Sections become localized when you change their values, or select them and click the Localize Property button in the toolbar. When a property is localized, the icon next to it changes to an arrow with a red cross through it. To return the values of properties in the Override Sections to their inherited values, select the properties and click the Inherit Property button in the toolbar.
The Template Editor is a work area in which you can define objects and formatting properties for your templates. It is similar to the Paper Layout view of the Report Editor. You can create, delete, and modify objects (for example, page numbers, text, and graphics) in the margin area. You cannot create and delete objects in the body area, but you can modify the properties of body objects in the Property Inspector (Tools > Property Inspector).
The Report Style list enables you to view the layout for a selected report style. To define default settings for all report styles, you can choose Default from the Report Style list. To make changes for an individual report style, you can select that report style from the Report Style list to specify settings that override the default.
Access
You can access the Template Editor in the following ways:
When creating a new template:
When displaying an existing template:
The topics in this section discuss the various output formats and capabilities in Oracle Reports Builder.
Note: When you run a report to preview format, empty browser windows are launched to display the output. To avoid opening such empty browser windows, complete the following steps in Internet Explorer 7:
If you are using browsers other than Internet Explorer, read their help information to modify this setting. |
In prior releases, Oracle Reports formatted the sections of a report in sequential order: Header section, followed by Main section, followed by Trailer section. This release introduces the capability to change the order in which the three sections of a report are formatted.
Note: Regardless of the order in which the report sections are formatted, the output order is unchanged: Header section first, then Main section, then Trailer section. |
The format order can be set in either of the following ways:
SRW.SET_FORMAT_ORDER
built-in procedure (if defined, overrides the Format Order of Sections property setting) This feature is useful for formatting any report section first to retrieve information that is known only at the time of formatting, such as page numbers, then using that information in the formatting of a previous section.
For example, to create a table of contents (TOC) for a report, you can format the Main section first and use report triggers to build a table containing the TOC entries. When the first element for the TOC is formatted, a trigger fires and creates a row in the TOC table containing the TOC entry and the page number. After the Main section has completed formatting, the format order setting can define that the Header section is formatted next. The Header section can contain a report block based on the TOC table. After formatting, you can output your report with a TOC (the Header section), followed by the report body (the Main section), followed by the Trailer section.
For the steps to create a TOC for a report, see the example reports in Chapter 35, "Building a Paper Report with a Simple Table of Contents and Index" and Chapter 36, "Building a Paper Report with a Multilevel Table of Contents".
A note about page numbering:
The page numbering of a report follows the format order. For example, in a report with a Header section of 2 pages, a Main section of 8 pages, and a Trailer section of 3 pages, with Format Order set to Main-Trailer-Header, the page numbering will be as follows in the report output: 12, 13 (Header pages, which were formatted last), 1, 2, 3, 4, 5, 6, 7, 8, (Main pages, which were formatted first) 9, 10, 11(Trailer pages, which were formatted second).
If it is not necessary to examine report output in the Previewer (for example, you may have to generate large volumes of output from a fully-tested report or run several reports in succession), you can run your report in batch using rwrun
. This leaves you free to pursue other tasks while your reports are running.
You can run reports in batch mode from the command line, or use a command file to specify arguments. A command file can save you a great deal of typing if you wish to run several reports using the same set of arguments.
You can also use the Reports Server to batch process reports by specifying BACKGROUND=YES
on the command line (valid for rwclient
or rwservlet
) to run reports asynchronously (the client sends the call to the server, then continues with other processes without waiting for the report job to complete; if the client process is killed, the job is canceled).
See also
Section 4.7.2, "Running a report from the command line"
Section 4.7.3, "Running a report using a command file"
The Reference > Command Line section of the Oracle Reports online Help (for information about BATCH
and BACKGROUND
)
Report distribution enables you to design a report that can generate multiple output formats and be distributed to multiple destinations from a single run of the report. You can create distributions for an entire report, and also burst to distribute individual sections of the report. For example, in a single run of a report, you can generate HTML output, send a PostScript version to the printer, and also e-mail any or all sections of the report to a distribution list.
To distribute a report, you first define the distribution, then enable the distribution, as described in Section 4.7.12, "Distributing a report to multiple destinations".
For an example of using section-level distribution, see Chapter 37, "Bursting and Distributing a Report". This chapter covers defining distribution of a single section to multiple destinations, using the Repeat On property and distribution XML file.
Usage notes
MODE
system parameter can only be set to one value per the entire report (DEFAULT
, BITMAP
, or CHARACTER
). XML
and DELIMITEDDATA
, as well as to layout-driven formats such as PDF
and ENHANCEDSPREADSHEET
, you must ensure the following requirements are met: include
element. For example: Examples
Example 1
You can use sectioning and distribution to publish your report output in HTML, and also send a PostScript version to the printer.
Example 2
You can send an executive summary of a report to senior management, and also e-mail detailed breakdowns to individual managers. In this example, a single report with two report sections needs to be created: a portrait-sized summary section and a landscape-sized detail section. Use the Repeat On property to associate the detail section with a data model group that lists the managers and then alter the destination to burst the report on each instance of the data model group to send the output to the appropriate managers.
See also
Section 2.1.2, "About report sectioning and sections"
Section 4.14.19, "Tracing report distribution"
Chapter "Creating Advanced Distributions" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Servicesmanual.
As an alternative to defining the distribution for a report or report section in the Distribution dialog box, you can also create a DST file and specify its name on the command line with the DESTINATION
keyword to distribute the report.
Note: DST files are supported for backward compatibility with prior releases; the preferred and recommended method of distributing reports is with the Distribution dialog box or using XML. |
If a DST file is specified on the command line, the distribution that it defines overrides the distribution defined using the Distribution dialog box.
Note: If you trace report distribution to identify distribution errors (see Section 4.14.19, "Tracing report distribution"), the trace file format is very similar to the DST file, so you can cut and paste to generate a DST file from the trace file. |
The format of each line of a DST file is as follows:
where
dist_ID
is an identifier for a distribution destination.
output_def
is a series of rwrun
or rwclient
command line keywords that specify the distribution definition. In addition, the following parameter is valid:
LEVEL
specifies the scope of the distribution.
Values for LEVEL
REPORT
means that the distribution applies to the entire report.
Header_Section
means that the distribution applies to the header section only.
Main_Section
means that the distribution applies to the main (body) section only.
Trailer_Section
means that the distribution applies to the trailer section only.
Default
REPORT
Example
The definition in this example sends report output to an HTML file, 3 copies of the main section to a printer, and the header section to a PDF file.
Note: All parameters for each distribution destination in a DST file (DEST1 , DEST2 , and DEST3 in the example above) must be specified on a single line. Specifying parameters on a new line results in failed distribution with error message REP-3430 4 and/or REP-34305 . |
See also
Pluggable destinations can be used to distribute any content that an engine (not only the Oracle Reports engine) has created in the Reports Server's cache. Oracle Reports provides the following out-of-the-box destinations:
You can also define access to your own custom destination by using the Oracle Reports Java APIs to implement a new destination component in the Reports Server. You can choose for your jobs to use an out-of-the-box destination or your customized destination to determine the destination for the output in the cache.
For information and steps to implement and register a destination class, then use the destination with Oracle Reports, see the Oracle FTP Destination tutorial available on the Oracle Reports Plugin Exchange on the Oracle Technology Network (OTN): on the Oracle Reports page (http://www.oracle.com/technology/products/reports/index.html
), click Plugin Exchange.
Note: Currently there is no support for FTP and WebDAV destinations from the Oracle Reports Builder environment. However, these destinations are supported from the Reports Runtime and the Reports Server environments. |
See also
Chapter "Configuring Destinations for Oracle Reports Services" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
Event-driven publishing enables you to set up a report to execute when a certain action has been performed. For example, when an employee submits an expense report, new data is being inserted into the database. When this insert event (for example, a database trigger or an Advanced Queuing (AQ) message) occurs, a report is sent to the employee's manager through their portal page or e-mail notifying them to approve/reject this expense report.
Event-driven publishing functionality includes making report objects available inside Oracle Workflow.For detailed information, refer to the chapter "Using Event-Driven Publishing" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services .
Using the Before Report, Between Pages, or format triggers, you can switch to different printer trays as your report formats. This enables you to easily print pages of the same report on different sheets of paper (for example, letterhead, forms, colored).
You can determine the names of the printer trays defined for your printer in the Page Setup dialog box, then use SRW.SET_PRINTER_TRAY
to set the printer tray as desired.
See also
Oracle Reports uses XML (Extensible Markup Language) in the following ways:
XML is a form of encoding text formats that can be read by many different applications. The XML tags can be used to output information or as a basis for building a pluggable data source to exchange electronic data with a third-party application (EDI).
You may change the XML properties that control XML output for your report at three levels: report, group, and column. Note that in any Oracle Reports Builder-generated XML file, your output mimics the data model, structured by groups and columns. For information on how to view your changes in XML output, see Section 4.7.7, "Generating XML output".
For detailed information about using XML for report distribution and customizing reports through XML, see the chapters "Creating Advanced Distributions" and "Customizing Reports with XML" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services .
See also
Section 4.7.7, "Generating XML output"
Section 4.7.1, "Running and dispatching a report from the user interface"
The XML PDS section of the Oracle Reports online Help
Oracle Reports Builder can generate report output to Hypertext Markup Language (HTML) and Hypertext Markup Language with a Cascading Style Sheet (HTMLCSS) files, containing the formatted data and all objects. When you generate your report output to an HTML or HTMLCSS file, you can distribute the output to any HTML destination, including e-mail, printer, Oracle Portal, and Web browser.
Usage notes
Note: If you modify your report's Before Report Value property or After Report Value property, you must make sure that you specify valid HTML. If the HTML is not valid, the generated HTML report output may not pass HTML 4.01 syntax checkers. |
desname
b.htm
. The report output filename is desname
d.htm
. desname
0.gif
... desname
17.gif
). Table 2-1 Report to HTML font sizes
Report font size | HTML font size |
---|---|
less than 8 | 1 |
8 through 9 | 2 |
10 through 12 | 3 |
13 through 15 | 4 |
16 through 20 | 5 |
21 through 30 | 6 |
more than 30 | 7 |
Note: If the font used in the report is non-proportional, TeleType mode is turned on for the generated HTML file. |
Restrictions
See also
Section 1.2.2, "About Web Reports"
Section 2.2.3, "About Web links for HTML output"
Section 4.7.5, "Generating HTML or HTMLCSS output"
Section 4.9.2.3, "Creating a boilerplate text object for HTML tags"
Section 4.9.2.7, "Linking an HTML text object to a file"
Section 4.8.4, "Selecting HTML tags from the database"
HTML page streaming enables you to display individual pages of your HTML/HTMLCSS report output in your Web browser, without having to download the entire report. From the first page of the report, you can navigate to any page in the rest of the report. When you click a bookmark or hyperlink with a destination:
Navigation controls
You can specify the navigation controls script for a report in either of the following ways:
.SET_PAGE_NAVIGATION_HTML
in a Before Report trigger) Output file names
With HTML page streaming, each page is formatted as a separate HTML document. If your HTML file is named myreport.htm
and there are no bookmarks, the new files are named as follows:
myreport.htm
(for the base frame) myreport
number
.htm
(for the bookmark file, present only if bookmarks are used in the HTML files) myreport
number
_1.htm
through myreport
number_n
.htm
( for the pages) myreport
number
j.htm
(for the navigation JavaScript) Scope of HTML output
To specify HTML to be displayed on only the first (header) or last (footer) pages of your report, set the Before Report or After Report properties or use the SRW.SET_BEFORE_REPORT_HTML
or SRW.SET_AFTER_REPORT_HTML
PL/SQL procedures. To specify global HTML to apply to the entire report, such as background colors or images, set the Before Page properties or SRW.SET_BEFORE_PAGE_HTML
PL/SQL procedure. The Oracle Reports Builder-generated HTML logo appears only on the last page of your report.
Enabling page-streamed output
To enable page streaming when you format your report as HTML or HTMLCSS output, you must specify PAGESTREAM=YES
on the command line. This option cannot be set using the Oracle Reports Builder user interface.
See also
Section 4.7.16.5, "Displaying individual pages of HTML report output"
Section 4.6.10.2.11, "Adding navigation controls for HTML page-streamed output using PL/SQL"
Oracle Reports allows a variety of fonts, styles, and colors for text objects in your reports. Through the use of the SRW
built-in procedures (see the Reference section of the Oracle Reports online Help), you can allow end users to change text attributes at runtime to a whole object, but not to a section of the text (for example, different formatting for different parts of a text object).
Alternatively, you can use a defined set of HTML formatting tags to format text style (bold, italics, underline, and strikethrough) and text attributes (font name, font color, and font size), and generate formatted text objects in all bitmap output formats supported by Oracle Reports when the objects' Contains HTML Tags property is set to Yes.
The text objects can have static values as in boilerplate text objects, or dynamic values as in field objects or text file link objects. A boilerplate text object can also have dynamic values if it references a field object or a report-level column. For boilerplate text, the formats specified at design-time are merged with rich text formats obtained at runtime. This feature also supports multibyte text containing HTML tags.
In the Paper Design view or Paper Layout view, you can choose the objects to which HTML formatting should be applied by setting their Contains HTML Tags property to Yes. If you run the report from the command line with CONTAINSHTMLTAGS=NO
, Oracle Reports will not interpret the HTML tags for the report, regardless of the object's Contains HTML Tags property setting. For HTML and HTMLCSS ouput, the browser will interpret the HTML formatting tags; for other output formats, the HTML tags themselves will appear as is in the report output.
The following HTML tags are interpreted by Oracle Reports if they appear in a boilerplate text, text file link, or field object. Any HTML tags or attributes not listed appear as is in non-HTML/HTMLCSS report output.
Table 2-2 Supported HTML tags
Tag | Result |
---|---|
| Text enclosed in either of these tags will be bold. For example:If the text is formatted as |
| Text enclosed in either of these tags will be italics. For example:If the text is formatted as the output will appear as |
| Text enclosed in this tag will be underlined. For example: If the text is formatted as the output will appear as |
| Text enclosed in either of these tags will be struck through. For example: If the text is formatted as the output will appear with a line struck through it. |
| Generic style container, used to specify font family, size, and color attributes, as described in Table 2-3. For example:
the output will appear in Times New Roman font, size 10 point, in red color. |
The following are the supported properties for the span
tag's style
attribute:
Table 2-3 Supported properties for style attribute of span tag
Property | Result |
---|---|
| This property specifies the font name. Oracle Reports provides support for specifying only one font name. If you specify a comma-separated list containing more than one font name, Oracle Reports uses the system default font (usually Courier, or its equivalent) to render this tag, without generating a warning. For example:
|
| This property describes the size of the font.CSS level 2 specifies the following options for this property:
Oracle Reports provides support for only where:
For example:
|
| This property describes the color of the enclosing element's text content. Oracle Reports supports the following options for this property:
where color names and rgb equivalents are as follows: aqua: For example:
Note: For
is equivalent to:
|
Usage notes
font face > font size > font style > font weight > font width
If Oracle Reports cannot match the font face, it will try to match the font size; if it cannot match the font size, it will try to match the font style; and so on. For the font lookup alogrithm, refer to the chapter "Managing Fonts in Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services . In font lookup, it is possible that the font used does not have all the required attributes (such as style, size, and so on) embedded in data. In this case, the unavailable font attributes do not appear in the report output.
Limitations
For example:
My<b
>format</b>
span
tag's style
attribute font-family
property. For example:
font-family:Arial
If you specify a comma-separated list containing more than one font name, Oracle Reports uses the system default font (usually Courier, or its equivalent) to render this tag, without generating a warning.
"
are not supported. For example:
<span style="font-family: "Courier New";">my format!</span>
You must use literal double quote (") instead.
Examples
Example 1: Inline font change
In a boilerplate text object, you can specify the text boilerplate as follows:
<b>My</b>text
With the Contains HTML Tags property set to Yes, the formatted output will look like this:
My text
Example 2: Single line text with multiple formats
Assume a span of text (in a boilerplate object or database column) that formats on one line, such as:
<b>My <span style="font-family:Courier">HTML</span>
</b><u><span style="font-family:Times New Roman">Formats</span></u>
With the Contains HTML Tags property set to Yes, the formatted output will look like this:
My HTML
Formats
Example 3: Multiline text with multiple formats
Assume a span of text that formats on multiple lines, such as:
Line 1: <i>My<span style="font-family:Courier">
Line 2: HTML</span></i><span style="font-family:Times New Roman><u>
Line 3: Formatting</u></span>.
With the Contains HTML Tags property set to Yes, the formatted output will look like this:
Line 1: My
Line 2: HTML
Line 3: Formatting.
Note in the preceding example that the formats are maintained in successive lines.
See also
Section 4.7.5, "Generating HTML or HTMLCSS output"
Section 4.9.2.3, "Creating a boilerplate text object for HTML tags"
Oracle Reports Builder can generate report output to PDF files, containing the formatted data and all objects. When you generate your report output to a PDF file, you can distribute the output to any PDF destination, including e-mail, printer, Oracle Portal, and Web browser.
Document taxonomy (classification) for PDF output is provided by the report properties Title, Author, Subject, and Keywords, which assist in cataloging and searching a report document.
With font subsetting, the PDF file includes the font information needed to render the PDF, regardless of the availability of that font on the machine used to view the report. PDF font subsetting works for single byte, multibyte, and Unicode fonts, and is the preferred method of creating multibyte reports.
Oracle Reports 10g Release 2 (10.1.2) provided the following enhancements to PDF output:
Oracle Reports 11g Release 1 (11.1.1) adds more enhancements to PDF output:
fonts
folder. For detailed information about PDF enhancements and capabilities in Oracle Reports, refer to the chapter "Using PDF in Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services .
Usage notes
Restrictions
See also
Section 1.2.2, "About Web Reports"
Oracle Reports Builder can generate report output to Rich Text Format (RTF) files, containing the formatted data and all objects. RTF can be read by many different word processing software packages, such as Microsoft Word. You can use the software's editing and graphics features to modify and enhance your report output. When you generate your report output to an RTF file, you can distribute the output to any RTF destination, including e-mail, printer, Oracle Portal, and Web browser.
Usage notes
Note: When you view the report in Microsoft Word in Office 95, you must choose View > Page Layout to see all the graphics and objects in your report. |
See also
Section 4.7.8, "Generating RTF output"
Section 4.7.1, "Running and dispatching a report from the user interface"
Oracle Reports can generate report output that includes a delimiter to delimited files (for example, files that contain comma-separated or tab-separated data), which are easily imported into spreadsheets or for use with word processors.
Oracle Reports provides two options for generating delimited output:
You can specify a delimiter (a character or string of characters) to separate the data (boilerplate or field objects) in your report output in either of the following ways:
DELIMITER
keyword. Note: If you do not specify a delimiter, the default delimiter is a tab. |
You can further distinguish the cells by using a cell wrapper. A cell wrapper can consist of any series of characters, such as a comma or parentheses.
For example, if the data in your report output include the same character as the delimiter (for example, a comma), you can use the parentheses cell wrapper to distinguish each cell:
Usage notes
DelimitedData output:
Delimited output:
When you generate a report to Delimited output, the data displays according to the positions of the objects in the Paper Layout view.
Restrictions
ID
(in uppercase) as the first field, you will be unable to open the file in Microsoft Excel. The following delimited output causes an error in Excel: ID, name, title, dept
If you want to generate delimited output that contains an ID
field, try changing the database column name to lowercase (that is, id
), or re-arranging the order of the fields.
DELIMITED
as an output format in a distribution XML file or in the Distribution dialog box. Note: You can distribute and burst a report in DelimitedData output format, specified either in a distribution XML file or in the Distribution dialog box.
See also
Section 4.7.10, "Generating delimited output"
Section 4.7.1, "Running and dispatching a report from the user interface"
Oracle Reports 11g Release 1 (11.1.1) introduces a new spreadsheet output format, ENHANCEDSPREADSHEET
, which enables you to burst and distribute reports to the spreadsheet format, as well as generate large data sets (up to 75,000 rows) to spreadsheets.
ENHANCEDSPREADSHEET
output formats generate output from paper layout report to HTML files that can be directly opened with Microsoft Excel 2000. You can:
.rdf
, .xml
, .jsp
), using rwrun
or Reports Server clients (rwclient
, rwservlet
). See the Example below. Note: DESFORMAT=ENHANCEDSPREADSHEET behavior is the same as the functionality of the rw:include JSP tag. Enhanced Spreadsheet output is not paginated; no page setup information is written in the output, and it is formatted as a single worksheet. Enhanced Spreadsheet output is driven by the layout; the reports ouput displays objects that are in the body area of each section (Header, Main, and Trailer) of the paper layout, and does not format any content in the margin, header, or footer areas. |
Prerequisites
Usage notes
direction
and charset
must be provided in a before report escape, because this information is not written to the generated output, by default. For example, you can define a before report escape as follows: cellspacing
, cellpadding
, and width
using the Table Attributes (HTML) property for frames and repeating frames. </body>
<table><tr><td><B> the text to be bolded </B></td><tr></table> </html>
<table><tr><td><B> the text to be bolded </B></td><tr></table>
</body>
</html>
REP-1223: THE PAGE SIZE IS INVALID
You can set the horizontal panels per page to a value higher than 1 for a matrix report for all DESFORMAT
s except ENHANCEDSPREADSHEET
.
rwservlet
commands such as SHOWJOBS
. It is also supported in Enterprise Manager's job queue, and in Oracle Portal's access object definition. Restrictions
ENHANCEDSPREADSHEET
output format only. Example
To generate the paper layout of your report to Microsoft Excel output through a URL (using rwservlet
), you can type a URL that includes the following in your browser:
Note: Microsoft Office 2000/2002/2003 supports Hypertext Markup Language (HTML) as a native file format. Enhanced Spreadsheet output relies on producing HTML output, which can be understood by Microsoft Excel as a file with valid Excel format. |
Other capabilities for generating Spreadsheet Output
You can also generate spreadsheet output as implemented in releases prior to Oracle Reports 11g Release 1 (11.1.1), in the following ways:
Advantage: Delimited output can be generated from existing paper layout reports saved in any format (.rdf
, .xml
, .jsp
), either directly from Oracle Reports Builder, or by running the report from the command line.
Disadvantage: Only data (as defined by the report Data Model), no layout information, displays in the output.
rw:include
tag to include the group frame of your paper layout in the Web source view as JSP code, save the report as a JSP file, then deploy the report. For the steps to implement this method, see Chapter 29, "Building a Report for Enhanced Spreadsheet Output". Advantage: You can use rich formatting such as colors and fonts so that you generate report layout, not just data, in Microsoft Excel output inside a Web browser.
Disadvantages: You must add custom JSP coding to get the output in Excel. The report can only be run through the JSP engine and not through rwservlet
, thus this method can only display the Microsoft Excel output inside a Web browser.
See also
Section 4.7.11, "Generating Enhanced spreadsheet output"
For choosing the appropriate delimited output solution for given requirements, see "Displaying Report Output in Microsoft Excel" in the appendix "Troubleshooting Oracle Reports Services" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services .
Oracle Reports Builder can generate report output to text files, containing the formatted data and all objects. When you generate your report output to text, and the running mode is character (MODE=CHARACTER, or MODE system parameter Initial Value property set to Character), the result is pure text output, which can be read by many different applications. If the running mode is bitmap (MODE=BITMAP, or MODE system parameter Initial Value property set to Bitmap), the result is PostScript output, which can be read and rendered only by PostScript-compatible applications (such as a PostScript printer).
See also
To create a character-mode report, you first create a bit-mapped report, then convert that report to an ASCII (character-mode) report. The process will create a new character-mode version of your bit-mapped report; the original bit-mapped report remains unchanged.
After conversion, many of your fields and text objects may need to be resized. Also, graphical objects such as images and drawings will not be included in your character-mode report. The following lists summarize what is supported in each output format:
Table 2-4 Supported items in bit-mapped and character-mode reports
Bit-mapped | Character-mode |
---|---|
Images | Boxes |
Colors | Horizontal lines |
Drawings | Vertical lines |
Ellipses/Circles | ASCII text |
Italicized text | Boldface text |
Diagonal lines | Underlines |
Bit-mapped patterns | |
Multimedia objects |
See also
Section 4.5.9, "Creating an ASCII (character-mode) report"
Section 4.2.5, "Setting properties for an ASCII (character-mode) report"
Section 4.7.1, "Running and dispatching a report from the user interface"
Oracle Reports enables you to access any data source. See Section 4.15.2, "Accessing non-Oracle data sources".
The topics in this section discuss information related to accessing other data sources in Oracle Reports Builder.
See also
The Pluggable Data Sources section of the Oracle Reports online Help, including the topics:
Database roles provide a way for end users to run reports that query tables to which they do not have access privileges. For example, a report may query a table that includes sensitive information such as salary data, even though the final report does not display this data.
Database roles are checked in the runtime environment only. If a table requires special access privileges, end users without those privileges cannot run a report that retrieves data from that table. However, if a database role is defined for the report, end users with privileges for that role can run the report using Reports Runtime (rwrun
).
Note: To run a report for which a database role is defined, the end user must run the .rdf file, not the .rep file. When running multiple reports, Reports Runtime automatically switches to the role defined for the current report. |
If you try to open a report in Oracle Reports Builder for which a database role has been defined, you will be prompted for the role password. Typically, only the report designer and DBA have this information.
See also
Oracle Net Services is Oracle's remote data access software that enables both client-server and server-server communications across any network. It supports distributed processing and distributed database capability. Oracle Net Services runs over and interconnects many communication protocols. Oracle Net Services is backwardly compatible with Net8 and SQL*Net.
In releases prior to Oracle Reports 10g, user exits provided a way to pass control from Oracle Reports Builder to a program you have written, which performs some function, and then returns control to Oracle Reports Builder. You could write ORACLE Precompiler user exits, ORACLE Call Interface (OCI) user exits, or non-ORACLE user exits to perform tasks such as complex data manipulation, passing data to Oracle Reports Builder from operating system text files, manipulating LONG RAW data, supporting PL/SQL blocks, or controlling real time devices, such as a printer or a robot.
Beginning with Oracle Reports 10g, you can call Java methods using the ORA_JAVA built-in package and the Java Importer. This reduces the need to have user exits in a report and allows for a more open and portable deployment. You may also use the ORA_FFI built-in package, which provides a foreign function interface for invoking C functions in a dynamic library. With the availability of these new built-in packages, the use of user exits is deprecated in Oracle Reports, though makefiles will still be supplied to permit you to continue to work with existing user exits.
In releases prior to Oracle Reports 10g, the Oracle Call Interface (OCI) provided a set of standard procedures that you could call in your 3GL programs to call Oracle Reports components. These procedures (written in C) were shipped with the Oracle Reports Builder, Reports Runtime, and Reports Converter components. For example, to run a Oracle Reports Builder report from a Pro*FORTRAN program, you could add a RWCRRB procedure call to your program to run the report using the Reports Runtime component.
Beginning with Oracle Reports 10g, the OCI is obsolete. Instead, use the rwclient.exe command line interface or the JSP tag library.
The topics in this section discuss debugging reports in Oracle Reports Builder.
Debugging an application is an iterative process in which application errors are identified and corrected. In general, quickly identifying and locating failing code is essential to successfully debugging your application.
See also
The PL/SQL Interpreter is your debugging workspace, where you can display source code, create debug actions, run program units, and execute Interpreter commands, PL/SQL, and SQL statements.
By default, two panes are always open in the PL/SQL Interpreter: Source pane and Interpreter pane.
Debugging features include the following:
The PL/SQL Interpreter's Source pane displays a read-only copy of the program unit currently selected in the Object Navigator pane.
The numbers along the left hand margin correspond to the line numbers of the displayed program unit.
In addition, the symbols described below may appear in the margin.
Table 2-5 Symbols in the margin of the Source pane
Symbol | Description |
---|---|
| | Specifies the current source location. |
=> | Specifies the current scope location. |
- | Specifies the current execution location (if different from the current scope location). |
B(n) | Specifies the location of a breakpoint, where n is the corresponding debug action ID. It appears in the line number column. |
T(n) | Specifies the location of a trigger, where n is the corresponding debug action ID. It appears in the line number column. |
The following commands are available when using the PL/SQL Interpreter:
Table 2-6 PL/SQL Interpreter Commands
Command | Description |
---|---|
CREATE | Creates a new library that can be stored in either the file system or the current database. |
DELETE | Deletes:
|
DESCRIBE | Inspects a variable or parameter that is local to the current scope location. The description includes the name, type, and value of the specified local. |
EXPORT | Writes the source of one or more program units to a text file. |
LIST | Displays the source text for program units, triggers, and debug actions. |
LOG | Saves a transcript of PL/SQL Interpreter input and output to the specified log file. |
RESET | Returns control to an outer debug level without continuing execution in the current debug level. |
SET | Changes the current scope location to a specified frame of the stack. You can specify relative motion from the current stack frame to any other frame, or move to a particular subprogram on the stack. There are several ways to invoke SET:
|
SHOW | Lists the name, type, and value of all variables and parameters at the current scope location. |
The PL/SQL Interpreter can be invoked from report code (triggers, user-named program units, libraries, and so on) by creating debug actions in the code. These are instructions that track the execution of PL/SQL program units so they can be monitored.
Each debug action you create is automatically assigned a unique numeric ID. While debugging, you can refer to this ID to browse, display, or modify a specific debug action with Oracle Reports Builder debug commands.
You can display detailed information about one or more debug actions, including its ID, source location, and whether or not it is enabled. You can temporarily disable specific debug actions and then re-enable them later if necessary.
There are two types of debug actions: breakpoints and debug triggers.
Breakpoints suspend execution at a specific source line of a program unit, passing control to the PL/SQL Interpreter.
Create breakpoints to identify specific debugging regions. For example, create a breakpoint at lines 10 and 20 to debug the code within this region.
With breakpoints, suspension occurs just before reaching the line on which the breakpoint is specified. At this point, use the PL/SQL Interpreter's features to inspect or modify program state. Once satisfied, resume execution with the GO or STEP commands, or abort execution using the RESET command.
Debug Triggers are a general form of debug action that associate a block of PL/SQL code with a specific source line within a program unit. When a debug trigger is encountered, Oracle Reports Builder executes the debug trigger code.
Create a debug trigger to execute a block of PL/SQL code provided at debug time in any of the following cases:
Debug triggers are especially useful as conditional breakpoints. You can raise the exception DEBUG.BREAK from within a trigger. For example, the debug trigger shown below establishes a conditional breakpoint on line 10 of my_proc
, which will be reached only if the local NUMBER variable my_sal
exceeds 5000:
You can create debug actions (breakpoints and debug triggers) in the PL/SQL Interpreter in the following ways:
When you create a debug action, attach the breakpoint or debug trigger to a program unit source line that is "executable." A source line is considered executable if it contains one or more statements for which the PL/SQL compiler generates code. For example, source lines containing assignment statements and procedure calls are executable, while source lines containing comments, blank lines, declarations, or the NULL statement are not executable.
See also
The current execution location specifies the next PL/SQL source line to be executed. It corresponds to what is commonly referred to as the program counter, or PC.
When control passes to the PL/SQL Interpreter while running a program (for example, when a breakpoint is encountered or following a step operation), the Source pane in the PL/SQL Interpreter automatically displays the source line associated with the current execution location.
Use the LIST command in the Interpreter pane to manually display the current execution location.
For example, entering:
will list the current execution location in the Source pane.
The current scope location dictates where the PL/SQL Interpreter looks for local variables and parameters. It corresponds to the current execution location of one of the PL/SQL subprograms on the stack.
Each time a program unit's execution is interrupted (for example, by a debug action), the scope location is initialized to the execution location of the subprogram at the bottom of the stack.
Once execution has been interrupted, you can change the current scope location to another frame on the stack. This enables you to view local variables in another subprogram in the call chain.
See also
When a debug action interrupts program execution, the PL/SQL Interpreter takes control and establishes what is known as a debug level. At a debug level, you can enter commands and PL/SQL statements to inspect and modify the state of the interrupted program unit as well as resume execution.
Since any PL/SQL code interactively entered at a debug level may itself be interrupted (for example, by encountering another breakpoint), it is possible for debug levels to nest. To facilitate distinguishing one debug level from another, the levels are numbered. The most deeply nested level is assigned the highest number. Numbering starts at zero with the outermost level.
The 0th or outermost level is commonly referred to as top level. Top level has no associated program state since it is the outermost level at which program units are originally invoked. When code invoked from top level is interrupted, debug level 1 is established. Similarly, interrupting code invoked from debug level 1 establishes debug level 2, and so on.
The PL/SQL Interpreter command prompt reflects the current debug level. When the PL/SQL Interpreter enters levels below top level, the prompt includes a prefix containing the current debug level number. For example, the PL/SQL Interpreter command prompt at debug level 1 appears as:
At runtime, you can modify and compile any program unit, menu item command, or trigger that is not on the current stack.
Note: To modify an item on the current stack, first clear the stack by issuing the RESET command. |
Although runtime code modification is not communicated back to Oracle Reports Builder, you can interactively test possible fixes, before returning to implement the eventual fix.
See also
This chapter provides an overview of the example reports in this manual. For information on accessing the demo reports and the data sources, refer to "Accessing the Example Reports" and "Accessing the Data Sources".
The chapter lists the example reports contained in this manual, a brief description of each report, a pointer to the location of the steps to build the example, and an image of the sample output.
This part of the manual introduces and explains the basic steps on how you can build reports.
In this example, you will use the Report Wizard to build a simple tabular report.
For more information on building this example, refer to Chapter 5, "Building a Tabular Report".
In this example, you will use the Report Wizard to build a simple mailing label report. The steps will show you how to fill out the provided template to format your mailing labels.
For more information on building this example, refer to Chapter 6, "Building a Mailing Label Report".
In this example, you will use the Report Wizard to build a simple form letter report. The steps will show you how to fill out the provided template to design your form letter.
For more information on building this example, refer to Chapter 7, "Building a Form Letter Report".
In this example, you will learn how to build a master/master report, which displays at least two sets of data which are not directly related. That is, the records constituting the data are fetched using at least two separate queries. A master/master report (also called a parent/parent report) contains two or more queries with no links (parent/child relationships).
For more information on building this example, refer to Chapter 8, "Building a Master/Master Report".
In this example, you will learn how to use the Summary Column tool to create a summary report.
A summary report contains at least one column whose value or values consist of a summary of other data. A column that totals sales, a column that averages a list of commissions, and a column that shows the maximum amounts found in a series of purchase orders are all examples of summary columns.
For more information on building this example, refer to Chapter 9, "Building a Summary Report".
This part of the manual explains the different kinds of report layouts.
In this example, you will build a simple group left report using one query.
Group left and group above reports divide the rows of a report into "sets," based on common values in one or more of the columns, such as the department number in the preceding example. In the sample output below, notice that each department number prints only once. If the report above was not a group report, the department number would print once for each employee in the department rather than just once for the whole department.
For more information on building this example, refer to Chapter 10, "Building a Single-Query Group Report".
In this example, you will build a group above report using two queries.
A two-query group report appears much the same as a single-query group report. Performance is the key issue when contrasting single-query and multiple-query group reports. In most cases, single-query reports will run faster than multiple-query reports. Multiple-query reports are, however, sometimes easier to understand conceptually and easier to maintain. For example, if you are in a situation where only a few users run the report and the report returns a relatively small number of records, you might want to use multiple queries to simplify maintenance and make the data model easier to understand. If you have many users and the report is quite large, then you should try to use a single-query report.
For more information on building this example, refer to Chapter 11, "Building a Two-Query Group Report".
In this example, you will build an across group report that prints the values of a database column across the page instead of down.
For more information on building this example, refer to Chapter 12, "Building an Across Group Report".
In this example, you will build a summary report that groups the summaries on the left in the report output.
This report consists of master records (Name, at the upper left of the figure below), detail records (Product, Itemtot, and Orderdate, to the upper right), and summary records (Product, and Sum Total). The summary calculates totals for the details under each master record. Notice that the column Product appears twice. With Reports Builder, you can display columns any number of times.
For more information on building this example, refer to Chapter 13, "Building a Group Left Summary Report".
In this example, you will use the Report Wizard to set up your report and write the one query that selects all the necessary database columns. You will then manually create the two formula columns to calculate tax and order totals for each customer, then add the formula columns to your report. You will use a Group Left style report to make the data in the report easy to read.
For more information on building this example, refer to Chapter 14, "Building a Group Left Formula Report".
This part of the manual explains how you can build reports with special formats.
In this example, you will build a break report where the line wraps on word boundaries if it is too long to fit on one line.
For more information on building this example, refer to Chapter 15, "Building a Wrapped Field Report".
In this example, you will build a report that has a page header printed in the upper margin area of every page of the report, and a footer printed at the end of the list of employee information for each department.
For more information on building this example, refer to Chapter 16, "Building a Header and Footer Report".
In this example, both the first and last department numbers found on each page are displayed in the page header.
For more information on building this example, refer to Chapter 17, "Building a Header with Database Values Report".
In this example, you will build a report and enhance it by adding an image to the margin, a title, and a border. You will also change the look of the report by applying different fonts and text styles.
For more information on building this example, refer to Chapter 18, "Building a Report with Graphics, Text, and Color".
In this example, you will build a report that numbers pages using the format "Page X of Y Pages". The first number (X) corresponds to the current page for each parent record (that is, each sales representative). This page number is reset to "1" for each sales representative, thus tracking the statistics of each representative separately.
For more information on building this example, refer to Chapter 19, "Building a Report that Renumbers Pages by Repeating Frame".
In this example, you will build a report where the group field appears between its related fields. Normally, a group (break) field appears to the left of (in group left report) or above (in group above report) its related fields.
For more information on building this example, refer to Chapter 20, "Building an Intermixed Fields Report".
In this example, you will build a master/detail report that fetches a master record with no associated details. In the sample output below, notice how the field labels for Department 40 do not display because no detail records were found. In this chapter, you will learn how to suppress the detail information for a single record, but allow the other master/detail records to display.
For more information on building this example, refer to Chapter 21, "Building a Report that Suppresses Labels".
In this example, you will build two form letters from the same report, as shown in the sample output below. As you can see, the two letters share a number of features. Hence, it is more convenient to create a base form letter and then apply conditions to certain parts to determine whether they should be displayed for the current record, in this case, employees.
For more information on building this example, refer to Chapter 23, "Building a Conditional Form Letter Report".
In this example, you will learn how to highlight data in your report. In this report that shows employee salaries, salaries that are greater than or equal to 10,000 are displayed in bold and in red color, and values that are between 4,999 and 10,000 are displayed in bold. Using the Conditional Formatting dialog box in Reports Builder, you can create format triggers that will change the appearance of retrieved data depending on factors you define.
For more information on building this example, refer to Chapter 22, "Building a Report with Conditional Highlighting".
In this example, you will build an employee report with a bar graph that displays monthly revenues for the company. Since the data in it changes monthly, you cannot import or draw the graph.
For more information on building this example, refer to Chapter 24, "Building a Report with Dynamic Graphics".
This part of the manual explains how you can build various kinds of matrix reports.
A matrix report looks like a grid. As shown in the sample output below, it contains one row of labels, one column of labels, and information in a grid format that is related to both the row and column labels. (Matrix reports are also sometimes referred to as "crosstab" reports.)
In this example, you will build a matrix report that contains three additions to the basic matrix: summaries have been added, zeroes replace non-existent values in the cells, and the cells themselves are surrounded by grid lines. Of the summaries, one sums the salaries by department, one sums them by job, and one sums them for the whole report.
For more information on building this example, refer to Chapter 25, "Building a Matrix Report".
In this example, you will build the nested matrix report shown below. The cross product is capable of displaying every possible value for three dimensions: two down (YEAR and DEPTNO) and one across (JOB). This method does not include rows that have null values.
For more information on building this example, refer to Chapter 26, "Building a Nested Matrix Report".
In this example, you will build a report that shows department, job, and salary information for each employee by the year they were hired using a matrix break format.
For more information on building this example, refer to Chapter 27, "Building a Matrix with Group Above Report".
This part of the manual explains how you can build various kinds of reports to suit your business requirements.
In this example, you will build a report that calculates and displays the four-month average of purchases for each customer. You will use the Report Wizard to create a simple time series calculations report for both paper and the Web. For the JSP-based Web report, you will modify the Web source to change labels and add format masks.
For more information on building this example, refer to Chapter 28, "Building a Time Series Calculations Report".
In this example, you will deploy a report with the Reports Server under Oracle WebLogic Server to display it in Microsoft Excel inside your Web browser, when you have an existing paper layout. You will generate a report to Microsoft Excel output after integrating the paper layout into a Web layout by modifying the Web source of your report.
For more information on building this example, refer to Chapter 29, "Building a Report for Enhanced Spreadsheet Output".
In this example, you will build a report that collects and displays names of all employees whose salaries fall within the range of 0 to 999, then collects and displays all employees whose salaries fall within the range of 1000 to 1999, and so on. You will be able to modify this report to display any aggregate range you need.
For more information on building this example, refer to Chapter 30, "Building a Report with Aggregate Data".
In this example, you will build a check printing report with a stub and spelled-out cash amounts. The steps described in this example will help you create a PL/SQL function that returns spelled-out numerical values. You will also learn how to import an image of a preprinted form (in this case, a blank check image) and use the tools in the Paper Layout and Paper Design views to print your report on such a form. Although we use a check as the example in this report, you can use the steps to use any preprinted form with Oracle Reports.
For more information on building this example, refer to Chapter 31, "Building a Check Printing Report with Spelled-Out Cash Amounts".
In this chapter, you will learn formatting techniques for printing reports on preprinted forms when you do not have access to a computer readable version of the forms. Such reports must be designed so that the data prints in exact positions on the form.
For more information on building this example, refer to Chapter 32, "Building a Report Using a Preprinted Form".
In this example, you will build a report that displays several distinguishing characteristics of a typical invoice, such as customer name and address, sales order number, billing information, and billing totals.
For more information on building this example, refer to Chapter 33, "Building an Invoice Report".
In this example, you will build a report that ranks data in two different ways: by count and by percentage. The upper portion displays the names and the total purchases of the top three customers; the lower portion displays the names and total purchases of those customers who constitute 75% of all sales. You can set the ranking criteria at runtime, or let them default to previously specified values.
For more information on building this example, refer to Chapter 34, "Building a Ranking Report".
This example is designed to teach you how to add navigational items to a large paper report. You will learn how to create a group above report, then add a simple table of contents to the beginning of your report, which will enable users to find an item by its category. You will also learn how to create an index so users can directly find a specific piece of information.
Note: Generating a table of contents or index is not supported for matrix reports. |
For more details on building this example, refer to Chapter 35, "Building a Paper Report with a Simple Table of Contents and Index".
This example is designed to teach you how to add a multilevel table of contents to a large paper report. You will add a table of contents based on a category and sub-category to an existing paper report.
Note: Generating a table of contents is not supported for matrix reports. |
For more details on building this example, refer to Chapter 36, "Building a Paper Report with a Multilevel Table of Contents".
In this example, you will modify a simple report we have provided to burst each section to a separate report. You will then modify a sample distribution XML file to send an e-mail to each destination with an attachment based on the separate reports. You will also send multiple e-mails to the same e-mail address with a single attachment (the entire report).
For more information on building this example, refer to Chapter 37, "Bursting and Distributing a Report".
Note: No sample output is available for this report. |
In this example, you will learn how to create a report in PDF format that contains multibyte characters for the Web and paper output. You will build a multibyte character set report using UTF8. You can produce reports that display text in multibyte character sets, such as Simplified Chinese, Traditional Chinese, Japanese, Korean, and Unicode.
For more details on building this example, refer to Chapter 38, "Building a Report with Multibyte Characters for PDF Output".
This part of the manual explains how you can build reports using PL/SQL and Java.
In this example, you will learn how to use an external PL/SQL library and PL/SQL within a report to modify formatting and calculate the total compensation for each employee. In the sample output below, notice the spacing between records (for example, between the record for Alexander Khoo and the record for Alexis Bull). This space is not due to a break; it is the result of using a PL/SQL procedure in a format trigger.
For more information on building this example, refer to Chapter 40, "Building a Report that Includes PL/SQL".
In this example, you will learn how to use Reports Builder's features for using REF CURSOR
s. To build this paper report, you will use the Data Model view to create a multiquery data model, and then use the Report Wizard to create the report layout. You will make fairly extensive manual refinements in the Data Model view.
For more information on building this example, refer to Chapter 41, "Building a Paper Report with REF CURSORs".
This example is designed to teach you how to build a simple JSP Parameter Form for a Web report. You will build a simple form in HTML, then create a JSP Parameter Form based on a data model in Reports Builder. You will then learn how to link the Parameter Form with an existing JSP-based Web report, then deploy and test both the JSP Parameter Form and the Web report through your browser.
For more details on building this example, refer to Chapter 42, "Building a Simple Parameter Form for a JSP-based Web Report".
In this example, you will build a report using the barcode Java bean in Oracle Reports. You will build two reports: one for paper and one for the Web. The paper report shows an invoice for a single customer who has ordered multiple items from a company. The barcode indicates the tracking information for the order.
For more details on building this example, refer to Chapter 43, "Building a Report with a Barcode".
In this example, you will use the properties in Oracle Reports to produce a JSP-based Web report that is accessible using assistive technology. You will learn how to modify an existing paper-based report to be accessible.
For more information on building this example, refer to Chapter 44, "Building an Accessible JSP-based Web Report".
Note: No sample output is available for this report. |
This part of the manual explains how you can build reports using pluggable data sources.
Reports Builder enables you to use any data source you wish. In this example, you will learn how to use the XML pluggable data source that is provided with Oracle Reports.
For more information on building this example, refer to Chapter 45, "Building a Report with an XML Pluggable Data Source".
In this example, you will learn how to use character-delimited text as a data source.
For more information on building this example, refer to Chapter 46, "Building a Report with a Text Pluggable Data Source".
In this chapter, each of the example reports contained in this manual are described. For more details on each of the examples, refer the location provided. For access to the latest versions of the documentation and example files, visit the Oracle Technology Network (OTN): on the Oracle Reports page (http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page.
This chapter provides procedures for using Oracle Reports to create objects and design your reports. Each topic in this chapter is also included in the How To... section of the Oracle Reports online Help (see Section 4.1.1, "Using the Oracle Reports online Help").
The procedures are grouped into the following sections:
This section provides procedures for the following tasks that you may perform to access the Oracle Reports documentation:
For more information on using Oracle Reports Builder, as well as Oracle Reports reference information, refer to the Oracle Reports online Help, which you can access in any of the following ways:
http://www.oracle.com/technology/products/reports/index.html
): readme.txt
in the download file. The following guidelines will help you to make effective use of the online Help:
To get started and become proficient with building reports, refer to the following resources:
Table 4-1 Oracle Reports documentation roadmap
For... | Refer to... |
---|---|
| |
| |
Instructions and hands-on lessons about building paper and Web-based reports |
|
Context-sensitive help on dialog boxes, messages, and properties |
|
Information about Oracle Reports Services and configuring and using the Reports Server |
|
Information about using the Oracle Reports application program interface (API) |
|
| |
Other resources, such as white papers |
|
This section provides procedures for the following tasks that you may perform as you work with property and preference settings:
To display the Property Inspector for an object:
See also
To set the properties for a report:
To specify the preferences for a report:
Oracle Reports 11g Release 1 (11.1.1) provides the Auto Save feature that recovers any unsaved changes during an unexpected event in Reports Builder or system failure.
If Auto Save is enabled, Reports Builder recovers any unsaved data automatically.
To enable the Auto Save feature:
To specify options for the Object Navigator display:
See also
To set properties for an ASCII (character-mode) report:
Note: By default, a report is defined in the Main section. |
See also
To set color palette preferences:
Note: A report can have only one color palette. |
See also
Section 2.4.5, "About changing colors and patterns"
Section 4.9.6.6, "Importing or exporting a color palette"
Section 4.9.6.5, "Modifying the color palette"
Section 4.9.6.2, "Changing colors"
Topics "Oracle CDE1 color palette", "Default color palette", and "Grayscale color palette" in the Reference > Color and Pattern Palettes section of the Oracle Reports online Help.
To set the properties of multiple objects:
Note: Any change you make to a property setting is applied to all of the objects in the current selection to which that property applies. |
For example, a report includes several fields, each of which displays the date. The Datatype property of each field is DATE, which causes dates to be displayed in the default ORACLE format DD-MON-YY.
To use a different date format throughout the application, you need to set the Format Mask property for each field that displays dates. Rather than setting each field's Format Mask property individually, select all of the items, then set the Format Mask property once to change the format mask for each item selected.
See also
Section 1.10.1.1, "About making multiple selections in the Property Inspector"
To compare the properties of one object to another:
A second Property Inspector is displayed. If the second window is on top of the first, drag it to move it alongside the first window.
As you work with Oracle Reports Builder, you will become very familiar with the following tasks:
Usage notes
Beginning with Oracle Reports 10g, reports are no longer stored in the database (including the obsolescence of Rename, Grant, and Get Info functionality for reports in the database). Instead, reports are saved to files.
To connect to a database when designing a report in Oracle Reports Builder:
To connect to a database using the command line:
rwbuilder
or rwrun
command line, use the USERID keyword to specify connection information (USERID=username[/password][@database]
). For information about USERID, see the Reference > Command Line section of the Oracle Reports online Help. To rename a report in the Object Navigator:
To rename a report in the file system:
To delete a report in the Object Navigator:
To delete a report in the file system:
To manipulate objects or define their properties, you must first select them.
To select a single object in the Object Navigator:
To select a single object in the Data Model view, Paper Layout view, Paper Design view, or Parameter Form view:
To select multiple objects in the Object Navigator:
Objects that are displayed in one of the Report Editor views are also selected in the corresponding view.
To select multiple objects in the Data Model view, Paper Layout view, Paper Design view, or Parameter Form view:
To select a set of objects owned by a frame or repeating frame:
All objects within the frame or repeating frame are selected, depending upon their explicit anchors.
To select grouped objects (grouped using Layout > Group Operations > Group), click the Select tool in the tool palette and click one of the grouped objects.
To select all objects within the region (Body or Margin of the Header Section, Main Section, or Trailer Section) you are currently editing, choose Edit > Select All. (In the Data Model view, note that this does not select any columns within groups.)
To select any object that is partially or completely overlapped by another object:
To deselect a single object in the Object Navigator:
To deselect a single object in the Data Model view, Paper Layout view, Paper Design view, or Parameter Form view:
To deselect all selected objects:
This section provides procedures for the following tasks that you may perform as you work with the Object Navigator:
See also
Section 1.5.1, "About the Object Navigator"
To display a Report Editor view from the Object Navigator, do any of the following:
Note: In the Object Navigator, there is no Paper Design node; the Paper Design view is displayed only after running a report. |
See also
Section 1.6.2, "About the Data Model view"
Section 1.6.3, "About the Paper Layout view"
To expand or collapse a node one level, do either of the following:
To fully expand or collapse a node, do either of the following:
To search for a specific node in the Object Navigator:
To view objects in the Object Navigator by object hierarchy to see the parent-child relationships:
To view objects in the Object Navigator by their type such as all queries under a single heading:
See also
See Section 4.2.4, "Setting preferences for the Object Navigator".
This section provides procedures for the following tasks that you may perform as you work with reports (either paper-based or Web-based):
To create a single-query report:
To build a multiquery report:
See also
Section 1.2.1, "About Reports"
Section 1.2.2, "About Web Reports"
Section 4.5.1, "Creating a report"
Section 1.3.1, "About tabular reports"
Section 1.3.2, "About group above reports"
Section 1.3.3, "About group left reports"
Section 1.3.4, "About form-like reports"
Section 1.3.5, "About form letter reports"
Section 1.3.6, "About mailing label reports"
Section 1.3.7, "About matrix reports"
See the example report in Chapter 11, "Building a Two-Query Group Report".
See the example report in Chapter 26, "Building a Nested Matrix Report".
To create a default layout for a report:
Caution: If you re-enter the Report Wizard after making manual adjustments to your layout in the Paper Layout or Paper Design view, you will lose these layout changes when you click Finish in the Report Wizard, which redefaults the layout. |
See also
Section 2.4.2, "About layout defaulting"
To add a new layout section to a report without overriding existing layouts:
Caution: If you re-enter the Report Wizard to make modifications, then click Finish in the Report Wizard, your entire layout will be overwritten with a new default layout. You will lose the additional report layout you have created, and any manual changes made to the layout in the Paper Layout or Paper Design view. |
See also
To create a table of contents (TOC) for a report, you can use the Format Order property or the SRW.SET_FORMAT_ORDER
built-in procedure to format the Main section of the report first and use report triggers to build a table containing the TOC entries. When the first element for the TOC is formatted, a trigger fires and creates a row in the TOC table containing the TOC entry and the page number. After the Main section has completed formatting, the format order setting can define that the Header section is formatted next. The Header section can contain a report block based on the TOC table. After formatting, you can output your report with a TOC (the Header section), followed by the report body (the Main section), followed by the Trailer section.
For two step-by-step examples, see Chapter 35, "Building a Paper Report with a Simple Table of Contents and Index" and Chapter 36, "Building a Paper Report with a Multilevel Table of Contents".
See also
To create an index for a report, you can use report triggers to build a table containing the index entries as you format the Main section of your report. When the first element for the index is formatted, a trigger fires and creates a row in the index table containing the index entry and the page number. After the Main section has completed formatting, the Trailer section is formatted next by default. The Trailer section can contain a report block based on the index table. After formatting, you can output your report with the report body (the Main section), followed by an index (the Trailer section).
For a step-by-step example, see Chapter 35, "Building a Paper Report with a Simple Table of Contents and Index".
To create an ASCII (character-mode) report:
See also
Section 2.8.15, "About creating an ASCII (character-mode) report"
Section 4.2.5, "Setting properties for an ASCII (character-mode) report"
To prepare a report to run on multiple platforms, consider the following GUI differences:
Fonts: A font type, style, or size might not be available in the target GUI. You can handle this in one of two ways:
uifont.ali
, to ensure that the fonts map correctly. Colors: A color might not be available in the target GUI. If possible, use a color that you know exists on the target GUI; otherwise, use one that maps well to the default color of the target GUI. The following colors are typically available on many platforms: blue, magenta, red, cyan, green, yellow.
DPI: The dots-per-inch (DPI) that your monitor uses may not be the same as the DPI used by the person who runs the report. The DPI only affects how alpha-numeric characters word-wrap on the screen. If you design a report that may be displayed in the Paper Design view, try to use the same DPI as the people who will run it. Also avoid giving layout objects fixed sizing.
This section provides procedures for the following tasks that you may perform as you work with Web reports:
See also
Section 1.2.2, "About Web Reports"
You can create a Web report in any of the following ways:
To view the source code for a Web report, do any of the following:
See also
Topic "Oracle Reports JSP tags" in the Reference section of the Oracle Reports online Help.
To retrieve the data to be used to build a report to add to an existing Web page (HTML file):
Caution: If you right-click the Data Model node, then choose Report Wizard to use the Report Wizard to select the data for a report, the report will overwrite all of the data in your existing Web page. |
After you click Finish, the data you have selected is available to your Web report.
Next step
To add a report block to an existing Web page:
Note: Adding some comment text such as "Place the report block here" to your Web page enables you to easily locate the correct position for your report block. |
To prepare a paper-based report for the Web:
See also
Section 1.2.2, "About Web Reports"
This section provides procedures that apply to paper-based reports generated to an HTML or PDF file. This is unrelated to HTML that might be generated when you run a JSP-based Web report (when you click the Run Web Layout button in the toolbar, or choose Program > Run Web Layout).
You can add Web links to paper-based reports by either:
This section provides procedures for the following tasks that you may perform using the Oracle Reports Builder user interface to add Web links to paper-based reports:
See also
Section 1.2.2, "About Web Reports"
Section 2.2.3, "About Web links for HTML output"
Section 2.2.4, "About Web links for PDF output"
Section 2.2.10, "About before and after escapes"
Note: This procedure is for HTML output only. |
To insert an HTML file or text on the header page of your HTML document:
See also
Section 4.6.10.2.1, "Creating an HTML document header using PL/SQL"
Note: This procedure is for HTML output only. |
To insert an HTML file or text on the footer page of your HTML document:
See also
Section 4.6.10.2.2, "Creating an HTML document footer using PL/SQL"
Note: This procedure is for HTML output only. |
To add a page header to every page of your HTML document:
To add a page header to a single page of your HTML document:
Note: This procedure is for HTML output only. |
To add a page footer to every page of your HTML document:
To add a page footer to a single page of your HTML document:
Note: This procedure is for HTML output only. |
To add items to the top of the HTML Parameter Form:
See also
Section 2.5.1, "About Parameter Form HTML extensions"
Section 4.6.10.2.5, "Creating an HTML Parameter Form header using PL/SQL"
Note: This procedure is for HTML output only. |
To add items to the bottom of the HTML Parameter Form:
See also
Section 2.5.1, "About Parameter Form HTML extensions"
Section 4.6.10.2.6, "Creating an HTML Parameter Form footer using PL/SQL"
To add a hyperlink destination to your report:
Note: If you are defining a template, you can select objects in the margin. Objects in the body are unknown until the template is applied to a report. |
See also
Section 2.2.7, "About hyperlink destinations"
Section 4.6.10.2.8, "Creating a hyperlink destination using PL/SQL"
To add a hyperlink to your report:
Note: If you are defining a template, you can select objects in the margin. Objects in the body are unknown until the template is applied to a report. |
For examples, see the description of the Hyperlink property in the Reference section of the Oracle Reports online Help.
Note: A report output in PDF format can include both hyperlinks and application command line links. If the Application Command Line property is set for an object, it will be applied to the object. Otherwise, the Hyperlink property is applied. |
See also
Note: This procedure is for PDF output only. |
To associate a command with an object in your report:
Note: If you are defining a template, you can select objects in the Margin. Objects in the body are unknown until the template is applied to a report. |
Note: A report output in PDF format can include both hyperlinks and application command line links. If the Application Command Line property is set for an object, it will be applied to the object. Otherwise, the Hyperlink property is applied. |
Restrictions
An object that is associated with an application command line link cannot also be the source of a Web link (a hyperlink).
See also
Section 2.2.9, "About application command line links"
Section 4.6.10.2.9, "Creating an application command line link using PL/SQL"
To create a bookmark on objects other than break columns in the bookmark area of your HTML or PDF document:
Note: If you are defining a template, you can select objects in the Margin. Objects in the body are unknown until the template is applied to a report. |
See also
To create a bookmark on break columns in the bookmark area of your paginated HTMLCSS or paper PDF document:
See also
Note: This procedure is for HTML output only. |
To add navigation controls for HTML page-streamed (paginated) output:
Note: If you do not change the default Page Navigation Control Value, Oracle Reports Builder will use a default built-in JavaScript for implementing the navigation between the pages of output. |
See also
Section 2.8.8.1, "About HTML page streaming"
Section 4.7.16.5, "Displaying individual pages of HTML report output"
Section 4.6.10.2.11, "Adding navigation controls for HTML page-streamed output using PL/SQL"
This section provides procedures for the following tasks that you may perform as you work with PL/SQL to add Web links to paper-based reports:
See also
Section 1.2.2, "About Web Reports"
Section 2.2.3, "About Web links for HTML output"
Section 2.2.4, "About Web links for PDF output"
Section 2.2.10, "About before and after escapes"
Note: This procedure is for HTML output only. A before report escape should be set in a trigger that fires before the report starts formatting, such as the Before Report trigger. |
To add items to the header page of your HTML document using PL/SQL instead of the Property Inspector:
See also
Section 4.6.10.1.1, "Creating an HTML document header using the Property Inspector"
Note: This procedure is for HTML output only. An after report escape should be set in a trigger that fires before the report is done formatting, such as the Before Report trigger. |
To add items to the footer page of your HTML document using PL/SQL instead of the Property Inspector:
See also
Section 4.6.10.1.2, "Creating an HTML document footer using the Property Inspector"
Note: This procedure is for HTML output only. If you want the escape to apply to every page, set it in a trigger that fires before the report begins formatting, such as the Before Report trigger. If you want the escape to apply to a single page, set it in a Format trigger |
To add a page header to every page of your HTML document using PL/SQL instead of the Property Inspector:
To add a page header to a single page of your HTML document using PL/SQL:
SRW.SET_BEFORE_PAGE_HTML
to define the PL/SQL for the format trigger. See also
Section 4.6.10.1.3, "Creating an HTML page header using the Property Inspector"
Note: This procedure is for HTML output only. If you want the escape to apply to every page, set it in a trigger that fires before the report begins formatting, such as the Before Report trigger. If you want the escape to apply to a single page, set it in a Format trigger. |
To add a page footer to every page of your HTML document using PL/SQL instead of the Property Inspector:
SRW.SET_AFTER_PAGE_HTML
to define the PL/SQL for the format trigger. To add a page footer to a single page of your HTML document using PL/SQL:
SRW.SET_AFTER_PAGE_HTML
to define the PL/SQL for the format trigger. See also
Section 4.6.10.1.4, "Creating an HTML page footer using the Property Inspector"
Note: This procedure is for HTML output only. A before form escape should be set in a trigger that fires before the Parameter Form starts formatting, such as the Before Parameter Form trigger. |
To add items to the top of the HTML Parameter Form using PL/SQL instead of the Property Inspector:
SRW.SET_BEFORE_FORM_HTML
to define the PL/SQL for the format trigger. See also
Section 2.5.1, "About Parameter Form HTML extensions"
Section 4.6.10.1.5, "Creating an HTML Parameter Form header using the Property Inspector"
Note: This procedure is for HTML output only. A before form escape should be set in a trigger that fires before the Parameter Form starts formatting, such as the Before Parameter Form trigger. |
To add items to the bottom of the HTML Parameter Form using PL/SQL instead of the Property Inspector:
SRW.SET_AFTER_FORM_HTML
to define the PL/SQL for the format trigger. See also
Section 2.5.1, "About Parameter Form HTML extensions"
Section 4.6.10.1.6, "Creating an HTML Parameter Form footer using the Property Inspector"
To add a hyperlink to your report using PL/SQL instead of the Property Inspector:
Note: If you are defining a template, you can select objects in the Margin. Objects in the body are unknown until the template is applied to a report |
SRW.SET_HYPERLINK
to define the PL/SQL for the format trigger.
SRW.SET_HYPERLINK_ATTRS
. Next step
Section 4.6.10.2.8, "Creating a hyperlink destination using PL/SQL"
See also
Section 2.2.5, "About hyperlinks"
Section 4.6.10.1.8, "Creating a hyperlink using the Property Inspector"
To add a hyperlink destination to your report using PL/SQL instead of the Property Inspector:
Note: If you are defining a template, you can select objects in the Margin. Objects in the body are unknown until the template is applied to a report. |
SRW.SET_LINKTAG
to define the PL/SQL for the format trigger. Next step
Section 4.6.10.2.7, "Creating a hyperlink using PL/SQL"
See also
Section 2.2.7, "About hyperlink destinations"
Section 4.6.10.1.7, "Creating a hyperlink destination using the Property Inspector"
Note: This procedure is for PDF output only. |
To associate a command with an object in your report using PL/SQL instead of the Property Inspector:
Note: If you are defining a template, you can select objects in the Margin. Objects in the body are unknown until the template is applied to a report. |
SRW.SET_PDF_ACTION
to define the PL/SQL for the format trigger. Restrictions
An object that is associated with an application command line link cannot also be the source of a Web link (a hyperlink).
See also
Section 2.2.9, "About application command line links"
Section 4.6.10.1.9, "Creating an application command line link using the Property Inspector"
To add a bookmark string in the bookmark area of your report using PL/SQL:
Note: If you are defining a template, you can select objects in the Margin. Objects in the body are unknown until the template is applied to a report. |
SRW.SET_BOOKMARK
to define the PL/SQL for the format trigger. See also
Section 2.2.8, "About bookmarks"
Section 4.6.10.1.10, "Creating a bookmark using the Property Inspector"
Section 4.6.10.1.11, "Creating a bookmark on break columns using the Property Inspector"
Note: This procedure is for HTML output only. |
To add navigation controls for HTML page-streamed output using PL/SQL instead of the Property Inspector:
See also
Section 2.8.8.1, "About HTML page streaming"
Section 4.7.16.5, "Displaying individual pages of HTML report output"
This section provides procedures for the following tasks that you may perform as you run and dispatch a report:
To run and dispatch a report from the Oracle Reports Builder user interface:
Note: When you create the report, you must use the Parameter Form Builder (choose Tools > Parameter Form Builder) to select the system and user parameters you want to appear in the Runtime Parameter Form. |
.prt
file) for character-mode reports). Note:
|
Note: The configuration fileORACLE_HOME \reports\conf\rwbuilder.conf must include the plug-in parameter mailServer (for example, <pluginParam name="mailServer">smtp01.mycorp.com</pluginParam>) with the outgoing mail server name. This applies in both the Windows and Solaris environments. |
Usage notes
See also
Section 4.11.6, "Selecting parameters to include in the Runtime Parameter Form"
To run a runfile (.rep
) or a report definition file (.rdf
) from the command line on Windows:
%ORACLE_HOME%\BIN\rwrun
, followed by the report name and desired arguments. DESTYPE=FILE DESNAME=
filename
DESFORMAT=
fileformat
), open or print the file to verify the output. See also
Section 1.12, "Oracle Reports Components"
Topic "rwrun" in the Reference section of the Oracle Reports online Help
To run a report using a command file on Windows:
%ORACLE_HOME%\BIN\rwrun
, followed by the report name and desired arguments. filename
.bat
. filename
.bat
on the command line. DESTYPE=FILE DESNAME=
filename
DESFORMAT=HTML
), open or print the file to verify the output. See also
Section 2.8.2, "About batch reporting"
Section 1.12, "Oracle Reports Components"
Topic "rwrun" in the Reference section of the Oracle Reports online Help.
To run a report to a remote Reports Server:
%ORACLE_HOME%\bin\rwclient
, followed by the report name, server name, and desired arguments. For additional information, see the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
To apply external style sheets and user-defined styles to your report or report objects for HTMLCSS output, you can set the following properties (for information about these properties, see the Reference > Properties section of the Oracle Reports online Help) :
To generate HTML or HTMLCSS output:
Note: If you choose to show all pages of your report output, and you have HTML page streaming enabled, the first page will display in your Web browser, and you will be able to quickly navigate to any other page in the rest of the report. |
See also
Section 2.8.8, "About HTML and HTMLCSS output"
To generate PDF output:
See also
In any Oracle Reports-generated XML file, your output mimics the data model; that is, it is structured by groups and columns. Follow the steps below to do any of the following:
To generate an XML output file from your current report in Oracle Reports Builder:
Tip: An .XML extension is required by XML-supporting browsers to recognize the format as XML and display it accordingly. |
To generate an XML output file from the command line, then preview the contents of the XML file in a Web browser:
DESFORMAT=XML
, DESTYPE=FILE
, and DESNAME=
filename
.XML
. To change the XML properties of the entire report:
To change the XML properties of a column or group:
Usage notes
type="packageSpec"
and/or type="packageBody"
to the function
element, as shown in the following example: This section provides procedures for the following tasks that you may perform as you work with the data model of your report:
To create a query, you can use any of the following tools:
REF CURSOR
s)See also
Section 1.7.1, "About queries"
Section 1.7.3, "About database columns"
To create a query using the Report Wizard:
SELECT
statement in the Data Source definition field.To create a query using the Data Wizard:
Note: The Data Wizard does not support creating links between queries. To define parent/child query relationships, you can create a data link manually. |
To create a SQL query:
SELECT
statement for the query in any of the following ways:SELECT
statement yourself, type it in the SQL Query Statement field.Tip: Select the columns in the order you want them to appear in the report output. |
Note: If you define multiple queries in the Data Model view of your report, the Data page does not appear when you invoke the Report Wizard to default the layout. |
To create an XML query:
To create a JDBC query:
To create a Text query:
To create a REF CURSOR
query:
REF CURSOR
type in one of the following ways:REF CURSOR
type you defined in the package. For example:Note: Oracle Reports supports both static and dynamic REF CURSOR s. For more information, see Section 2.6.10, "About REF CURSOR queries". |
REF CURSOR
query object, then choose Tools > Property Inspector to modify properties.REF CURSOR
query you want to create.See also
Section 2.6.10, "About REF CURSOR queries"
To modify a SQL query statement or the columns displayed in your report:
SELECT
statement, click the Data tab.To modify the properties of a query:
You can use Query Builder to define almost any query that you would build using a SQL SELECT
statement. Query Builder automatically generates the appropriate SELECT FROM [table.column]
clause based on columns displayed in the Query Builder workspace.
See the How To section of the Oracle Reports online Help for topics about using Query Builder.
See also
Section 1.7.5, "About Query Builder"
Note: This procedure applies to paper-based reports. |
To select HTML tags from the database:
SELECT
statement that selects a column containing HTML tags or the names of files that contain HTML tags.Usage notes
When the text object's Contains HTML Tags property is set to Yes, HTML tags and attributes are formatted in your report output as follows:
Note: These steps, and the steps in Section 4.9.8.1.2, "Linking an image object to a file" (for paper-based reports only), allow you to include images in a wide variety of formats supported by Oracle Reports, including JPEG (all types, such as Progressive JPEG and Exif JPEG), PNG, BMP, TIFF, GIF, and CGM. For paper-based reports, you can also use Insert > Image to import an image from a file into the report layout for images in the following formats: TIFF, JFIF, BMP, TGA, PCX, PICT, GIF, CALS, RAS, OIF, PCD (see Section 4.9.8.1.1, "Importing an image"). |
To select an image from the database:
containsHtml
attribute to the <rw:field>
JSP tag for the column, as follows:rw:field
tag for the column (<rw:field ... src="column_name" ...>
)containsHtml=yes
attribute to specify that the field's value contains an image.For example:
See also
Section 1.7.3, "About database columns"
Notes: This procedure is for HTML output only. These steps, and the steps in Section 4.9.8.1.3, "Linking an image object to a URL" (for paper-based reports only), allow you to include images in a wide variety of formats supported by Oracle Reports, including JPEG (all types, such as Progressive JPEG and Exif JPEG), PNG, BMP, TIFF, GIF, and CGM. For paper-based reports, you can also use Insert > Image to import an image from a file into the report layout for images in the following formats: TIFF, JFIF, BMP, TGA, PCX, PICT, GIF, CALS, RAS, OIF, PCD (see Section 4.9.8.1.1, "Importing an image"). |
To select a URL from the database that point to an image to include in an HTML report:
SELECT
statement that selects a column containing URLs.containsHtml
attribute to the <rw:field>
JSP tag for the column, as follows:rw:field
tag for the column (<rw:field ... src="column_name" ...>
)containsHtml=yes
attribute to specify that the field's value contains an image.For example:
See also
Section 2.8.8, "About HTML and HTMLCSS output"
You can define break groups in the Report Wizard or create them manually.
To create a break group manually:
See also
Section 1.3.2, "About group above reports"
Section 1.3.3, "About group left reports"
You can define matrix groups in the Data Wizard or create them manually.To create a matrix (cross-product) group using the Data Wizard:
To create a matrix (cross-product) group manually:
See also
Section 2.3.7, "About matrix objects"
Section 1.3.7, "About matrix reports"
Section 2.1.7, "About nested matrix reports"
Section 2.1.8, "About matrix with group reports"
Section 4.9.1.3, "Creating a matrix object"
Section 4.5.3, "Creating a nested matrix report"
Section 1.3.2, "About group above reports"
Section 1.3.3, "About group left reports"
To create a data link:
Create a Group to Group Link: To create a link between one query's group and another query's group, which is useful when you want the child query to know about the parent's data, click the parent group (avoiding the columns in the group) and drag a link to the child group.
Create a Column to Column Link: To create a link between columns, click a column of the parent query and drag a link to a column of the child query.
See also
Section 1.7.4, "About data links"
Section 2.3.5, "About non-linkable queries"
To create or edit a formula column:
Example: Referencing a PL/SQL function in formulas
Suppose that you have a report with the following groups and columns:
Given these groups and columns, you might create multiple formulas that apply the cost of living factor (COSTOFLIVING) to salaries. To avoid duplication of effort, you could create the following PL/SQL function and reference it from the formulas:
Following are some examples of how you might reference the PL/SQL function in formulas:
or
See also
Section 2.3.2, "About formula columns"
To create a summary column (for totals or subtotals) using the Data Wizard:
Note: For group reports, the Report Wizard and Data Wizard create n summary fields in the data model for each summary column you define: one at each group level above the column being summarized, and one at the report level. For example, if a report is grouped by division, and further grouped by department, then a summary column defined for a salary total would create fields for the sum of salaries for each division and each department group (group-level summaries), and the sum of all salaries (report-level summary). |
To create a summary column (for totals or subtotals) using the tool palette:
Usage notes
For JSP-based Web reports with a Group Above or Matrix style, if any summary column values are not correctly left-aligned when you click the Run Web Layout button in the toolbar (or choose Program > Run Web Layout), you can implement the following workaround to align the values:
See also
Section 2.3.1, "About summary columns"
Chapter 9, "Building a Summary Report"
Chapter 13, "Building a Group Left Summary Report"
To create or edit a placeholder column:
See also
Section 2.3.2, "About formula columns"
This section provides procedures for creating and modifying objects in your report layout. The procedures are grouped into the following sections:
This section provides procedures for the following tasks that you may perform as you work with container objects:
To create a field object manually in the report layout:
See also
Section 1.9.2, "About Parameter Form fields"
To create a frame or repeating frame manually:
Note: The size of the rectangle must be large enough to include the objects that it will contain. |
See also
Section 1.8.2, "About repeating frames"
Section 1.8.3, "About frame and repeating frame sizing"
Note: This procedure provides steps to create a matrix object manually. The recommended method for creating a matrix object is to use the Report Block Wizard (choose Insert > Report Block in the Paper Layout view). |
To create a matrix object:
This creates a matrix object that is the intersection of the two repeating frames. For example:
See also
Section 2.3.7, "About matrix objects"
Section 1.3.7, "About matrix reports"
Section 2.1.7, "About nested matrix reports"
Section 2.1.8, "About matrix with group reports"
Section 4.8.8, "Creating a matrix (cross-product) group"
Section 4.5.3, "Creating a nested matrix report"
Note: Beginning with Oracle9i Reports, Release 2 (9.0.2), you can use a barcode JavaBean that automatically generates the barcode for you. See the example report in Chapter 43, "Building a Report with a Barcode". |
To create a barcode using a barcode font:
Note: For portability between platforms, you can use a PostScript barcode font to allow you to print your report to any PostScript-enabled output device. |
To apply conditional formatting to a layout object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
Usage notes
See also
Section 2.1.6, "About conditional formatting"
Chapter 4, "Highlighting a value"
Chapter 4, "Highlighting a row"
This section provides procedures for the following tasks that you may perform as you work with text objects:
To create a boilerplate object for text:
The text you type is composed of paragraphs which are separated by new lines. Text within a paragraph is word-wrapped inside the boilerplate object's horizontal size.
See also
Section 1.8.5, "About boilerplate objects"
To create a boilerplate object for text that displays every other page:
See also
Section 1.8.5, "About boilerplate objects"
Note: This procedure applies to paper-based reports. |
To create a boilerplate text object for HTML tags:
Usage notes
When the text object's Contains HTML Tags property is set to Yes, HTML tags and attributes are formatted in your report output as follows:
Example 1: Turning formatting on and off
Consider a text boilerplate object that is defined as follows:
With its Contains HTML Tags property set to Yes, this will format as:
Design time format is merged with run time formatting instructions.
With its Contains HTML Tags property set to No, this will format in the report output as:
<i><b>Design time format</b> is merged with <span style="font-family:Arial; color:#00F">run time formatting instructions.</span></i>
Example 2: Boilerplate text object tagged as a hyperlink
In a boilerplate text object, you can type the following text:
With the Contains HTML tags property set to Yes, this object will appear in HTML/HTMLCSS report output as a graphic (oracle.gif) , which the end user can click to link to my_report.html.
Example 3: Parameter values output to HTML
In a boilerplate text object, you can type the following Java Applet, called NervousText.class
, which takes the object width and height as parameters:
With the Contains HTML tags property set to Yes, this object will be interpreted with the parameters replaced with their actual values, as follows:
See also
Section 1.8.5, "About boilerplate objects"
Section 2.5.1, "About Parameter Form HTML extensions"
To insert and replace text:
To delete text:
To cut, copy, or paste text:
To reference a field in boilerplate text:
If you want to place the field reference in front of other text with no spaces in between, enclose the field name in angle brackets to separate it from the text (for example, &<
fieldname
>Oracle
). If the field reference follows other text, no angle brackets are needed (for example, Oracle&
fieldname
). You can include field references right next to each other with no spaces in between and without angle brackets (for example, &field1&field2&field3
).
Usage notes
f_sal
is fixed horizontally, $&<f_sal>/week
may produce $800/week
in the report output.&SAL
). For example, $&<SAL>/week
may produce $800/week
in the report output.See also
Section 1.8.5, "About boilerplate objects"
Note: This procedure applies paper-based reports. File Link objects are not implemented in JSP-based Web reports. |
To link a boilerplate text object to a file:
See also
Section 1.8.5, "About boilerplate objects"
Note: This procedure applies to paper-based reports. File Link objects are not implemented in JSP-based Web reports. |
To link an HTML object to a file:
Usage notes
When the text object's Contains HTML Tags property is set to Yes, HTML tags and attributes are formatted in your report output as follows:
See also
Section 1.8.5, "About boilerplate objects"
To wrap text in a field:
Caution: If you have made manual adjustments to your layout in the Paper Layout view or Paper Design view, you will lose these layout changes when you click Apply or Finish in the Report Wizard, which redefaults the layout. If you do not want to overwrite your current layout, you can manually drag the column to the desired width in the Paper Layout view or Paper Design view. |
To change the font, justification, spacing, or reading direction of a text object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
To change the font or justification of a text object using PL/SQL instead of the user interface:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
SRW.SET_FONT_FACE
SRW.SET_FONT_STYLE
SRW.SET_FONT_WEIGHT
SRW.SET_FONT_SIZE
SRW.SET_JUSTIFICATION
See also
Topic "SRW built-in package" in the Reference > PL/SQL Reference > Built-in Packages section of the Oracle Reports online Help.
This section provides procedures for the following tasks that you may perform as you work with page numbers or date/time stamps:
To create default page numbers:
To create customized page numbers:
Note: The margin area is defined by a thick black line that separates it from the body. If you create objects in the body portion of a report while displaying the margin area, you can only edit those objects when the margin is displayed. |
&
fieldname
.
Usage notes
To reset default page numbers (created with Insert > Page Number):
To add a date or time stamp to your report:
This section provides procedures for the following tasks that you may perform as you work with borders:
To show or hide the borders around an object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
Note: If you make the borders transparent for all the objects, this includes the underlines beneath the column headings. To add the underlines, click the underline objects, and use the Line Color in the tool palette to select a line color. |
To change the borders around an object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 2.4.5, "About changing colors and patterns"
Section 4.12.8, "Modifying the color, pattern, or border of body objects in a template"
To set or override Confine mode:
On: child objects cannot be moved outside their enclosing parent objects.
Off: child objects can be moved outside their enclosing parent objects.
On: parent borders "stretch" when child objects are moved against them. The child object maintains the same distance from the side it moves against.
Off: parent borders remain fixed when child objects are moved against them.
See also
Section 2.4.7, "About moving and layering objects in the Paper Layout view"
Chapter 4, "Adjusting parent borders automatically"
Chapter 4, "Moving an object outside its parent"
This section provides procedures for the following tasks that you may perform as you work with anchors:
See also
Section 2.4.4, "About anchors"
Anchoring objects assures that the anchored object will move with the parent object. An object can be anchored to only one other object.
To anchor objects together:
A line is drawn from the child to the parent. A small box appears at the end of the line that is attached to the parent object.
By default, you see the explicit anchors created in the Paper Layout view of the Report Editor.
To view information on both implicit and explicit anchors:
With this option selected, you can see all information on both implicit and explicit anchors in the Object Navigator.
Note: By default, objects are anchored to the upper left corner of their enclosing object. If this view of the Object Navigator does not show anchoring information for an object, you can assume that the object is anchored to its enclosing object, which might be the frame or the body. |
See also
Section 2.4.4.1, "Implicit anchoring algorithm"
Moving an anchor changes how the objects will be displayed in relationship to each other.
To move an anchor:
To move an anchor along an object edge:
To change the position of the anchor on the object edge, as a percentage down or across from top to bottom or left to right:
To change the edge on which the anchor is positioned:
This section provides procedures for the following tasks that you may perform as you work with colors, patterns, and highlighting:
To change the color of an object or text:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
Note: The Fill/Line/Text Display, the box directly above the three Color tools, shows the currently selected fill, border, and text. The default fill and border for objects created by Oracle Reports Builder is transparent, while the default for objects you create is a black, one-point line around a white. |
See also
Section 2.4.5, "About changing colors and patterns"
Section 4.12.8, "Modifying the color, pattern, or border of body objects in a template"
To change the pattern of an object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
Note: The Windows platform does not support a border pattern (that is, patterns for the Line Color tool). |
See also
Section 2.4.5, "About changing colors and patterns"
Section 4.12.8, "Modifying the color, pattern, or border of body objects in a template"
Topic "Pattern color palette" in the Reference > Color and Pattern Palettes section of the Oracle Reports online Help.
To change the color of an object using PL/SQL instead of the user interface:
SRW.SET_BACKGROUND_BORDER_COLOR
SRW.SET_BACKGROUND_FILL_COLOR
SRW.SET_FOREGROUND_BORDER_COLOR
SRW.SET_FOREGROUND_FILL_COLOR
SRW.SET_TEXT_COLOR
SRW.SET_BORDER_PATTERN
See also
Section 2.4.5, "About changing colors and patterns"
Topic "SRW built-in package" in the Reference > PL/SQL Reference > Built-in Packages section of the Oracle Reports online Help.
To modify the color palette:
Note: By default, color palettes are read-only. |
Note: A report can have only one color palette. |
See also
Section 2.4.5, "About changing colors and patterns"
Topics "Oracle CDE1 color palette", "Default color palette", and "Grayscale color palette" in the Reference > Color and Pattern Palettes section of the Oracle Reports online Help.
To import or export a color palette:
Note: By default, color palettes are read-only. |
Note: A report can have only one color palette. |
See also
Section 2.4.5, "About changing colors and patterns"
Topics "Oracle CDE1 color palette", "Default color palette", and "Grayscale color palette" in the Reference > Color and Pattern Palettes section of the Oracle Reports online Help.
To highlight a value in a report:
Note: If you can't select the condition you want to use in the dialog box, select the formatting you want and a placeholder condition. The condition can be edited in the PL/SQL Editor for the format trigger that is created. |
Example
The following code determines the monthly compensation and changes the background color to red if the compensation has exceeded four thousand dollars a month and the employee is not a manager.
See also
Section 2.1.6, "About conditional formatting"
Section 4.9.1.5, "Applying conditional formatting to a layout object"
Note: If you can't select the condition you want to use in the dialog box, select the formatting you want and a placeholder condition. The condition can be edited in the PL/SQL Editor for the format trigger that is created. |
Example
The following code determines the monthly compensation and changes the background color to red if the compensation has exceeded four thousand dollars a month and the employee is not a manager.
See also
Section 2.1.6, "About conditional formatting"
Section 4.9.1.5, "Applying conditional formatting to a layout object"
To alternate the colors of either the text or the fill of a row:
This section provides procedures for the following tasks that you may perform as you work with format masks:
The following tables describe the date and time format masks, and the suffixes you can add to date format masks:
Table 4-2 Date and time format masks
Format Mask | Description |
---|---|
SCC or CC | Century, abbreviated; 'S' prefixes "BC" with (-) |
SYYYY or YYYY | Year; 'S' prefixes "BC" date with a (-) |
I or IY or IYY | Last 1, 2, or 3 digit(s) of year |
Y or YY or YYY | Last 1, 2, or 3 digit(s) of year |
Y,YYY | Year with comma |
SYEAR or YEAR | Year, spelled out; 'S' prefixes "BC" date with (-) |
RRRR or SRRRR | Year; 'S' prefixes "BC" date with a (-) |
RR | Last 2 digit(s) of year |
BC, AD, or B.C., A.D. | Century indicator |
Q | Quarter of year (Jan-Mar= Quarter 1) |
MM | Month in digits (Jan = 01) |
MONTH or MON | Name of month, or 3-letter abbreviation |
WW, IW | Week in year |
W | Week in Julian days |
J | Julian day; the number of days since January 1,4712 BC |
DDD, DD, or D | Day in year, month, or week |
DAY | Day of week fully spelled out (for example, MONDAY) |
DY | Name of day, 3-letter abbreviation (for example, MON) |
AM, PM, or A.M., P.M. | Meridian indicator |
HH or HH12 | Hour of day (1-12) |
HH24 | Hour of day (0-23) |
MI | Minute |
SS; SSSSS | Second in minute; seconds in day |
FM | Toggles fill mode which replaces multiple spaces before or between dates, numbers, or words with a single space |
The following suffixes may be added to the format masks:
Table 4-3 Date format mask suffixes
Suffix | Description |
---|---|
TH | Suffixed number ("DDth" for "4th") |
SP | Spelled out number ("DDSP" for "FOUR") |
SPTH or THSP | Spelled and suffixed number ("DDSPTH" for "FOURTH") |
Examples
Table 4-4 Date format mask examples
Sample Date Format | Date Displayed |
---|---|
MM/DD/RR | 03/04/09 |
DD MON RRRR | 04 MAR 2009 |
Mon. DD, RRRR | Mar. 4, 2009 |
Day Month DD fmHH:MI AM | Monday March 4 11:35 AM |
Dy Mon ddth fmHH24:MI:SS | Mon Mar 4th 23:35:22 |
Day "the" ddthsp "of" Month | Monday the fourth of March |
The following table describes the tokens you can use in creating a number format mask:
Table 4-5 Tokens for number format masks
Format Token | Description |
---|---|
0 | Prints one digit. |
N | Prints one digit, unless it is a leading zero to the left of the decimal point or a trailing zero to the right of the decimal point. |
* | Prints one digit, unless it is a leading zero to the left of the decimal point, in which case an asterisk (*) is printed. Trailing zeros to the right of the decimal point are printed. |
9 | Prints one digit, unless it is a leading zero to the left of the decimal point, in which case a space is printed. Trailing zeros to the right of the decimal point are printed. |
+ | Prints a leading plus (+) for positive values and a leading minus (-) for negative values. This token must lead the mask. |
- | Prints a leading minus (-) for negative values and nothing for positive values. This token must lead the other tokens. |
MI | Prints a minus (-) after negative values and a space after positive values. This token must trail the other tokens. |
S | Prints a minus (-) for negative values and a plus (+) for positive values (wherever the S appears in the mask). This token must lead or trail the other tokens. |
PR | Prints angle brackets (<>) around negative values and spaces around positive values. This token must trail the other tokens. |
( ) | Prints parentheses around negative values and spaces around positive values. The parentheses must surround the other tokens. |
DB | Prints a "DB" after positive values. This token must trail the other tokens. |
CR | Prints a "CR" after negative values. This token must trail the other tokens. |
Y | Causes no sign symbol to be printed for negative or positive values. |
V | Causes the number to be multiplied by 10N, where N is the number of 0, 9, *, and S tokens that appear to the right of the V. |
EEEE | Causes the number to be printed in scientific notation. All digit tokens refer to digits of the mantissa. There must be exactly one digit to the left of the decimal point (displayed or implicit). The token EEEE prints as E followed by a plus (+), if the ordinate is positive or zero, and a minus (-), if the ordinate is negative, and two digits representing the ordinate (for example, E-99). |
"string" | Prints the string between the double quotes. To have double-quotes inside the string, type double-quotes back to back (""). |
. (period) | Prints a period (.) to separate the integral and fractional parts of a number. |
D | Prints the local decimal character to separate the integral and fractional parts of a number. |
, (comma) | Prints a comma (,) as the group/thousands separator. |
G | Prints the local group/thousands separator. |
$ | Prints $ |
L | Prints the local currency symbol. |
C | Prints the ISO currency symbol. |
% | Prints %. |
" " | Prints a blank space. (Do not include quotes in mask.) |
v | Prints a blank space for all zero values, regardless of other tokens. |
K | Prints a blank space. |
<> | Delineates the beginning and ending of the decimal-aligned region (that is, that part of the number that you want aligned with the decimal point in the format mask). Angle brackets indicate that the number should always occupy the same amount of space. If necessary, values are padded with blanks to the left or right of the decimal point. |
RN, rn | Prints values in uppercase or lowercase Roman numerals, respectively. You cannot enter any other tokens with this token. |
Restrictions
Examples
Table 4-6 Number format mask examples
Sample Number Format | Number | Number Displayed |
---|---|---|
-0000 | 7934 | "7934" |
-7934 | "-7934" | |
-00000 | 7934 | "07934" |
-NNNN | 7639 | "7639" |
535 | "535" | |
-NNN | 7639 | "****" |
-**** | 7902 | "7902" |
-***** | 7902 | "*7902" |
+NNNN | 100 | "+100" |
-99 | "-99" | |
(NNNN) | 1600 | " 1600 " |
-800 | "(800)" | |
NNNNPR | 1600 | " 1600 " |
-800 | "<800>" | |
NNNNMI | 1600 | "1600 " |
-800 | "800-" | |
NNNVNN | 343 | "34300" |
N.NNEEEE | 7369 | "7.37E+03" |
"SRW"-0000 | 7782 | "SRW7782" |
-$NNNN.NN | 800 | "$800" |
1600 | "$1600" | |
-%NNN | 10 | "%10" |
-NN NNN.NN | 3000 | "3 000" |
+KKNNNNN.00 | 1950 | "+ 1950.00" |
900 | "+ 900.00" | |
$<NNNNN.00> | 1200 | "$1200.00" |
500 | "$500.00" | |
$<NNNNN.00> DB | 1200 | "$1200.00 DB" |
-500 | "$500.00" | |
$<NNNNN.00> CR | 1200 | "$1200.00" |
-500 | "$500.00 CR" |
* The quotation marks will not appear in your output. They are used here to make it clear where there are leading or trailing spaces.
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
To apply a format mask to a date object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
To add a custom format mask to the default format masks list:
Now, you will see your new custom format masks in the list of values for the Format Mask property for fields and the Input Mask property for parameters.
To change the format mask for multiple fields at one time:
This section provides procedures for the following tasks that you may perform as you work with graphic or image objects:
To add an image to your report, perform the steps in any of the topics listed below.
For paper-based reports and JSP-based Web reports:
For paper-based reports only:
See also
Note: This procedure applies to paper-based reports. For JSP-based Web reports, see the Usage notes, below. These steps allow you to include images in the following formats: TIFF, JFIF, BMP, TGA, PCX, PICT, GIF, CALS, RAS, OIF, PCD. For images in other formats supported by Oracle Reports, including JPEG (all types, such as Progressive JPEG and Exif JPEG), PNG, BMP, TIFF, GIF, and CGM, see Section 4.9.8.1.2, "Linking an image object to a file" or Section 4.8.5, "Selecting an image from the database". |
Usage notes
This procedure is for paper-based reports only. If you want to include static images in your JSP-based Web reports, you can add HTML <img>
tags in the Web Source view.
Notes: This procedure applies to paper-based reports. File link objects are not implemented in JSP-based Web reports. These steps, and the steps in Section 4.8.5, "Selecting an image from the database", allow you to include images in a wide variety of formats supported by Oracle Reports, including JPEG (all types, such as Progressive JPEG and Exif JPEG), PNG, BMP, TIFF, GIF, and CGM. For paper-based reports, you can also use Insert > Image to import an image from a file into the report layout for images in the following formats: TIFF, JFIF, BMP, TGA, PCX, PICT, GIF, CALS, RAS, OIF, PCD (see Section 4.9.8.1.1, "Importing an image", above). |
To link an image object to a file:
Notes: This procedure applies to paper-based reports output to an HTML or HTMLCSS file. This is unrelated to HTML that might be generated when you run a JSP-based Web report (when you click the Run Web Layout button in the toolbar, or choose Program > Run Web Layout). Additionally, file link objects are not implemented in JSP-based Web reports. These steps, and the steps in Section 4.8.6, "Selecting an image URL from the database", allow you to include images in a wide variety of formats supported by Oracle Reports, including JPEG (all types, such as Progressive JPEG and Exif JPEG), PNG, BMP, TIFF, GIF, and CGM. For paper-based reports, you can also use Insert > Image to import an image from a file into the report layout for images in the following formats: TIFF, JFIF, BMP, TGA, PCX, PICT, GIF, CALS, RAS, OIF, PCD (see Section 4.9.8.1.1, "Importing an image", above). |
To link an image object to a URL that points to an image to include in an HTML report:
Example 1: Image URL
Example 2: Image URL containing user parameter
where P_SERVER_NAME
is a user parameter of type CHAR
.
At runtime, the end user can specify a value for the parameter (for example,
for a dynamic URL link of
P_SERVER_NAME=www.oracle.us.comhttp://www.oracle.us.com/images/logo.gif)
.
Example 3: URL to a file
Note: If you click Browse to find a file, Oracle Reports automatically prepends FILE:// to the returned path. |
To add a graph to your report, follow the steps in either of the following topics:
Usage notes
Inserting a graph with a once-per-group position in the Paper Design view of a matrix with group report causes Oracle Reports Builder to fail. As a workaround, insert the graph in the Paper Layout view, rather than the Paper Design view, when adding a graph to a matrix with group report.
See also
Section 1.6.6, "About the Web Source view"
Chapter 39, "Building a Report with Graphs"
To add a graph to your paper-based report:
Note: When you specify a graph title, subtitle, footnote, or axis title in the Graph Wizard, you can insert lexical references (to user parameters, system parameters, and columns) in the text. For example, in the Show Title field on the Title page of the Graph Wizard, type: titletext &<P_1> to insert the value of the user parameter P_1 into the title text at runtime. The angle brackets (<> ) are required around the parameter or column name. |
To customize your graph XML definition beyond the scope of the Graph Wizard, you can directly edit the XML in the graph's Graph Settings property. The full list of attributes available is defined in the DTD file, graph.dtd
.
Note: The graph.dtd is available in the following locations:
|
To add a graph to a JSP-based Web report:
Note: Previously adding some text such as "Place the graph here" to your Web page enables you to easily locate the correct position for your graph. |
Note: When you specify a graph title, subtitle, footnote, or axis title in the Graph Wizard, you can insert lexical references (to user parameters, system parameters, and columns) in the text. For example, in the Show Title field on the Title page of the Graph Wizard, type titletext &<P_1> to insert the value of the user parameter P_1 into the title text at runtime. The angle brackets (<> ) are required around the parameter or column name. |
Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry key HKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
<rw:graph>
and </rw:graph>
tags in the Web Source view, then choose Edit > Settings.To customize your graph XML definition beyond the scope of the Graph Wizard, you can directly edit the XML in the Web Source view. The full list of attributes available is defined in the DTD file, graph.dtd
.
Note: The graph.dtd is available in the following locations:
|
To add a graph to your report, follow the steps in either of the following topics:
See also
Section 1.4.4, "About Graphs and the Graph Wizard"
Section 1.6.6, "About the Web Source view"
To edit a graph in a paper-based report:
Note: The graph is represented as a bar graph even if the graph is of another type. |
rw:graph
tag attributes. The full list of attributes available is defined in the DTD file, graph.dtd
.Note: The graph.dtd is available in the following locations:
|
To edit a graph in a JSP-based Web report, do any of the following in the Web Source view:
rw:graph
> and </rw:graph
> tags, then choose Edit > Settings to re-enter the Graph Wizard.Note: Any manual changes and additions you've made to the graph XML will be lost if you click Finish, which redefaults the graph to the definition in the Graph Wizard. |
<rw:graph>
tag to the </rw:graph
> tag.rw:graph
> and </rw:graph
> tags that define the graph, make changes directly to the JSP and XML tags. This enables you to customize your graph XML definition beyond the scope of the Graph Wizard. The full list of attributes available is defined in the DTD file, graph.dtd
.Note: The graph.dtd is available in the following locations:
|
You can add a graph hyperlink to a graph in your paper-based Web report (output to PDF or HTML), or JSP-based Web report. When end users display the report on the Web, they can click the areas of the graph to drill down to additional linked information.
To add a graph hyperlink to a graph, follow the steps in either of the following topics:
See also
Section 2.2.6, "About graph hyperlinks"
Section 1.4.4, "About Graphs and the Graph Wizard"
Section 1.6.6, "About the Web Source view"
For a paper-based Web report (for HTML or PDF output), you can add a graph hyperlink to a graph in either of the following ways:
To specify a graph hyperlink in a paper-based report using the Property Inspector:
Examples:
#&<dept_id>
http://my_machine:8888/reports/myWebApp/Dept_Detail.jsp? p_deptid=&<deptid>+...
www.oracle.com
To specify a graph hyperlink in a paper-based report using the Graph Wizard:
After you have defined the graph hyperlink, generate your report to HTML, HTMLCSS, or PDF to test the graph hyperlinks. Refer to Section 4.7.5, "Generating HTML or HTMLCSS output" and Section 4.7.6, "Generating PDF output".
To add a graph hyperlink to a graph in a JSP-based Web report:
<rw:graph>
JSP tag to include the graphHyperlink
attribute.For example:
graphHyperlink="http://my_machine:8888/reports/myWebApp/Dept_Detail.jsp? userid=hr/hr@mydb+server=myserver+p_deptno=&<deptno>
"
After you have defined the graph hyperlink, click the Run Web Layout button in the toolbar (or choose Program > Run Web Layout) to display your report and graph in your Web browser, and click the graph hyperlinks to test them.
This section provides procedures for the following tasks that you may perform as you work with page or group headers or footers:
To create an object or heading in the margin of a report:
Note: The margin area is defined by a thick black line that separates it from the body. If you create objects in the body portion of a report while displaying the margin area, you can only edit those objects when the margin is displayed. |
To create a heading that includes database values:
Note: Any totals that you intend to place in the margin area of your report must be report-level totals. Group totals (for example, the total for a department) placed in the margin will cause a frequency error when you run your report. |
Note: The margin area is defined by a thick black line that separates it from the body. If you create objects in the body portion of a report while displaying the margin area, you can only edit those objects when the margin is displayed. |
Note: If you do not need to specify a format mask, you can simply reference the value directly in Step 6, and you do not need to create this hidden field. |
See also
The example report in Chapter 17, "Building a Header with Database Values Report".
To create a header or footer above or below each group of records:
Tip: In the Object Navigator, under the Paper Layout node, expand the Body node to select the frame by name. |
This section provides procedures for the following tasks that you may perform as you work with margin, header page, or trailer page objects:
To create an object or heading in the margin of a report:
Note: The margin area is defined by a thick black line that separates it from the body. If you create objects in the body portion of a report while displaying the margin area, you can only edit those objects when the margin is displayed. |
With report sectioning, Header and Trailer pages are identical to Body pages. In effect, this means that the Header, Trailer, and Body are three sections of a report. The names of the sections are exposed under the Paper Design node in the Object Navigator as Header Section, Main Section, and Trailer Section. You can use the margin and body of the Header and Trailer sections to create a Header and Trailer "page" as in earlier releases of Oracle Reports.
Tip: In the Object Navigator, under the Paper Layout node, expand the Body node to select the repeating frame by name. |
This section provides procedures for the following tasks that you may perform as you move your report objects:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 2.4.7, "About moving and layering objects in the Paper Layout view"
To move a child object outside its enclosing parent object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 2.4.7, "About moving and layering objects in the Paper Layout view"
To adjust parent borders as you move child objects:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 2.4.6, "About resizing objects"
To move a column in report output:
See also
Section 2.4.7, "About moving and layering objects in the Paper Layout view"
Chapter 4, "Changing columns labels or widths"
Chapter 4, "Changing the default layout spacing"
To offset the detail fields in a group above or group left report:
See also
Section 1.3.2, "About group above reports"
Section 1.3.3, "About group left reports"
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 2.4.7, "About moving and layering objects in the Paper Layout view"
To change the order in which objects are layered on top of each other:
See also
Section 2.4.7, "About moving and layering objects in the Paper Layout view"
You can only rotate boilerplate text and graphics. You cannot rotate other layout objects (repeating frames or fields).
To rotate a boilerplate object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 1.8.5, "About boilerplate objects"
This section provides procedures for the following tasks that you may perform as you resize your report objects:
To resize one or more objects:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
See also
Section 2.4.6, "About resizing objects"
Section 1.8.3, "About frame and repeating frame sizing"
To make multiple objects the same size:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
This section provides procedures for the following tasks that you may perform as you change spacing between your report objects:
To change column labels or widths:
See also
Chapter 4, "Moving a column in report output"
To change spacing within a text object:
Tip: To select multiple objects, click one object, then Shift-click all other objects. To select all objects, choose Edit > Select All. |
To change the default layout spacing used by the Report Wizard when defaulting the report layout:
See also
Chapter 4, "Moving a column in report output"
To change the spacing between all rows using the Paper Design view:
To change the spacing between all rows using the Property Inspector:
To add blank lines between groups of rows:
This section provides procedures for the following tasks that you may perform as you modify the page layout of your report:
To adjust margins:
Note: The margin area is defined by a thick black line that separates it from the body. If you create objects in the body portion of a report while displaying the margin area, you can only edit those objects when the margin is displayed. |
To add a page break:
Usage notes
If you want to set a page break at a specific row of report output, you can create a hidden object (for example, a rectangle with No Fill and No Line) that formats only at the specific row. If you set the Page Break Before property to Yes for the rectangle object, you will get a page break after the row.
This section provides procedures for the following tasks that you may perform as you work with report sections:
See also
Section 2.1.2, "About report sectioning and sections"
To display the layout view for a report section:
To create a default layout for a report section:
Caution: If you re-enter the Report Wizard after making manual adjustments to your layout in the Paper Layout or Paper Design view, you will lose these layout changes when you click Finish in the Report Wizard, which redefaults the layout. |
See also
Section 2.4.2, "About layout defaulting"
Section 4.5.4, "Creating a default layout for a report"
Chapter 4, "Changing the default layout spacing"
This section provides procedures for the following tasks that you may perform as you work with parameters and the Parameter Form:
See also
Section 1.9.1, "About parameters"
Section 2.3.4, "About referencing columns and parameters"
Section 1.6.5, "About the Paper Parameter Form view"
Section 1.11.1, "About the Runtime Parameter Form"
Section 1.9.4, "About Parameter Forms for Web reports"
Note: Oracle Reports Builder automatically creates a user parameter when you use a bind parameter reference in a query. |
Tip: If you define a parameter in a template, you must apply the template to a report in order to select that parameter for the Runtime Parameter Form. |
To create a LOV for a parameter:
Caution: If you send the report output to an HTML file, either from Oracle Reports Builder or running it in your Web browser, the value of the first column will be visible in the HTML source, even if Hide First Column is selected. If you run the report from a Web browser and the list of values is unrestricted, the HTML Parameter Form will display a text field instead of a combo box, and a list of static values that you can copy and paste into the text field. In this case, the first column will always be shown in the Parameter Form, even if Hide First Column is selected. |
To validate a parameter value at runtime:
See also
Section 2.6.13.3, "About validation triggers"
To create a default Parameter Form:
To select parameters to include in the Runtime Parameter Form:
To display the Runtime Parameter Form when you run your report:
Note: The Parameter Form can be used only for paper reports. If you display your paper-based report on the Web, you can create an HTML Parameter Form by adding HTML header and footer tags (using either the Before Form Value property and After Form Value property or the SRW.SET_BEFORE_FORM_HTML and SRW.SET_AFTER_FORM_HTML procedures). However, if you design a JSP-based Web report with a Parameter Form in Oracle Reports Builder, be aware that Web reports that use JSPs do not support the display of the Runtime Parameter Form at runtime. For more information, see Section 1.9.4, "About Parameter Forms for Web reports". |
To add more pages to the Runtime Parameter Form:
To pass parameters (for example, data ranges) to reports running in batch mode:
Query:
Runtime:
See Section 4.6.10.2.5, "Creating an HTML Parameter Form header using PL/SQL"
See Section 4.6.10.2.6, "Creating an HTML Parameter Form footer using PL/SQL"
To create an HTML Parameter Form field with input or select events:
Note: In some cases, for example, when raising messages it may be necessary to type JavaScript code in the Before Form trigger. |
To insert the JavaScript code in the Before Form trigger:
Example 1: Data input validation
This example shows how to set Parameter Form fields for input validation when the report is run throughwith the Web. Doing so will raise a message whenever an end user enters invalid data in the Parameter Form field.
At runtime, if the end user enters the department name in the Runtime Parameter Form rather than the department number when running the report through the Web, the following message is raised:
Example 2: Select validation
This example shows you how to set Parameter Form fields for select validation when the report is run through the Web. Doing so will raise a message whenever an end user selects Printer from the DESTYPE list of values in the Runtime Parameter Form.
At runtime, if the end user selects PRINTER from a list of values in the DESTYPE field, the following message is raised:
See also
Section 2.5.1, "About Parameter Form HTML extensions"
To change data input values default to uppercase upon entry in a Parameter Form field:
Example: Default input to uppercase
This example specifies that data input values default to uppercase upon entry in a Parameter Form field.
At runtime, if the end user enters pdf
as the destination format, the value will change to uppercase (that is, PDF) in the Runtime Parameter Form when running the report through the Web.
This section provides procedures for the following tasks that you may perform as you define a report template:
See also
Section 2.7.5, "About the Template Editor"
Section 2.7.1, "About templates"
Section 2.7.2, "About template attributes"
Section 2.7.3, "About applying templates"
Section 2.7.4, "About inheritance in templates"
To define default attributes for report objects in a template that applies to all report styles:
Note: The Paper Layout view is synchronized with the Object Navigator; when you select a layout object, the associated node is highlighted in the Object Navigator. To select the parent frame for a layout object, click the object, then click the Select Parent Frame button in the toolbar to select the parent frame. |
Note: Any changes you make for an individual report style will override the attributes defined under the Default node. |
See also
Section 2.7.1, "About templates"
Section 2.7.2, "About template attributes"
To define override attributes for a selected report style:
Note: Sections are mapped to groups in a report. For more information, see About template attributes. |
Note: You can only delete nodes down to the minimum requirement for the current report style. |
Note: The Paper Layout view is synchronized with the Object Navigator; when you select a layout object, the associated node is highlighted in the Object Navigator. To select the parent frame for a layout object, click the object, then click the Select Parent Frame button in the toolbar to select the parent frame. |
Note: Any changes you make for an individual report style will override the attributes defined under the Default node. |
See also
Section 2.7.1, "About templates"
Section 2.7.2, "About template attributes"
To apply a template to a report:
Note: If you select the node for the entire report in the Object Navigator, the template will be applied to the Main section of the report by default. To apply the template to a specific section of your report, select the node for that section in the Object Navigator. |
See also
Section 2.7.1, "About templates"
Section 2.7.3, "About applying templates"
To set default attributes (such as font and color) for the title in a selected template:
To set the placement and override attributes (such as font and color) for the title in a selected template:
See also
Section 2.1.1, "About report titles"
Section 2.7.1, "About templates"
To add items and objects to a template:
See also
Section 2.7.5, "About the Template Editor"
Section 2.7.1, "About templates"
Section 2.7.2, "About template attributes"
Section 2.7.4, "About inheritance in templates"
To modify objects in the margin of a template:
See also
Section 2.7.5, "About the Template Editor"
Section 2.7.1, "About templates"
Section 2.7.2, "About template attributes"
Section 2.7.4, "About inheritance in templates"
Template objects can be modified using the same techniques as report objects. To change the color or pattern of objects in a template, however, you use the template Property Inspector, rather than the Color tools in the tool palette:
See also
Section 2.4.5, "About changing colors and patterns"
Section 4.9.6.2, "Changing colors"
Section 4.9.6.3, "Changing patterns"
Section 2.7.1, "About templates"
To add your own template to the list of predefined templates in the Report Wizard:
$ORACLE_INSTANCE\config\FRComponent\frcommon\tools\admin\CAUPREFS.ORA
(user preferences) if it exists; otherwise, open $ORACLE_INSTANCE\config\FRComponent\frcommon\tools\admin\CAGPREFS.ORA
(global preferences).your_home_directory
/prefs.ora
(user preferences) if it exists; otherwise, open $ORACLE_INSTANCE/config/FRComponent/
frcommon/tools/admin/prefs.ora
(global preferences).Reports.
xxx
_Template_Desc
(where xxx
specifies a report style: Tabular, BreakAbove, BreakLeft, FormLetter, Formlike, MailingLabel, Matrix, MatrixBreak).Reports.
xxx
_Template_Desc
list, add the description that you want to appear on the Template page of the Report Wizard.Reports.
xxx
_Template_File
list, add the file name of your template in the same position as the addition you made to the description list.filename
.tdf
) to ORACLE_HOME/REPORTS/TEMPLATES
.To include a sample image of your template in the Report Wizard:
.bmp
file you want to use as the image for the template and name it yyy
.bmp
, where yyy
is the file name of your template..bmp
file to ORACLE_HOME
/REPORTS/TEMPLATES
.See also
Section 2.7.1, "About templates"
Section 2.7.3, "About applying templates"
To create and use an HTML template for a report that can be published on an Oracle Portal page:
http://www.oracle.com/technology/products/reports/index.html
). Click Getting Started. In the list of topic sections on the left, click Index. On the Index page, in the Collateral Type list, choose White Papers & How To Documents, and click Search. In the list that displays, click Creating a Report Portlet Template.See also
Section 2.7.1, "About templates"
Section 2.7.3, "About applying templates"
This section provides procedures for the following tasks that you may perform as you use PL/SQL in a report or template:
See also
Section 2.6.12, "About built-in packages"
This section provides procedures for the following tasks that you may perform as you work with the PL/SQL Editor:
Tip: Check for missing semicolons at the end of statements, or misspelled syntax. |
See also
Section 2.6.4, "About program units"
To search and replace text in a program unit:
Tip: If you replace text in multiple program units, you can recompile them all at once when you are finished. |
Tip: If your edits are extensive, you may want to click Apply to save your changes incrementally, without having to compile. |
See also
Section 2.6.4, "About program units"
See also
Section 2.6.4, "About program units"
The editing features in the PL/SQL Editor (and Stored PL/SQL Editor) include:
Table 4-7 Editing features of PL/SQL Editor
Editing Feature | Description |
---|---|
Automatic indent | When you press the Enter key at the end of a line, the next line is automatically indented. |
Color syntax highlighting | Keywords, comments, strings, and symbols such as := and || are colored differently. |
Column and line selection | You can select columns of text as well as lines of source code. To select a column, press the ALT key, then click and drag horizontally. To select a line, click the extreme left margin of the line in the Source pane. |
Drag and drop text manipulation | Selected text may be copied or moved by dragging and dropping. To copy text, press the CTRL key and drag the selected text. To move text, simply drag the selected text. |
Indent/Outdent lines | The Indent/Outdent commands on the Edit menu enable you to indent or outdent selected source lines. |
Multiple split views | You can create up to four separate views of the current program unit. To create horizontal views, place the cursor on the split bar at the top of the vertical scroll bar. Then click and drag the split bar down. To create vertical views, place the cursor on the split bar at the far left of the horizontal scroll bar. Then click and drag the split bar to the right. To remove a horizontal or vertical view, double-click the split bar that separates the views. |
Printing | Choose File > Print to print the current program unit. |
Unlimited undo/redo | The Undo/Redo commands on the Edit menu enable you to undo or redo changes as far back as the last save operation. |
Note: These features are available in Microsoft Windows only. On UNIX, you can print the current program unit, and you can use TAB/Shift-TAB to indent/outdent selected lines. |
The following keyboard actions are supported when using the PL/SQL Editor (and Stored PL/SQL Editor) in Microsoft Windows and UNIX:
Table 4-8 Using the keyboard in the PL/SQL Editor
To do the following | Use Keystroke | On Platform |
---|---|---|
Move cursor left one character | Left arrow key | Windows and UNIX |
Select character as cursor moves left | Shift + Left arrow key | Windows and UNIX |
Move cursor right one character | Right arrow key | Windows and UNIX |
Select character as cursor moves right | Shift + Right arrow key | Windows and UNIX |
Copy selected characters or words | Ctrl + C | Windows and UNIX |
Cut selected characters or words | Ctrl + X | Windows and UNIX |
Paste from the clipboard | Ctrl + V | Windows and UNIX |
Delete character on the right of current cursor position, or delete selected characters or words | Delete key | Windows and UNIX |
Delete character on the left of current cursor position | Backspace | Windows and UNIX |
Move cursor to the end of the program unit | Ctrl + End | Windows |
Move cursor to the start of the program unit | Ctrl + Home | Windows |
Select source lines from the current cursor position to the end of the program unit | Ctrl + Shift + End | Windows |
Select source lines from the current cursor position to the start of the program unit | Ctrl + Shift + Home | Windows |
Move cursor to the end of current line | End | Windows |
Move cursor to the start of current line | Home | Windows |
Select characters from the current cursor position to the end of the current line | Shift + End | Windows |
Select characters from the current cursor position to the start of the current line | Shift + Home | Windows |
Indent selected line, or indent characters on the right of current cursor position | Tab Key | Windows and UNIX |
Outdent selected line | Shift + Tab key | Windows and UNIX |
Move cursor down one line | Down arrow key | Windows and UNIX |
Select line as cursor moves down | Shift + Down arrow key | Windows and UNIX |
Move cursor up one line | Up arrow key | Windows and UNIX |
Select line as cursor moves up | Shift + Up arrow key | Windows and UNIX |
Scroll down the program unit by the number of lines that are shown in the Source pane | PageDown key | Windows and UNIX |
Scroll down the program unit by the number of lines that are shown in the Source pane and select the lines at the same time | Shift + PageDown key | Windows and UNIX |
Scroll up the program unit by the number of lines that are shown in the Source pane | PageUp key | Windows and UNIX |
Scroll up the program unit by the number of lines that are shown in the Source pane and select the lines at the same time | Shift + PageUp key | Windows and UNIX |
Undo most recent action | Ctrl + Z | Windows |
Revert most recent undo action | Ctrl + Y | Windows |
The following table describes the mouse actions that are supported when using the PL/SQL Editor (and Stored PL/SQL Editor) in Microsoft Windows:
Table 4-9 Using the mouse in the PL/SQL Editor
To do the following | Use mouse action |
---|---|
Select characters in a range | Click and drag the cursor from the first character to the last character in the range you wish to select. (also supported in UNIX) or... Click the first character, then press the Shift key, and click the last character in the range you wish to select. |
Select word under cursor | Double-click the word. (also supported in UNIX) or... Press the Ctrl key, then click the word you wish to select. |
Select words in a range | Press the Ctrl key, then click and drag the cursor from the first word to the last word in the range you wish to select. |
Select a line | Place the cursor on the left margin of the line you wish to select. Click when the cursor changes to an arrow. |
Select multiple lines | Place the cursor on the left margin of the first line you wish to select. When the cursor changes to an arrow, click and drag the cursor to the last line you wish to select. |
Select columns of text | Press the Alt key, then click and drag the cursor from the first column to the last column in the range you wish to select. |
Move selected text | Select the text first. Then click and drag the selected text to its new position. |
Copy selected text | Select the text first. Then press the Ctrl key, and drag the selected text to the location where you want to place a copy and release the mouse. |
Split window into two horizontal views | Double-click the split bar at the top of the vertical scroll bar. or... Click and drag the split bar at the top of the vertical scroll bar. |
Split window into two vertical views | Double-click the split bar at the extreme left of the horizontal scroll bar. or... Click and drag the split bar at the extreme left of the horizontal scroll bar. |
Adjust relative size of split views | Click and drag the split bar that separates the views. |
Remove split views | Double-click the split bar that separates the views. or... Click and drag the split bar to the edge of the window. To remove all four views at once, double-click the intersection where the split bars meet or drag it to any corner of the window. |
To copy syntax into the PL/SQL Editor:
When you click a category or a package, the PL/SQL language elements or PL/SQL constructs that are available for selection appear in the list area below.
When you click a PL/SQL language element or construct, the syntax appears in the display area that is below the list area.
The selected PL/SQL language element or construct is inserted into the active editor at the current cursor position.
Note: You can also double-click a PL/SQL language element or construct in the list area to insert the syntax into an editor. |
See also
Section 2.6.3, "About the Syntax Palette"
This section provides procedures for the following tasks that you may perform as you create or edit report-level or template-level PL/SQL:
To create a local (client-side) program unit:
Note: If the radio button is not selected when you click, try clicking a different radio button, then click the desired Type again. |
See also
Section 2.6.4, "About program units"
To create a stored (server-side) program unit:
Note: If the radio button is not selected when you click, try clicking a different radio button, then click the desired Type again. |
See also
Section 2.6.5, "About stored program units"
Note: If you delete a PL/SQL package, function, or procedure, you must also delete all references to it in your report. Otherwise, you will get an error when you compile, generate, or run the report. |
To delete a program unit:
See also
Section 2.6.4, "About program units"
To move a program unit from the client to the database server:
To move a program unit from the database server to the client:
See also
Section 2.6.5, "About stored program units"
Section 2.6.4, "About program units"
See also
Section 2.6.13.1, "About report triggers"
See also
Section 2.6.13.1, "About report triggers"
The Table list shows a list of table names owned by the user shown in the Table Owner field. If you select a user name other than your own in the Table Owner field, the Table list shows only the tables to which you have been granted access.
A unique trigger name (with respect to other triggers in the same schema) is automatically assigned to the new trigger in the Name list. You can modify the trigger name.
The Name list displays a list of trigger names associated with the table (or view) shown in the Table (or View) field. The Name list displays only the names of the database triggers associated with the tables to which you have access.
See also
Section 2.6.13.4, "About database triggers"
This section provides procedures for the following tasks that you may perform as you create or edit object-level PL/SQL:
To create or edit a format trigger using the Property Inspector:
To create or edit a format trigger using the Object Navigator:
To create or edit a group filter:
See also
Section 2.6.9, "About group filters"
See Section 4.8.10, "Creating or editing a formula column".
See Section 4.8.12, "Creating or editing a placeholder column".
See Section 4.9.6.4, "Changing colors and patterns using PL/SQL".
This section provides procedures for the following tasks that you may perform as you create or edit an external PL/SQL library:
See also
Section 2.6.6, "About external PL/SQL libraries"
To create an external PL/SQL library:
The newly created library (initially named LIB_xxx
) is automatically opened. Once a library has been created, its contents can be modified by inserting or removing program units, or attaching other libraries.
To add a program unit to an open library:
To edit a program unit in a PL/SQL library:
To remove a program unit from a PL/SQL library:
Restrictions
To convert one or more PL/SQL libraries from one storage format to another on Windows:
%ORACLE_HOME%\BIN\rwconverter
, followed by the report name and desired arguments. See the Reference section of the Oracle Reports online Help for more information about rwconverter
.This section provides procedures for the following tasks that you may perform as you compile and run program units:
See also
Section 2.6.4, "About program units"
To compile a single program unit:
Note: An uncompiled program unit is indicated by an asterisk (*) after its name under the Program Units node in the Object Navigator. When you make changes to a program unit, dependent program units lose their compiled status. |
Tip: Check for missing semicolons at the end of statements, or misspelled syntax. |
To compile all program units:
Note: An uncompiled program unit is indicated by an asterisk (*) after its name under the Program Units node in the Object Navigator. When you make changes to a program unit, dependent program units lose their compiled status. |
Tip: Check for missing semicolons at the end of statements, or misspelled syntax. |
To compile all uncompiled program units:
Note: An uncompiled program unit is indicated by an asterisk (*) after its name under the Program Units node in the Object Navigator. When you make changes to a program unit, dependent program units lose their compiled status. |
Tip: Check for missing semicolons at the end of statements, or misspelled syntax. |
This section provides procedures for the following tasks that you may perform as you debug a report:
For conceptual information that supports these tasks, see Section 2.10, "Debugging Tools".
To debug a report:
Usage notes
When debugging a JSP-based Web report in Oracle JDeveloper, you must disable any breakpoints that are not of Source type. If these breakpoints are not disabled, a deadlock is detected. You can disable breakpoints that are not of Source type in the Breakpoints window.
To compile and run a report in debug mode:
To compile and run a report in debug mode from the command line:
rwbuilder
or rwrun
command line, specify RUNDEBUG=YES. For information about RUNDEBUG, see the Reference > Command Line section of the Oracle Reports online Help.Usage notes
Running a report in debug mode specifies that you want extra runtime checking for logical errors in the report. It checks for things that are not errors but might result in undesirable output, and displays these as warnings at runtime, before displaying the report output. Running a report in debug mode is not the same as debugging a report using the PL/SQL Interpreter.
To set a breakpoint in the execution of your report:
Note: Uncompiled program units are indicated by an asterisk (*) after their name. |
Tip: You cannot place a breakpoint on a BEGIN, END, or NULL, statement, or on a comment. |
The breakpoint is inserted and is indicated by B00n, where n is the number of the breakpoint. When you run the program unit, execution is suspended at the line just prior to the breakpoint.
Note: Uncompiled program units are indicated by an asterisk (*) after their name. |
Tip: You cannot place a breakpoint on a BEGIN, END, or NULL statement, or on a comment. |
For example, to create a debug trigger that interrupts program execution if the local NUMBER variable my_sal exceeds 5000, enter the following as the trigger body:
Note: To create a debug trigger that contains multiple lines of text, include a BEGIN and an END statement around the code. |
You must raise the DEBUG.SUSPEND exception from the DEBUG package if you want the PL/SQL Interpreter to appear when this line is executed. Otherwise, Oracle Reports Builder executes the code silently and the PL/SQL Interpreter does not appear.
Tip: You can also create a debug trigger by entering commands in the PL/SQL Interpreter pane. |
or
For example, entering DESCRIBE BREAK 1 in the Interpreter pane reveals the following about Breakpoint 1:
To edit a debug action:
To disable/enable a debug action:
or
For example, entering .DISABLE ACTION 1 in the Interpreter pane disables the first debug action and displays the following status:
To delete a debug action:
To run a program unit in the PL/SQL Interpreter:
PL/SQL>
prompt, type the name of the program unit followed by a terminating semi-colon (;). If the program unit requires any arguments, be sure to supply them in parentheses. For example: getdata(SCOTT)
;PL/SQL>
prompt returns to indicate successful execution.PL/SQL>
prompt appears. You need to edit or debug your program unit.(debug n)PL/SQL>
.Usage notes
Running a program unit as described above only works for procedures (or packaged procedures), not for functions (since there's no variable for a return value to be returned to).
To insert an Object Navigator pane in the PL/SQL Interpreter:
Notice that the button bar is updated with new Object Navigator buttons.
Once you have inspected and modified the program state, you can resume or terminate execution using the following features:
Table 4-10 Program unit execution
Execution Feature | Description |
---|---|
STEP | You can use the STEP command to temporarily resume execution of an interrupted program. Control returns to the PL/SQL Interpreter after the specified set of statements have been executed. STEP Into or Over enables you to: execute the next statement (optionally descending into subprogram calls) resume execution until the current subprogram has returned continue execution until the specified source location is reached |
GO | Use the GO command to resume program execution indefinitely--that is, until either the currently executing thread of execution terminates or it is interrupted again due to a debug action. |
RESET | Use the RESET command to return control to an outer debug level without continuing execution in the current debug level. Thus, RESET effectively aborts execution at the current (and possibly higher) debug levels. You can explicitly reset execution to any previous debug level, or you can simply reset to top level, which is the default. |
Execute these commands from either the PL/SQL Interpreter toolbar or by typing the command in the PL/SQL Interpreter pane.
To step through the code:
Before proceeding, you must already have set a debug action such as a breakpoint, and run your program unit at the PL/SQL Interpreter PL/SQL>
prompt to suspend execution.
To step to the next line of the suspended program unit:
If the next executable line is a call to a nested subprogram (a program unit that is called from within another program unit), Step Into halts execution at the first line of the nested subprogram.
To step over a nested subprogram call in the suspended program unit:
Step Over executes any calls to nested subprograms and then halts execution at the next executable line of the current program unit.
To step out of a nested subprogram and return to the outer program unit:
If you previously used Step In to descend into a nested subprogram, Step Out completes execution of the nested subprogram and returns to the next line of the original program unit.
To resume program unit execution:
Execution of the program unit continues until the program unit execution has finished, or until interrupted again by another debug action.
Note: If your debug action is located in a PL/SQL LOOP, using Go will cycle through the loop. |
To exit suspended execution at the current debug level:
Control is returned to the Interpreter, or to an outer debug level (if any exist).
To modify your code at runtime:
See also
Section 2.10.9, "About modifying code at runtime"
To display the current scope location:
or
See also
Section 2.10.7, "About the current scope location"
You must currently have a suspended program unit in the PL/SQL Interpreter to examine or change local variables values.
To examine local variable values:
Each local variable is displayed with its current value.
To edit local variable values:
Each local variable is displayed with its current value.
To modify a variable:
To view subprogram references:
The Object Navigator displays any subprogram references.
Note: Referenced By shows the program units that call the current program unit. References shows the program units that are called by the current program unit. |
To set tracing options, do one of the following:
logging.xml
), set the trace level in the level
attribute of the logger
element (oracle.reports.runtime
).For more information, including tracing for rwserver
and rwservlet
, see the chapters "Configuring OracleAS Reports Services" and "Tuning Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
See also
Section 2.8.3, "About report distribution"
Section 4.7.12, "Distributing a report to multiple destinations"
The TRACE function provides you with the exact statements that are being parsed. Once you have them, you can time them in SQL*Plus, and multiply these times with the expected number of rows to retrieve from the database. (Always compare apples to apples; that is, send output to a file--not to the screen. Do not change anything in the SQL statements when moving it to SQL*Plus; even the slightest change in the WHERE clause can make a big difference in the performance.)
There are two ways to trace your reports:
We recommend the user level because you can more easily find the information you need. For more information on SQL TRACE, see the Oracle Server SQL Language Reference manual.
Note: You could also call SQL TRACE from the Before Form trigger. |
some_number
.trc
, will be created in either ORACLE_HOME
/rdbms/log
, or the destination indicated by the init.ora
parameter USER_DUMP_DEST
. (The date stamp on the file can help you determine which .trc
file is yours.)If you issue more than one trace during the rwbuilder
session, the trace outputs are concatenated into one file.
init.ora
file: SQL_TRACE=TRUE and TIMED_STATISTICS=TRUE.Note: Every interaction with the database will be traced, and the ORACLE_HOME /rdbms/log is likely to grow very large. |
This section provides procedures for the following tasks that you may perform as you integrate your reports with other products:
Oracle Portal is integrated with Oracle Reports. This integration enables you to quickly publish a report as a portlet (that is, a small, dynamic region) or an item on a page, so that end users can easily access dynamic reports.
For general information, refer to the Oracle Technology Network (OTN): on the Oracle Reports page (http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Any Format, then select Integration with Oracle Portal.
For detailed information and tasks to publish a report as a portlet in Oracle Portal, see the chapter "Deploying Reports in Oracle Portal" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
When you install Oracle Portal with a nondefault language setting, some entries required to publish a report as an item link on a portal page are not installed automatically. You must install the language of your choice by using the rwlang.sql
script.
Thus, you must run rwlang.sql
(ORACLE_HOME
/portal/admin/plsql/wwd/
) if:
US
) at the time of installing Oracle Portal.AND
Note: By default, a report is defined in the Main section. |
To run the script:
ORACLE_HOME
/portal/admin/plsql/wwd/
.sqlplus
.rwlang.sql
script with the following parameters:@rwlang.sql
language_list
where
language_list
is the list of languages separated by commas.
For example, to install French and Japanese:
@rwlang.sql f,ja
Usage notes
sqlplus
treats the language list as two parameters, instead of one parameter separated by a comma (,).rwlang.sql
script contains the complete list of all language abbreviations. Edit the script file using any text editor to find out the various abbreviations.Oracle Reports enables you to access any data source. The pluggable data source (PDS) architecture replaces Oracle Open Client Adapter (OCA) and the Open Database Connectivity (ODBC) drivers, which are no longer supported in Oracle Reports. However, Java Database Connectivity (JDBC) is one of the pluggable data sources available that can utilize the JDBC-ODBC bridge, allowing access to other data sources.
Use the following steps to determine the easiest method for accessing your data source:
A pluggable data source (PDS) has already been set up. All you have to do is select JDBC as your data type.
If so, make sure that you have downloaded the JDBC-ODBC bridge from Sun Microsystems. This lets you use the JDBC connection mentioned in Step 1. If you do not know if there is an ODBC driver for your data source, check the company Web site. For example, Microsoft has a downloadable ODBC driver for Excel.
Oracle Reports includes an XML PDS. If the DTD file is available, all you have to do is select XML as your data type. If the DTD file is not available, you will have to create one.
You can use the Text PDS included with Oracle Reports to query the data source.
If the PDS exists, it will probably be on the Reports Server. Ask your administrator if such a file exists. If the PDS exists, add it to the classpath for your copy of Oracle Reports Builder. If the PDS does not exist, use the API Reference to help you build one.
Examples
Oracle Reports ships with XML data source sample files.
See also
The Pluggable Data Sources section of the Oracle Reports online Help, including the topics:
This section provides procedures for the following tasks that you may perform as you administer Oracle Reports Builder:
Before beginning this procedure, verify that the database administrator has created the role, granted privileges to the role, and granted the role to approved end users. Refer to your Oracle Application Developer's Guide for more information.
To set a database role for a report:
Usage notes
rwrun
).Caution: Do not attempt to set the role in a PL/SQL trigger. The PL/SQL will not compile. |
See also
Section 2.9.1, "About database roles"
To convert one or more report definitions or PL/SQL libraries from one storage format to another:
%ORACLE_HOME%\bin\rwconverter
, followed by the report name and desired arguments.Performing operations in SQL is faster than performing them in Oracle Reports Builder or PL/SQL. The following are the most common cases where using SQL would improve performance:
Rationale: SQL can perform calculations more quickly than a summary or formula. WHERE and SUBSTR can reduce unnecessary fetching because they operate on the data during rather than after data retrieval. Improvements in performance become more noticeable when retrieving thousands of records versus a few records.
Consider adding a WHERE clause for the matrix cell query in a multiquery data model. If you are using a multiquery data model and your dimension queries are restricted by a WHERE clause, adding a WHERE clause to the matrix cell query ensures that you do not retrieve more records than are necessary. For example, suppose that you had the following queries for your dimensions:
Q_Dept
Q_Job
Q_Filler
To ensure that your cell query only retrieves the records that are necessary, you would write the following SELECT
statement:
If you did not add the WHERE clause to this query, all rows would be retrieved from the database, regardless of what you selected in Q_Dept and Q_Job.
Note: If you added a WHERE clause that did not use the subqueries (for example, WHERE EMP.DEPTNO = DEPT.DEPTNO), the query would be executed once for each combination of values in the cross-product. This can lead to excessive execution of the filler query, if the cross-product has a lot of combinations. |
The chapters in this Part provide steps to build simple reports.
This part contains the following chapters:
A tabular report is the most basic type of report. The output of this report is organized in a multicolumn, multirow format (with rows and columns corresponding to those in the database table).
A mailing label report is displayed in a format suitable for use as address labels on envelopes. You write custom text and embed database values, or text from files, to create the labels. You can print the labels in one or many columns and at any position.
A form letter report is displayed in a format suitable for use in printed forms or letters. Similar to the mailing label report, you can write custom text and embed to it, database values or text from files.
A master-master report (also called a parent-parent report) consists of at least two sets of data that are not directly related. This report contains two or more queries with no links (that is, no parent-child relationships).
A summary report contains a field that summarizes at least one column of the report. This summary can be: total sales, average of a list of commissions, maximum amount found in a series of purchase orders, and so on.
In this chapter, you will learn about tabular reports, the most basic report style. By following the steps in this chapter, you can generate the report output shown in Figure 5-1.
Concepts
A tabular report is the most basic type of report you can build. The report output is organized in a multicolumn, multirow format, with each column corresponding to a column in the database table. In this example, the column labels Department Id, Department Name, Manager Id, and Location Id are derived from the columns in your SQL SELECT
statement, but you can modify column labels as you wish.
Data Relationships
SELECT
statement. Although this example report uses only one query, reports can contain any number of queries.Q_1
, Q_2
, and so on. The default group name is G_
fieldname
, where fieldname
is the first field of the table specified in the query. For example, if the first field of the table EMPLOYEE
is FIRSTNAME
, then the default group name is G_FIRSTNAME
.SELECT
statement, Oracle Reports creates a report column and assigns it to the group. By default, the columns appear in the order in which you enter them in your SELECT
statement. The default column names are generated from the database column names or replaced by any aliases specified in your SELECT
statement.Deptno
, Deptno1
, and so on).Layout
Example Scenario
As you build this example report, you will:
To see a sample tabular report, open the examples folder named tabular
, then open the Oracle Reports example named tabular.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. To build the simple report in this example, you can use the Report Wizard. Using the wizard enables you to define the layout for the report, as well as set the data definition.
To create a simple report:
SELECT
statement in the Data Source definition field:Tip: This query selects all the department IDs, the department names, the manager IDs, and the location IDs, then sorts the data by the department IDs. |
Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 5.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Note: In the Paper Design view, you can see how the tabular report displays the data like a table, in order of department ID number. |
tabularreport_
your_initials
.rdf
.Congratulations! You have successfully created a tabular paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about mailing label reports, one of the standard report styles. By following the steps in this chapter, you can generate the report output shown in Figure 6-1.
Concepts
Data Relationships
To fetch the data for a mailing label report, all you need to do is create a query to select it.
Layout
Example Scenario
As you build this example report, you will:
To see a sample mailing label report, open the examples folder named mailinglabel
, then open the Oracle Reports example report named mailinglabel.rdf.
For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. To build the simple report in this example, you can use the Report Wizard. Using the wizard enables you to define the layout for the report, as well as set the data definition.
To create a simple mailing label report:
Note: In this case, you must include the DEPARTMENTS table since the EMPLOYEES and LOCATIONS tables are not directly related in the schema. |
The three tables display in the Query Builder.
Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 6.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
The code in the Mailing Label Text box should look like this (if necessary,add spaces as shown):
Tip: For more information on formatting your mailing labels, click Help on this page of the Report Wizard. |
mailinglabel_
your_initials
.rdf
.In this section, you will use the Vertical Spacing property to add space between each record in your mailing label report. You can adjust this spacing according to the size of the mailing labels where the records will be printed.
0.25
.Your report should look something like this:
Congratulations! You have successfully created a mailing label paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about form letter reports, one of the standard report styles. By following the steps in this chapter, you can generate the report output shown in Figure 7-1.
Concepts
Data Relationships
There are no special restrictions on data relationships for a form letter report.
Layout
&
). The ampersands indicate that they are hidden fields, and are contained within boilerplate and repeating frame objects. You then add the text of the letter to the layout. Oracle Reports prints one record (that is, one letter) per page.&
). Oracle Reports treats the reference as a normal field.Example Scenario
As you build this example report, you will:
To see a sample form letter report, open the examples folder called formletter
, then open the Oracle Reports example report called formletter.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. To build the form letter report in this example, you can use the Report Wizard. Using the wizard enables you to define the layout for the report, as well as set the data definition.
In the Report Wizard, on the Text page, you will be able to set up your form letter report exactly the way you want it to appear. On this page of the wizard, you can set up your boilerplate text (for example, the body of the letter), and use the fields from your data tables to fill in the variable data (for example, the addressee's name).
To create a form letter report:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 7.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Employee: &<FIRST_NAME> &<LAST_NAME>
Emp. #: &<EMPLOYEE_ID>
Dear &<FIRST_NAME> &<LAST_NAME>:
The Human Resources department is updating its records of the company's employees. Currently, our records show your employee number as &<EMPLOYEE_ID>, and that you hold the position of &<JOB_TITLE>. If any of this information is incorrect, please contact the Human Resources department.
Thank you,
Human Resources
Employee:
.Emp. #:
.Dear
.:
) next to LAST_NAME, then click New Line twice.The Human Resources department is updating its records of the company's employees. Currently, our records show your employee number as &<EMPLOYEE_ID>, and that you hold the position of &<JOB_TITLE>. If any of this information is incorrect, please contact the Human Resources department.
Thank you,
Human Resources
formletterreport_
your_initials
.rdf
.Congratulations! You have successfully created a form letter paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about master/master reports. By following the steps in this chapter, you can generate the report output shown in Figure 8-1.
Concepts
A master/master report displays at least two sets of data that are not directly related—that is, the records constituting the data are fetched using at least two separate queries. A master/master report (also called a parent/parent report) contains two or more queries with no links (parent/child relationships).
Data Relationships
Although the data may be conceptually related, the queries make no attempt to relate it by the manner in which it is fetched. To select the data for a master/master report, you create two or more unrelated queries. Reports Builder will create all other necessary data objects by default.
Layout
This report uses the default tabular layout style. You will move the layout objects associated with the second query to insert more space between the information fetched by the two queries and make your report easier to read.
Example Scenario
In this example, you will create a master layout that lists department names, numbers, and locations followed by another master layout that lists all employees with their job, titles, and salaries.
As you build this example report, you will:
To see a sample master/master report, open the examples folder named masterb
, then open the Oracle Reports example named masterb.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layouts.
To create a blank report:
When you create a report with multiple queries, it is typically easier to create all of the queries with the Data Wizard first and then create the layouts with the Reports Wizard.
To create the queries:
Q_Dept
for the Query name and click Next.SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 8.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Emp
and use the following SELECT
statement:Once your data model is complete, you need to create a layout for the data objects to display in the report output. The Report Wizard enables you to create layouts for your data model.
Tip: When you have multiple queries in your data model, make sure that you check the names of the groups associated with each query prior to entering the Report Wizard. The Report Wizard requires you to choose data for the layout by group name. |
To create the layout:
If you scroll down in the Paper Design view, you will notice that the field labels from the second query, Q_Emp, are located directly below the fields from the first query, Q_Dept. In fact, they are almost touching each other. For this report, you will move all of the layout objects belonging to Q_Emp down the page to create some white space between the two layouts.
To create white space between the layouts:
Notice that you have moved not only M_G_LAST_NAME_GRPFR but also all the layout objects within it. Here you take advantage of Confine mode, the default mode for the Paper Layout view. With Confine mode on, an object cannot be moved outside of or placed behind its parent. Such a situation renders the layout invalid and no output is produced.
Sometimes moving an object outside of its parent is a valid action. If you need to do so, you can turn off Confine mode by clicking the Confine Off button in the toolbar.
masterb_
your_initials
.rdf
.In the Paper Design view, notice the Salary field. The values are neither aligned nor displayed as monetary amounts. You can quickly rectify this in the Paper Design view.
To assign a format mask to monetary values:
Tip: If you are familiar with format mask syntax, you could now right-click the field values, choose Property Inspector, and choose or manually type a value for the Format Mask property. |
Congratulations! You have successfully created a master/master report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about summary reports. By following the steps in this chapter, you can generate the report output shown in Figure 9-1.
Concepts
A summary report contains at least one column whose value or values consist of a summary of other data. A column that totals sales, a column that averages a list of commissions, and a column that shows the maximum amounts found in a series of purchase orders are all examples of summary columns.
Data Relationships
Layout
This report uses a master/detail layout style.
Example Scenario
In this example, you will create a report that displays and summarizes sales data by sales representative. This report includes the following summaries:
As you build this example report, you will:
To see a sample summary report, open the examples folder named summary
, then open the Oracle Reports example called summary.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 9.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Fields | Labels |
---|---|
SALES_REP_ID | Sales Rep |
CUSTOMER_ID | Customer |
TOTAL | Dollars |
In the Paper Design view, notice the Total field. The values are neither aligned nor displayed as monetary amounts. You can quickly rectify this in the Paper Design view.
To assign a format mask to monetary values:
Tip: If you are familiar with format mask syntax, you could now right-click the field values, choose Property Inspector, and choose or manually enter a value for the Format Mask property. |
summaryb_
your_initials
.rdf
.In this case, the Report Wizard created the summaries according to the requirements of the project. However, in some cases, you may need to manually adjust the settings of summaries to get the exact calculations you wish. By carefully reviewing the summaries created by the Report Wizard, you can gain a better understanding of how summaries work.
In this section, you will not be making any changes to the report, you will only be checking the summary settings to better understand summaries.
Reviewing summary settings
Congratulations! You have successfully created a summary report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
The chapters in this Part provide steps to build group reports. In these reports, the rows of output are displayed as groups based on a single query or on multiple queries. Group reports can contain formula columns and the values of the report can be printed from top to bottom or across a page.
A single-query group report contains a single query and divides the rows of a report into groups based on common values in one or more column(s). For example, employees can be grouped based on department numbers, which means each department number prints only once for every group. Otherwise, the department number would print once for every employee in the department. These reports include the group left and group above reports and were earlier known as break reports or master/detail reports.
A two-query group report appears much the same as a single-query group report except that the former report uses multiple queries. Multiple queries enable you to simplify maintenance or make the data model easier to understand.
An across group report prints the values of a database column across the page instead of down. In these reports, the values in the master group print from top to bottom, and the values in the detail group print across the page, from left to right.
A group left summary report consists of master record values, detail records, and summaries. Summaries are totals calculated for the details under each master record.
A group left formula report contains a formula column, for which values are calculated based on a PL/SQL formula. A formula column, like a summary column, is a computational column that you create. This column performs user-defined calculations on other column(s) data including placeholder columns.
In this chapter, you will learn about single-query group reports. By following the steps in this chapter, you can generate the report output shown in Figure 10-1.
Concepts
Group left and group above reports divide the rows of a report into "sets," based on common values in one or more of the columns, such as the department number in the preceding example. Notice that each department number prints only once. If the report above was not a group report, the department number would print once for each employee in the department rather than just once for the whole department.
Example Scenario
In this example, you will create a group left report that lists employees with their jobs and salaries by department. As you build this example report, you will:
Then, you will add another column to the break group:
Then, you will add a second break group:
To see a sample across report with control breaks, open the examples folder called break
, then open the Oracle Reports example report named grp_lft2.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The most basic case of a group left or above report is to have one break group with one break column in it. This means that a single master field value will print once for many detail field values.
To see a sample group left report with one break column, open the examples folder named break
, then open the Oracle Reports example named grp1col_lft1.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
Concepts
SELECT
statement includes a column, called a break column, containing at least one value which repeats over multiple records (for example, department number in the example report above). With the break column, you will create a second group, called a break group, to create the breaks in the data.When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 10.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
In the Paper Design view, notice the Salary field. The values are neither aligned nor displayed as monetary amounts. You can quickly rectify this in the Paper Design view.
To assign a format mask to monetary values:
grp_lft2_
your_initials
.rdf
.If you examine your report output in the Paper Design view, you will notice that it can be difficult to distinguish where one department's data ends and the next department's data begins. To make the report more readable, you want to add some white space between the departments, but you want to retain the same spacing between employee rows. For this report, you will change a repeating frame property for the master repeating frame to create some white space between the department records.
To create white space between the departments:
The report above looks similar to the group left report you built in Section 10.2, "Group Report with One Break Column". However, notice that DEPARTMENT_ID values sometimes print more frequently than they did in the previous report. The DEPARTMENT_ID value repeats for each unique value of JOB_ID within the department. This behavior occurs because DEPARTMENT_ID is now grouped with JOB_ID and must print with JOB_ID. While DEPARTMENT_ID values may repeat several times, not until the position of PU_CLERK in department 30 does a job repeat, and not until that point can the break group actually break.
Concepts
To see a sample group left report with two break columns, open the examples folder named break
, then open the Oracle Reports example named grp2col_lft1.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
The first task in changing your previous report is to modify the data model by placing an additional column in the break group.
To add a column to the break group:
In order for your data model change to be reflected in your output, you need to redefault the layout for your report using the Report Wizard.
To redefault the layout with the Report Wizard:
The figure above shows a further modification of your group left report. In this version, DEPARTMENT_ID prints only once for each department. JOB_ID also prints only once when more than one employee in a department has the same job. Both columns are now in separate break groups and DEPARTMENT_ID is in the higher group. Hence, it does not repeat for each unique value of JOB_ID within a department any more.
Concepts
To see a sample group left report with two break groups, open the examples folder named break
, then open the Oracle Reports example named grp_lft2.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
The first task in changing your previous report is to modify the data model by creating another break group.
To add another break group:
In order for your data model change to be reflected in your output, you need to redefault the layout for your report using the Report Wizard.
To redefault the layout with the Report Wizard:
Congratulations! You have successfully created a single-query group report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about multiquery group reports. By following the steps in this chapter, you can generate the report output shown in Figure 11-1.
Concepts
As you can see above, a two-query group report appears much the same as a single-query group report. Performance is the key issue when contrasting single-query and multiple-query group reports. In most cases, single-query reports will run faster than multiple-query reports. The multiple-query reports are, however, sometimes easier to understand conceptually and easier to maintain. For example, if you are in a situation where only a few users run the report and the report returns a relatively small number of records, you might want to use multiple queries to simplify maintenance and make the data model easier to understand. If you have many users and the report is quite large, then you should try to use a single-query report.
Note: For more information on streamlining your report's performance, refer to the chapter "Tuning Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
Data Relationships
SELECT
statement at run time.Layout
Example Scenario
In this example, you will create a group above report that lists employees with their jobs and salaries by department.
As you build this example report, you will:
To see a sample group above report with two queries, open the examples folder named masterdetail
, then open the Oracle Reports example named grp_above.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Summit Sporting Goods (SUMMIT) schema. To download the SQL scripts that install the schema, see "Accessing the Data Sources" in the Preface.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layouts.
To create a blank report:
When you create a report with multiple queries, it is typically easier to create all of the queries with the Data Wizard first and then create the layouts with the Report Wizard.
To create the queries:
Q_Salesrep
for the Query name and click Next.SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 11.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Product
and use the following SELECT
statement:
To add the data link
Linking the group G_ENAME and the query Q_Product through the EMPNO and REPID columns is analogous to writing both queries as the single-query shown below:
Once your data model is complete, you need to create a layout for the data objects to display in the report output. The Report Wizard enables you to create layouts for your data model.
Tip: When you have multiple queries in your data model, make sure that you check the names of the groups associated with each query prior to entering the Report Wizard. The Report Wizard requires you to choose data for the layout by group name. |
To create the layout:
Table 11-1 Field description of Labels page
Fields | Labels | Width |
---|---|---|
PRODNAME |
|
|
AMOUNT |
|
|
CUSTNAME |
|
|
ENAME |
|
|
EMPNO |
|
|
In the Paper Design view, notice the Amount field. The values are neither aligned nor displayed as monetary amounts. You can quickly rectify this in the Paper Design view.
To assign a format mask to monetary values:
Tip: If you are familiar with format mask syntax, you could now right-click the field values, choose Property Inspector, and choose or manually enter a value for the Format Mask property. |
grp_above_
your_initials
.rdf
.The final report output should look something like this:
Congratulations! You have successfully created the two-query, group report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about across group reports. By following the steps in this chapter, you can generate the report output shown in Figure 12-1.
Concepts
ENHANCEDSPREADSHEET
output, the across group keeps repeating (until it reaches the 75,000 rows limit). This is natural Excel behavior because Excel does not have a fixed "page width", and Oracle Reports adapts ENHANCEDSPREADSHEET
output to this Excel behavior.Data Relationships
The break in this report is created through a data link between a master group and a detail query.
Layout
To create the layout used in this report, you will select the master/detail style, then modify the Print Direction setting for one of the groups to ensure it prints across the page instead of down the page.
Example Scenario
As you build this example report, you will:
To see a sample across report with control breaks, open the examples folder called acrossbreak
, then open the Oracle Reports example report named acrossbreak.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. In this example, you will use the Data Model view to create your two queries, then use the tool palette to create a data link between the two queries to relate the data tables.
To create two queries:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
The data model for your new query displays:
Note: You can also copy and paste the code from the text file provided in the acrossbreak folder, called acrossbreak_code.txt . |
Your data model should now look like this:
Note: You can right-click the data link, then choose Property Inspector from the pop-up menu to ensure that the data link was created properly. |
The steps in this section show you how to use the Report Block Wizard to create the layout and choose how your data will display in your report. Here, you will choose the style of report you want to create, and choose to display the data across the report (hence creating the across group report).
To create the default layout:
In this section, you will run your report to the Paper Design view so you can see how your report displays.
acrossbreak_
your_initials
.rdf
.Congratulations! You have successfully created an across group paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about group left summary reports. By following the steps in this chapter, you can generate the report output shown in Figure 13-1.
Concepts
Data Relationships
Layout
Example Scenario
In this example, you will create a report that displays and summarizes sales data by customer. This report would include the following for each customer:
As you build this example report, you will:
To see a sample master/detail summary report, open the examples folder named masterdetailsummary
, then open the Oracle Reports example called grp_above_summ.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Summit Sporting Goods (SUMMIT) schema. To download the SQL scripts that install the schema, see "Accessing the Data Sources" in the Preface.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layouts.
To create a blank report:
When you create a report with multiple queries, it is typically easier to create all of the queries with the Data Wizard first and then create the layouts with the Report Wizard.
To create the queries:
Q_Customer
for the Query name, then click Next.SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 13.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Item
and use the following SELECT
statement:To add the data link:
Once your data model is complete, you need to create a layout for the data objects to display in the report output. This particular report consists of two separate layouts:
Given that two layouts are required, you need to create the first layout through the Report Wizard and the second by inserting a report block. The reason for taking this approach is that the Report Wizard overwrites everything in the layout. Hence, you can only create the first layout through the Report Wizard. Additional layouts must be created by inserting a report block.
To create the first layout:
Table 13-1 Field Description Labels Page
Fields | Labels | Width |
---|---|---|
NAME |
|
|
DESCRIP |
|
|
Itemtot |
|
|
Orderdate |
|
|
To create the second layout:
DESCRIP and SumITEMTOTPerCUSTID1 should be the only fields in the Displayed Fields list when you are done.
After you have created the two layouts, you have only achieved part of your desired result. The summary of purchases by product is outside of the master/detail layout. Hence it summarizes the product purchases for the entire report rather than the product purchases for each customer. To show the summary for each customer, you must move the second layout inside of the first one.
To merge the second layout with the first:
Tip: To make finding this frame easier, just type in the name in the Find field at the top of the Object Navigator. |
In the Paper Design view, notice the monetary values are neither aligned nor displayed as monetary amounts. You can quickly rectify this in the Paper Design view.
To assign a format mask to monetary values:
grp_above_summ_
your initials
.rdf
.Congratulations! You have successfully created a group left summary report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about group left formula reports, containing formula columns. By following the steps in this chapter, you can generate the report output shown in Figure 14-1.
Concepts
Data Relationships
Layout
This report uses the default group left format with no modifications.
Example Scenario
As you build this example report, you will:
To see a sample formula report, open the examples folder called formula
, then open the Oracle Reports example report named formula.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. To build the simple report in this example, you can use the Report Wizard. Using the wizard enables you to define the layout for the report, as well as set the data definition.
To create a simple report:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 14.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
formulareport_
your_initials
.rdf
.Frequently, you want to base calculations on values in your data source. One way you can do this is by using formula columns. The steps in this section will show you how to create two formula columns that calculate the following values:
To create a formula column that calculates the tax:
The data model should look something like this:
Tip: To view the names of the tools in the tool palette and the toolbar, drag and hold your mouse over each icon and hint text will display describing the icon. |
You have created a formula column that calculates the tax (7%) of each order.
To create a formula column that calculates customer order totals:
SALES_TOTAL
.You have created a formula column that calculates the total orders of each customer. Your data model should now look something like this:
Now that you have created your formula columns, you must add them to your report layout. The easiest way to do this is to return to the Report Wizard.
To add formula columns to your report layout:
Congratulations! You have successfully created a formula paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
The chapters in this Part provide steps to build reports that include special formatting. The example reports show you how to wrap text data, add headers and footers, format headers with database values that change at runtime, renumber pages, include intermixed fields, suppress labels, use conditional text, and add text, color, and graphics to your report.
This Part contains the following chapters:
A wrapped field report wraps the data on word boundaries if it is too long to fit in one line. The report contains a field that is of a fixed horizontal width but can expand vertically if the contents of the break field are longer than the specified width. The contents of the fields are not truncated.
A header and footer report contains boilerplate or fields in the header or footer section. This report has a page header printed in the upper margin area of every page of the report and a footer printed at the end.
A header with database values report can include dynamic values in the page header of the report. For example, you can print both the first and last department numbers found on each page.
A report with graphics, text, and color enables you to modify the look of your report. You can enhance a report by adding an image to the margin, adding a title or a border, or applying different fonts and text styles.
A report that renumbers pages by repeating frame displays page numbers using the format "Page X of Y Pages". The first number (X) corresponds to the current page of each parent record. The second number (Y) corresponds to the total number of pages of each parent record.
An intermixed fields report includes the group field between its related fields. This is in contrast to a group report. Normally in the group report, the break field appears to the left of its related fields in the group left report or above in the group above report.
A report that suppresses labels is a master/detail report that fetches a master record with no associated details. Therefore, the report suppresses the detail information for a single record but allows the other master/detail records to display.
A conditional form letter report generates two different form letters from one report. Since the two letters share common features, it is more convenient to create a base form letter and then apply conditions to certain parts. The conditions will determine whether the part should display for the current record.
Conditional highlighting draws attention to specific data in a report by using visual formatting. You can use Oracle Reports Builder or the PL/SQL Editor to create a format trigger that changes the appearance of retrieved data depending on factors you define. For example, you can display amounts greater than 1000 in red.
A report with dynamic graphics contains drawings and images that are "dynamic." Any changes that you make to the graphics will be reflected in your report output at runtime.
In this chapter, you will learn about reports that include fields with wrapped text. By following the steps in this chapter, you can generate the report output shown in Figure 15-1.
Concepts
Data Relationships
This is a simple, one-query break report. In addition, you will add three summary columns.
Layout
Example Scenario
As you build this example report, you will:
To see a sample wrapped field report, open the examples folder called wrappedbreak
, then open the Oracle Reports example report named wrappedbreak.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. In this example, you will use the Data Model view to create your two queries, then use the tool palette to create a data link between the two queries to relate the data tables.
To create the query:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
Your data model should now look like this:
wrappedbreak_
your_initials
.rdf
.The steps in this section show you how to use the Summary Column tool in the Data Model view to create three summary columns. These columns will calculate the percentage of each order total that the customer has purchased, the total purchases the customer has made, and the percentage of the total sales of all customers.
To create the summary columns:
Your data model should now look something like this:
wrappedbreak_
your_initials
.rdf
.The steps in this section show you how to use the Report Wizard to create the layout and choose how your data will display in your report. Here, you will choose the style of report you want to create, and choose to display the data across the report (hence creating the across group report).
You can create a default layout using the Report Wizard, which deletes any existing layouts in your report and replaces it with the new one.
To create the default layout:
Fields | Width |
---|---|
CUST_FIRST_NAME | 2 |
CUST_LAST_NAME | 2 |
Notice how the complete names do not display. The steps in the next section will show you how to quickly correct this issue.
In this section, you will change the field to expand vertically if the contents of the break field are longer than the specified width. As you can see in Figure 15-6, the width of the fields are fixed, but the names are incomplete. You will also add space to display between each record in the report.
To modify the layout:
0.25
, then press Enter.You have now modified the layout of your report to display all the text in the wrapped fields, and added space between the records.
In this section, you will run your report to the Paper Design view so you can see how your report displays.
Click the Paper Design button in the toolbar to display the Paper Design view. Your report runs, then displays in the Paper Design view. It should look like the following:
Save your report as wrappedbreak_
your_initials
.rdf
.
Congratulations! You have successfully created a wrapped field paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include headers and footers. By following the steps in this chapter, you can generate the report output shown in Figure 16-1.
This report has a page header, Employee Summary Report
, printed in the upper margin area of every page of the report, and a footer, Total Salary for Department <number>: <sum_sal>
, printed at the end of the list of employee information for each department.
Concepts
Data Relationships
This report uses one query to select all necessary columns. You'll add a break by assigning a column to a second group.
Layout
This report uses a group left layout with modifications. You'll increase the size of a repeating frame and the frame enclosing it to ensure they are large enough to contain a footer, then add the footer. Then you'll modify the vertical spacing of a repeating frame to add space between each instance of it.
Example Scenario
In this example, you will create a report that displays and summarizes employee data by department. To make the report more readable, you decide to add a header to each page and to add footer for each master record.
As you build this example report, you will:
To see a sample report with a header and footer, open the examples folder named headerfooter
, then open the Oracle Reports example named headfoot.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 16.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Fields | Labels |
---|---|
DEPARTMENT_ID | Department |
SumSALARYPerDEPARTMENT_ID | Total Salary for Department &DEPARTMENT_ID: |
This step will add a footer to each instance of the master repeating frame (departments).
Note: The DEPARTMENT_ID column is part of the data model so you need to reference DEPARTMENT_ID in the footer label using &DEPARTMENT_ID. |
In the Paper Design view, notice how the department summary of salaries is very far to the right of the footer label (Total Salary for Department &DEPARTMENT_ID). For this report, you will move the salary summary closer to its label.
To move the summary closer to its label:
Now that you have added the repeating frame footer, it is time to add a page header. You perform this task from the Paper Layout view.
Note: Similarly, you can add a page footer, below the page margin. |
headfoot_
your_initials
.rdf
.The only task that remains now is to make your report a little more readable by adding some white space between records and formatting values properly.
Tip: If you are familiar with format mask syntax, you could now right-click the field values, choose Property Inspector, and choose or manually enter a value for the Format Mask property. |
Tip: The steps above have formatted all of the salaries and the department summary of your report. The report summary (the summary of all salaries in the report), however, is not yet formatted. You can find the report summary on the last page of the report and format it using the same techniques as above. |
Congratulations! You have successfully created a header and footer report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports with headers that include values queried from the database. By following the steps in this chapter, you can generate the report output shown in Figure 17-1.
Concepts
In this example report, both the first and last department numbers found on each page are displayed in the page header.
Layout
This report uses one query and two groups. You'll also create two summary columns to provide the values for the header fields. To ensure unique field values for each page, you'll compute the values using the First and Last functions. The First function will return the first database value selected for a group, page, or report, and the Last function will return the last database value selected for a group, page, or report.
Layout
This report uses the default group left format with no modifications.
Example Scenario
In this example, you will create a report that displays and summarizes employee data by department. To make the report more readable, you decide to add a header to each page that indicates which departments appear on the page.
As you build this example report, you will:
To see a sample header with database values report, open the examples folder named headingdb
, then open the Oracle Reports example called headingdb.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 17.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Fields | Labels |
---|---|
DEPARTMENT_ID | Department |
JOB_ID | Job |
Tip: If you are familiar with format mask syntax, you could now right-click the field values, choose Property Inspector, and choose or manually enter a value for the Format Mask property. |
Your report should look something like this:
headingdb_
your_initials
.rdf
.For the header that you want to create (that is, departments found on this page), you need to create two summary columns that compute the values you need in order to populate the header.
Your data model should now look like this:
Now that you have the data for the header, you need to add the corresponding layout objects to the margin area of the report.
Your report should now look like this:
Congratulations! You have successfully created a header with database values report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include graphics, text, and color. By following the steps in this chapter, you can generate the report output shown in Figure 18-1.
Concepts
Data Relationships
This is a one-query group left report.
Layout
This report uses a Group Above layout, which you will modify in the Paper Layout view to make room for the title and company logo. Then, you will import the logo, create the report title, and the rest of the graphics shown in the image above.
Example Scenario
As you build this example report, you will:
To see a sample report with graphics and highlighted text, open the examples folder named graphics
, then open the Oracle Reports example named graphics.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. In this example, you will use the Report Wizard to create your query and basic report layout.
To create the report definition:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 18.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Department
, then click Next.The steps in this section show you how to use the various tools in the Paper Layout view to modify the appearance of your report. First, you will move the existing frames to accommodate the changes you will make. You will then add a title to your report, borders around each record, and change the text color.
To modify your report:
Notice that, in the Paper Layout view, the outermost frame is selected.
You can use the rulers along the sides of the Paper Layout view as guidance. Your Paper Layout should now look something like this:
graphics_
your_initials
.rdf
.Now that you have set up your layout, you can start adding new items. In this section, you will add a border around the entire report.
To add a border:
graphics_
your_initials
.rdf
.In the Paper Layout view, you can also change the font and style of the text. The steps in this section will show you how to modify the Department Number text.
To change the font:
Note: B_DEPARTMENT_ID refers to the boilerplate text "Department ID", which serves as the label for the F_DEPARTMENT_ID field. |
Note: Depending on the font and font size you choose, you may have to adjust the size of the fields to accommodate the text. In the example, since the font was increased, we selected the boilerplate text field and enlarged it. |
graphics_
your_initials
.rdf
.The steps in this section will show you how to add bullets so that a bullet displays next to each department ID.
To add bullets to your report:
Note: Pressing the SHIFT key while you draw the ellipse puts the tool in a "constrained" mode. When you create an ellipse in this mode, you can create a circle. Other tools are similar; for example, constraining the Rectangle tool creates a square. For more information on using these tools, refer to the Oracle Reports online Help. |
Note: When you are checking your layout, make sure that the ellipse displays within the R_G_DEPARTMENT_ID repeating frame. |
graphics_
your_initials
.rdf
.When you have a lot of data, you sometimes want to further distinguish each record, so that it is clear how the information is related. In this section, you will add a horizontal line to the layout that will display between each department record.
To add a line separator:
graphics_
your_initials
.rdf
.The steps in this section will show you how to use the tools in the tool palette to create a title for your report. You will use the Fill Color to create a black background and white text, as well as arrange your items so they display properly.
To add a title to the report:
Employee Details
."graphics_
your_initials
.rdf
.Congratulations! You have successfully created a paper report and modified the text color and fill colors, as well as added graphics. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that resets page numbers based on data shown. By following the steps in this chapter, you can generate the report output shown in Figure 19-1.
This example numbers pages using the format "Page X of Y". The first number (X) corresponds to the current page for each parent record (that is, each sales representative). This page number is reset to "1" for each sales representative, thus tracking the statistics of each representative separately.
The second number (Y) is the total pages required to display the customer information for each sales representative. This field is also reset with each new parent record.
Important Note: The steps in this chapter explain how to produce the "Page X of Y Pages" for the paper layout and have no effect on the Web source, because the Web source does not have pagination.
Concepts
Data Relationships
As illustrated in Figure 19-1, this report contains both a master/detail relationship and a break. This results in two levels of data differentiation. The top level (the break) will determine when page numbers reset.
Layout
This report uses the master/detail layout style, with modifications. In addition, you will create two hidden fields for the page numbers, then reference them in a boilerplate object. This will ensure that the field displaying the total number of pages is the proper size. Then you will check the Maximum Records Per Page property setting for the break group's repeating frame to ensure that your pages are numbered correctly.
Example Scenario
In this example, you will create a page number in the margin of a report in the format "Page X of Y Pages". The page number X is incremented for each page produced by customer sales for one sales representative at a time. Y represents the total number of pages for the sales representative of that sales grouping and is reset for the next sales representative.
As you build this example report, you will:
To see a sample report that renumbers pages by repeating frame, open the examples folder named pagenum
, then open the Oracle Reports example called pagenum.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and group above layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 19.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Fields | Labels | Width |
---|---|---|
ENAME | Rep Name | 10 |
REPID | Rep ID | 6 |
NAME | Customer Name | 20 |
ADDRESS | Address | 20 |
LOCATION | Location | 20 |
AREA_PHONE | Area Phone | 12 |
CREDITLIMIT | Credit Limit | 8 |
pagenum_
your_initials
.rdf
.In the Paper Design view, the data is grouped by the Sales Representative with customer data listed below each Sales Representative.
All the data will display on one page and the individual sales transactions for each customer is not yet available. You will need an additional query in the Data Model to accomplish this.
To add a new query to the report:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
To redefault the layout to use the additional query data:
Fields | Labels | Width |
---|---|---|
prodname | Product Name | 30 |
amount | Amount | 9 |
Note that the data is still grouped by the Sales Representative with customer data listed below each Sales Representative. But now, the individual products sold to the customers are listed below each customer. The report now has multiple pages.
To set properties and format the fields of your report:
To create new fields for the page numbers of the report:
Hiding both this field and the field you'll create below ensures that they'll appear only where you reference them. Changing the horizontal sizing to Variable ensures that the fields can expand to accommodate large page ranges.
In the Reset at list, click R_G_ENAME, and verify that the Start at and Increment by values are both 1, then click OK.
Because it is a duplicate of F_TOTAL_PAGENO, the Horizontal Elasticity and Visible properties are already set as desired.
In the Reset at list, click R_G_ENAME, and verify that the Start at and Increment by values are both 1, then click OK.
Next, you will reference these fields in a text box to display page numbers in the format "Page X of Y Pages."
To reference the page number fields:
Page &F_PAGENO of &F_TOTAL_PAGENO
.In the report output, the current page number will appear where you reference the field F_PAGENO, while the total number of pages for each master will appear where you reference the field F_TOTAL_PAGENO. If you wish, you can resize the page number boilerplate text object to lengthen it to ensure that no values for F_TOTAL_PAGENO get truncated.
Congratulations! You have successfully created a report that renumbers pages by repeating frame. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that display group fields in different positions. By following the steps in this chapter, you can generate the report output shown in Figure 20-1.
Concepts
Normally, a group (break) field appears to the left of (in group left report) or above (in group above report) its related fields. In this example, the group field appears between its related fields.
Data Relationships
Layout
Example Scenario
In this example, you will create a report that displays salary data by employee and department. Your users have indicated to you that they prefer the group value (that is, department name) to appear in the middle of the layout with employee names to the left and employee salaries to the right.
As you build this example report, you will:
To see a sample report that intermixes fields, open the examples folder named intermix
, then open the Oracle Reports example named intermix.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and group above layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 20.1, "Prerequisites for This example" describes the sample schema requirements for this example. |
Fields | Labels |
---|---|
DNAME | Dept. |
ENAME | Name |
SAL | Salary |
intermix_
your_initials
.rdf
.To have the department names appear in the center of this group report, it is simplest to have a column in the detail group for the department names. To achieve this result, you must create a formula column in the detail group that will display the department names.
To add a formula column:
begin
), type the following:Now that you have added the formula column to the data model, you need to add a corresponding field to display it. You can easily do this by invoking the re-entrant Report Wizard.
To add a field:
After you have added a field for the formula column, you will notice that the department values appear in two places. To eliminate this redundancy, you need to remove the master field and its heading.
To remove a field and its label:
Notice in your output that the department values are properly positioned, but they repeat for every record in the department. What you really want is for the department values to appear once for each department. To accomplish this task, you will first create a global variable to be used in comparing the current department value to the previous one. You will then write a Format Trigger to determine which values to suppress based upon the comparison within each department's records.
To create a global variable:
global
in the Name field and select Package Spec.To add the format trigger:
F_DEPARTMENT
in the Find field to select it.Congratulations! You have successfully created an intermixed fields report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that suppress the display of field labels. By following the steps in this chapter, you can generate the report output shown in Figure 21-1. Notice how the field labels for Department 40 do not display because no detail records were found
Concepts
A default master/detail report must print a detail label or field, even if there are neither fetched detail records nor values for user-created columns. This example demonstrates how to suppress the detail information for a single record, but allow the other master/detail records to display.
Data Relationships
Layout
This report uses a Group Above layout style with modifications.
Example Scenario
In this example, you will build a report that does not display field labels when there are no detail records. Instead, text displays that notifies the user that no detail records were retrieved.
As you build this example report, you will:
To see a sample report that suppresses labels, open the examples folder named suppresslabels
, then open the Oracle Reports example named suppresslabels.rdf.
For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to build a simple data model with two queries in a master/detail relationship.
To create a data model
SELECT
statement:Note: You can enter this query in any of the following ways:
Also note that if you have not installed the Pictures table into the sample schema, you will not be able to create this query. |
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 21.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
SELECT
statement:suppresslabels_
your_initials
.rdf
.The steps in this section will show you how to add a formula column to the Q_EMP (or detail) query you built in the previous section that will return a value every time a detail record is returned. You will then add a summary column to the Q_DEPT (or master) query that will count the number of times this formula column returns a value.
Before you create either of these columns, you may want to expand the size of your groups for better visibility. To do so, select the yellow group box. Click the bottom frame, then drag it down about 0.25 inches (0.5 centimeters). If you do this for both groups, you will have enough room to add your new columns.
This section will show you how to create a formula column that will return a single value.
To create a formula column:
Tip: If you receive errors when compiling, compare your code against the code provided. You can also simply copy and paste the code from suppresslabels_code.txt . |
The steps in this section will show you how to create and customize a summary column in the master query that will depend on the information returned by the formula column.
To create a summary column:
Your data model now contains both the formula and summary columns, and should look like this:
suppresslabels_
your_initials
.rdf
.In this section, you will create a default layout for your report. You will then add all the necessary layout objects for your checks.
To create the initial layout:
suppresslabels_
your_initials
.rdf
.The steps in this section will show you how to add a format trigger to your report that will prevent labels from being displayed for records will null values.
To create a format trigger:
Tip: See the image below for an example of where the frame is located in your Object Navigator. When you select the frame name in the Object Navigator, the corresponding frame will be selected in the Paper Layout view, as well. |
Tip: If you receive errors when compiling, compare your code against the code provided. You can also simply copy and paste the code from suppresslabels_code.txt . |
suppresslabels_
your_initials
.rdf
.The steps in this section will show you how to add boilerplate text to your report layout that will display when no records are retrieved.
To add boilerplate text:
Note: To adjust the way the boilerplate objects display in your resulting report, you must turn off Confine and Flex modes before you create the objects. |
No detail records retrieved.
"F_ENAME
Your Object Navigator should look like this:
Note: If this menu option is greyed out, click the title bar of the Paper Layout view, but do not click on the canvas itself. This menu option is only available when the Paper Layout view is active. |
By choosing this menu option, Reports Builder will display the records in front of the boilerplate text you just created. If there are no records, the boilerplate text will display.
The Object Navigator should now look like this:
Note: You will notice that the boilerplate text, B_1, is now located directly under the parent frame, M_G_DEPTNO1_GRPFR. This placement means that the records displayed by the objects in the repeating frame, R_G_DEPTNO1, will display in front of the boilerplate text. The boilerplate text, which says that no detail records were retrieved, only displays when no records are present. |
Now, we need to change the fill color of the parent frame, so that you cannot see the boilerplate text behind the detail records.
Note: Notice how the record for Department 40 shows the boilerplate text you added, and the field names for the record are suppressed. |
suppresslabels_
your_initials
.rdf
.Congratulations! You have successfully built a report that suppresses labels when no data is retrieved. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that display highlighted values based on one or more conditions. By following the steps in this chapter, you can generate the report output shown in Figure 22-1.
Concepts
Data Relationships
This report uses one query to fetch all data.
Layout
This report uses a tabular layout style. To add conditional highlighting, you will use the Conditional Formatting dialog box to determine which names and salaries will be highlighted in the report output.
Example Scenario
In this example, you will create a report for managers that shows a complete list of employees in the company, but also highlights employee salaries that are greater than or equal to $10,000. You also need to indicate which employees' salaries are between $4,999 and $10,000. In this example, you will use conditional formatting to highlight these figures in bold and red text.
As you build this example report, you will:
To see a sample report that uses conditional highlighting, open the examples folder named condhigh
, then open the Oracle Reports example report named condhigh.rdf.
For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to use the Report Wizard to build a simple tabular report.
To create a tabular report:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 22.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Now, let us format the data to make it more meaningful.
To format the report:
The Salary column of your report should now look like this:
condhigh_
your_initials
.rdf
.The steps in this section will show you how to add conditional formatting so that salaries greater than or equal to $10,000 will be highlighted in bold, red text, and salaries between $4,999 and $10,000 will be highlighted in bold text.
Since the data retrieved cannot be both greater than or equal to $10,000 and between $4,999 and $10,000, you will need to create two separate format exceptions. In this section, you will see how to create each distinct format exception.
To add conditional formatting:
10000
.Note: You can choose as many options as you want in the Format Exception dialog box, such as text color, style, and font. |
You should now see the following options selected in the Format Exception dialog box:
Note: Make sure you type the values in the order described, so that Reports Builder knows to highlight the data between $4999 and $10000, and not $10000 and $4999. |
condhigh_
your_initials
.rdf
.The steps in this section will show you the PL/SQL code that was automatically generated by Reports Builder when you used the Conditional Formatting dialog box to set up your format exceptions.
Note: You can also edit the conditional format trigger code in the PL/SQL Editor, but if you attempt to modify the code again in the Conditional Formatting dialog box, your edits will be overwritten by the selections in the dialog box. If you do modify the code in the PL/SQL Editor, you will see a warning note when you try to open the Conditional Formatting dialog box. |
To examine the automatically generated code:
Note: In this code, you can see that the two format exceptions you created comprise two parts of a format trigger. You needed to create two separate format exceptions in the Conditional Formatting dialog box to achieve this effect. If you had tried to create both exceptions simultaneously in the same Format Exception dialog box, your data would not have satisfied both exceptions, and thus would not have been highlighted. |
Congratulations! You have successfully built a report that highlights specified data in the report output. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that generate different versions of a form letter based on changing conditions. By following the steps in this chapter, you can generate the report output shown in Figure 23-1 and Figure 23-2.
Concepts
Data Relationships
This report uses one query to select all data.
Layout
This report uses the Form Letter layout style. You'll also create the various pieces of boilerplate that will comprise the letter. To govern the printing of these boilerplate objects, you'll use vertically collapsing anchors and PL/SQL format triggers to conditionally produce different form letters for employees who meet the specified criteria.
Example Scenario
In this example, you will create a form letter to invite all of your employees to the company picnic. For your top sales representatives, though, you also want to include a special invitation to a dinner party in the form letter. For all other employees, you want to include a thank you without the dinner invitation.
As you build this example report, you will:
To see a sample conditional form letter report, open the examples folder named condform
, then open the Oracle Reports example named condform.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 23.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Tip: Be sure to include hard returns at the end of each line. |
condform_
your_initials
.rdf
.After you add the basic text in the Report Wizard, you need to create some additional text. The text must reside inside of the repeating frame, so before you add text, you will resize the repeating frame.
To resize the repeating frame:
R_G_ENAME
in the Find field to locate it.To add more text:
B_ALL2
:B_ALL3
:B_ALL
by selecting it and choosing Tools > Property Inspector to set the Name property.The text in B_SALESREP and B_ALL2 applies only to some employees. Hence, you need to apply a condition to each one to determine when it should appear. You also need to ensure that objects (for example, B_ALL2 and B_ALL3) move up in the layout whenever objects above them (for example, B_SALESREP and B_ALL2) do not print. Otherwise, you will have large gaps in your report output for employees who do not get all of the objects. To achieve this, you must anchor the text objects together.
To create collapsing anchors:
To create format triggers:
This boilerplate will print only in the letters to employees whose commissions are greater than $500.
This logic causes B_ALL2 to print only in the letters where B_SALESREP does not print.
Tip: To preview this report for a specific destination type, in the Paper Design view, choose File > Preview Format, and select the destination type. Your report output will display as though using Printer fonts instead of screen display fonts, and you can get a clearer indication of the appearance (for example, line wrapping) of the printed report. In addition, when you print a conditional form letter report on stationery as illustrated, be sure to take into account the position of the letterhead, and so on, when creating the layout so the text of the letter fits into the overall design of the stationery. |
Congratulations! You have successfully created a conditional form letter report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include graphics that change depending on the data. By following the steps in this chapter, you can generate the report output shown in Figure 24-1.
Concepts
Oracle Reports enables you to link to and display drawings and images that are "dynamic." That is, any changes made to the graphics will be reflected in your report output at runtime.
Data Relationships
Layout
This report uses a simple Group Above layout.
Example Scenario
In this example, you will create a simple report using the Group Above layout to display data about an employee, showing a different image depending on the location of the employee's department.
As you build this example report, you will:
To see a sample report containing dynamic graphics, open the examples folder called dynamicgraphics
, then open the Oracle Reports example report named dynamicgraphics.rdf.
For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build this example report, you will need access to the data source and the graphics we have provided. You will also need to install an extra table into the database, which contains the pictures for this report.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you don't know if you have access to this sample schema, contact your database administrator.
You will also need to ask your database administrator to install the Pictures table by using the provided file called pictures.dmp
.
Before you build this report, make sure the following images are in the dynamicgraphics
directory where the sample report file is located:
NEW_YORK.TIF
BOSTON.TIF
DALLAS.TIF
CHICAGO.TIF
Although we have chosen to use TIF files in this example, you can use other graphic file formats, such as GIF, JPEG, and BMP.
Then, update your REPORTS_PATH
in the Windows registry to include the directory where these images are located. The REPORTS_PATH
is located under the Oracle Home entry in the Windows entry. When you edit the entry, add the full directory path of the location of your images.
On UNIX, you can set REPORTS_PATH
in $ORACLE_HOME/bin/reports.sh
.
The steps in this section will show you how to build a simple data model with two queries in a master/detail relationship.
To create a data model:
SELECT
statement:Note: You can enter this query in any of the following ways:
Also note that if you have not installed the Pictures table into the sample schema, you will not be able to create this query. |
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 24.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_EMPLOYEES
with the following code:Note: You can enter this query in any of the following ways:
|
dynamicgraphics_
your_initials
.rdf
.In this section, you will create a default layout for your report using the Report Wizard. You will then modify all the necessary layout objects for your graphics.
To create the initial layout:
dynamicgraphics_
your_initials
.rdf
.Now that you have created an initial layout for your report, you can rearrange your layout objects and add dynamic graphics.
To modify your layout:
1
.Note: By setting the maximum records per page to 1, only one state will display per page in your report. |
dynamicgraphics_
your initials
.rdf
.To run your report:
Your report displays in the Paper Design view and should look something like this:
Note: The image displayed by the Picture field is updated for each region. |
Congratulations! You have successfully built a report that displays graphics depending on the data in the report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
The chapters in this Part introduce matrix reports in Oracle Reports Developer and provide steps to build matrix reports. Matrix reports display information in a grid format and include variations, such as information displayed as nested grids or grids displayed for each group in the report.
A matrix report looks like a grid that contains a row of labels, a column of labels, and information in a grid format related to both the row and column labels. These reports are sometimes referred to as "crosstab" reports.
A nested matrix report contains the cross product, that displays every possible value for three dimensions - two down (such as YEAR and DEPTNO) and one across (such as JOB).
A matrix with group above report is a combination of a matrix layout and a group above layout. For each group in this report, the break group (for example, the department number) displays across the top of the record, and the details of the group (for example, the employee information) displays in a matrix format.
In this chapter, you will learn about matrix reports. By following the steps in this chapter, you can generate the report output shown in Figure 25-1.
Concepts
SELECT
statement plus the columns you create yourself. The number of columns in your report depends on the number of values contained in the columns providing the horizontal and vertical labels. Thus, the report would automatically be extended if a new job function, called RECEPTIONIST, was added to the underlying data tables.Example Scenario
In this example, you will create report that cross tabulates salaries by job function and department. The result would be a matrix with job functions listed across the top, departments down the side, and sums of salaries in the cells. Thus, you could quickly determine the sum of all of the salaries for clerks in department 20 and compare that value to the one for all clerks in some other department.
As you build this example report, you will:
To see a sample matrix report, open the examples folder named matrix
, then open the Oracle Reports example named matrix1qb.rdf
for a single-query matrix report, or matrix3qb.rdf
for a multi-query matrix report. For details on how to access these reports, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
You can build a matrix report with a single query in the data model. A single-query data model typically performs better than a multiple-query data model.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 25.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Note: In this case, the query itself performs the summary through the SUM function. Hence, you should not use the Sum button in this instance. |
You can build a matrix report with multiple queries in the data model. A multiple-query data model is typically easier to conceptualize and code than a single-query, but the single-query data model typically performs better.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layouts.
To create a blank report:
When you create a report with multiple queries, it is typically easier to create all of the queries with the Data Wizard first and then create the layouts with the Report Wizard.
To create the queries:
Q_Dept
for the Query name, then click Next.SELECT
statement:Tip: If you click Query Builder, you can build the query without entering any code manually. |
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 25.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Job
and use the following SELECT
statement:Q_Matrix
and use the following SELECT
statement:To create the cross product group:
To add the data link:
Once your data model is complete, you need to create a layout for the data objects to display in the report output.
To create the layout:
To make your matrix report more useful, you should add summaries of each row and column in the matrix, and the whole report. In the single-query case, you can add these summaries very easily with the Report Wizard. In the multiquery case, you would need to add the summaries manually and then use the Report Wizard to create fields for them.
The steps below describe the procedure for adding summaries to the single-query matrix.
To add summaries to a single-query matrix:
Note: Although you can use the Report Wizard to add summaries to a single-query matrix, you cannot use this method for a multiquery matrix. |
Tip: You may have to use the arrows to make the Totals tab visible. |
Note: When your new layout is created, you should notice a couple of things. First, at the bottom of each column of the matrix, you should now see a summary of that column's values. The report is also probably more than one page long now. Because of the width of the layout, the summaries for the departments cannot fit on the page with the rest of the matrix. Hence, the department summaries and the report summary overflow to the next page. Go to the second page of the report and you will see the department summaries and the report summary. |
To make your report easier to read, you can add formatting to the monetary values.
To format monetary values:
A matrix report displays a juxtaposition of data – in other words, the values held in common by two different categories of data. These categories are indicated by the row and column labels.
The matrix displays this juxtaposition of values using a grid-like format. If the two categories have nothing in common, the grid at that point is empty. The matrix appears to be full of "holes". You can fill the holes using boilerplate text.
Note: Do not confuse empty spaces in the grid with null values. A null value is an actual value fetched from the database. The spaces in a matrix report are empty because nothing has been fetched to fill them. |
To replace blanks with zeroes:
Tip: The steps that follow require some precision in the placement of objects. Hence, you may want to magnify the view to make the process easier. Click the Magnify tool and then click somewhere in the Paper Layout view. Repeat as many times as necessary. |
B_1
in the Find field. You will be taken to the object you just created. If you are viewing the Object Navigator in Ownership View (View > Change View > Ownership View), you should see B_1 underneath R_G_SUM_SAL and on the same level as F_SUM_SAL.Tip: If B_1 does not appear underneath R_G_SUM_SAL, return to the Paper Layout view, delete B_1 and try again. |
Tip: After this operation, B_1 should appear just above R_G_SUM_SAL, as a peer rather than a child of R_G_SUM_SAL. If B_1 is still appearing as a child under R_G_SUM_SAL, repeat steps 11 through 14 until it is no longer appearing as a child of R_G_SUM_SAL. |
Tip: If the $0.00 is not quite aligning with the other monetary values around it, select it and use the arrow keys to move it to the desired location. |
Sometimes matrix reports are easier to read when they have grid lines that divide the cells from each other. For most objects, No Line is the default setting. To add grid lines, all you need to do is select the appropriate objects and give them a line color.
To add grid lines
matrix1qb_
your_initials
.rdf
Congratulations! You have successfully created a matrix report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about nested matrix reports. By following the steps in this chapter, you can generate the report output shown in Figure 26-1.
Concepts
Notes:
|
Example Scenario
In this example, you will create a report that cross tabulates salaries by year and department, and by job function. The result is a matrix with job functions listed across the top, years and departments down the side, and sums of salaries in the cells. Thus, you can quickly determine the sum of all of the salaries for clerks in department 20 and compare that value to the one for all clerks in some other department.
As you build this example report, you will:
To see a sample nested matrix report, open the examples folder named nestedmatrix
, then open any of the Oracle Reports examples named nested1.rdf
, nested2.rdf
, or nested3.rdf
. For details on how to access them, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
You can build a matrix report with a single-query in the data model. A single-query data model typically performs better than a multiple-query data model.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 26.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Fields | Labels | Width |
---|---|---|
YEAR | (no change) | 4 |
DEPTNO | (no change) | (no change) |
JOB | (no change) | 10 |
SUM_SAL | <none> | 10 |
Note: You can set alignment and format monetary values directly in the Paper Design view. Simply click the item, then click the appropriate toolbar button (if you run the mouse over these buttons, hint text displays). If the Paper Design view and the Object Navigator are displayed side-by-side, notice that when you select an item in one, the selection is reflected in the other. |
You can build a matrix report with multiple queries in the data model. A multiple-query data model is typically easier to conceptualize and code than a single-query, but the single-query data model typically performs better.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layouts.
To create a blank report:
When you create a matrix report with multiple queries, it is typically easier to create all of the queries with the Data Wizard first and then create the cross product group and the necessary links in the Data Model view.
To create the queries:
Q_Year
for the Query name, then click Next.SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 26.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Dept
and use the following SELECT
statement:Note: You can enter these queries in any of the following ways:
|
Q_Job
and use the following SELECT
statement:Q_Salary
and use the following SELECT
statement:Tip: The order of the queries is significant in this case. Q_Dept must appear to the right of or below Q_Year in order for the values of DEPTNO to be nested inside of the values of YEAR in the output. |
To create the cross product group:
To add the data links:
Once your data model is complete, you need to create a layout for the data objects to display in the report output.
To create the layout:
Fields | Labels | Width |
---|---|---|
SUM_SAL | <none> | 10 |
YEAR | <none> | 4 |
JOB | <none> | 10 |
If you compare the single-query nested matrix output in Figure 26-4, "Paper Design view for the nested matrix report" to the multiple-query output in Figure 26-10, "Paper Design view for the nested matrix output", you notice that the multiple-query case displays all of the departments for every year while the single-query case does not. In the single-query case, only those departments that actually have values in their matrix cells are displayed in the output. To achieve a similar result with multiple queries, you need to have a parent/child relationship between the groups containing YEAR and DEPTNO.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layouts.
To create a blank report:
When you create a matrix report with multiple queries, it is typically easier to create all of the queries with the Data Wizard first and then create the cross product group and the necessary links in the Data Model view.
To create the queries:
Q_Dept
for the Query name, then click Next.SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 26.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Job
and use the following SELECT
statement:Q_Salary
and use the following SELECT
statement:To create the cross product group:
To add the data links:
Once your data model is complete, you need to create a layout for the data objects to display in the report output.
To create the layout:
Fields | Labels | Width |
---|---|---|
SUM_SAL | <none> | 10 |
YEAR | <none> | 4 |
JOB | <none> | 10 |
To make your matrix report more readable, you should format the monetary values.
To format monetary values:
nested3_
your_initials
.rdf
Congratulations! You have successfully created three nested matrix reports. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about nested matrix with group above reports. By following the steps in this chapter, you can generate the report output shown in Figure 27-1.
Concepts
Data Relationships
This example of a matrix with group above report uses one query and at least five groups. At least one group is placed above the cross product to serve as the Master group.
Layout
This report uses the Matrix with Group layout style.
Example Scenario
In this example, you will create report that cross tabulates salaries by department and by job for each year. The result is a group report where year is the master and the detail is a matrix with job functions listed across the top, departments down the side, and sums of salaries in the cells. Thus, you can quickly determine the sum of all of the salaries for clerks in department 20 for any particular year.
As you build this example report, you will:
To see a sample matrix with group above report, open the examples folder named matrixgroup
, then open the Oracle Reports example named matrixgroup.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
Since this report is a single-query report, it is easiest to build it with the Report Wizard.
To create the data model and layout with the Report Wizard:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 27.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Note: In this case, the query itself performs the summary through the SUM function. Hence, you should not use the Sum button in this instance. |
matrixgroup_
your_initials
.rdf
.To make your report more readable, it would be useful to add labels for the row and column summaries. It would also be nice to have lines above the column summaries to better distinguish them from the cell values.
To add labels:
Job Tot.:
, then click in a blank area of the Paper Design view. If you perform this step correctly, the label should now appear for all of the column summaries in the report.Tip: If you want more precise movements, turn off Snap to Grid in the View menu. It may also be helpful for this step to turn off Flex mode by clicking the Flex Off button in the toolbar. |
Dept. Tot.
, then click in a blank area of the Paper Design view. If you perform this step correctly, the label should now appear for all of the column summaries in the report.To add lines above column summaries
Note that the output has no space between the groups.
To add more space:
Now that you have created a paper layout, suppose that you decide to have a Web layout for this report. You can quickly create a Web layout in the Report Wizard without changing your paper layout.
To create a Web Layout:
Notes: If Netscape 7.0 is your default browser, and the browser does not display, set the registry key HKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
Congratulations! You have successfully created a matrix group above report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
The chapters in this Part provide steps to build reports that are intended for specific business purposes. The examples provided include computing values over specified periods of time, collecting data over a specified range, and grading data. Following the steps, you will learn how to print reports on preprinted forms (for checks or invoices), split a report into sections and distribute each section to a different destination, and include a simple table or contents and index, or a multilevel table of contents.
A time series calculations report computes values over a specified period of time. You can use the techniques used for this report to produce other formats of time series calculations. For example, you can build a report that calculates and displays the quarterly average of purchases for each customer.
A paper report generated to spreadsheet output can be displayed in your browser. You can integrate the paper layout into a Web layout by modifying the Web source of your report, and then generate the output. You can then deploy this report with the Reports Server under Oracle WebLogic Server and display it in a spreadsheet utility (such as Microsoft Excel) inside your browser.
A report with aggregate data collects data within a range, retrieves values from the database, and formats them based on an aggregate range defined. You can use parameters to specify the range over which the data should be collected.
A check printing report contains a stub and spelled-out cash amounts. You can create a PL/SQL function that returns spelled-out numerical values, imports an image of a preprinted form (such as a blank check image), and prints your report on the form.
A report using a preprinted form enables you to use formatting techniques to print reports on preprinted forms when you do not have access to a computer readable version of the forms. Such reports must be designed so that the data prints in the exact positions on the form.
An invoice report displays several distinguishing characteristics of a typical invoice, such as customer name and address, sales order number, billing information, and billing totals. You can import an image and print your report on a preprinted form.
A ranking report grades data in two different ways: by count and by percentage. You can set the ranking criteria at runtime or let the criteria default to previously specified values.
Navigational tools, such as a simple table of contents and an index, can be added to a paper report. First, the page numbering must be determined for the entire report, then Oracle Reports Builder can generate the table of contents and index based on the established page numbering.
A multilevel table of contents can be added to a paper report to facilitate navigation. This table of contents is created similarly to that in Chapter 35, "Building a Paper Report with a Simple Table of Contents and Index", however with a hierarchy that categorizes the information in the table of contents.
A report built for bursting and distributing a report enables you to simultaneously deliver a single report to multiple destinations. You can create a single report, burst each section to a separate report, and then send each section in any format (such as, PDF or HTML) to multiple destinations.
A multibyte character report can display text in virtually any language. You can produce reports that display text in multibyte character sets, such as Simplified Chinese, Traditional Chinese, Japanese, Korean, and Unicode.
In this chapter, you will learn about reports that show data based on calculations over a period of time. By following the steps in this chapter, you can generate the report output shown in Figure 28-1.
Concepts
Reports with time series calculations calculate values over a specified period of time. The techniques described for this report can be used to produce other formats of time series calculations, as well.
Data Relationships
This time series calculations report uses a query that will compute four-month moving averages of customer purchases. The SELECT
statement will sum the current purchase (TOTAL
) with purchases made by that customer in the previous four months, then average that sum through use of a self-join. For example, if the data queried is 30-JUL-00, Oracle Reports will average all purchases the customer made between 30 MAR-00 and 30-JUL-00.
Example Scenario
In this example, you will use the Report Wizard to create a simple time series calculations report for both paper and the Web that calculates and displays the four-month average of purchases for each customer. For the JSP-based Web report, you will modify the Web source to change labels and add format masks.
As you build this example report, you will:
To see a sample time series calculations report, open the examples folder named timeseries
, then open the Oracle Reports example called timeseries.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Summit Sporting Goods (SUMMIT) schema. To download the SQL scripts that install the schema, see "Accessing the Data Sources" in the Preface.
The steps in this section will show you how to build a simple data model and report layout in the Report Wizard, which you can then use to generate either a JSP-based Web report or a paper report. In the next section, you will modify the JSP so that the appropriate information displays in your Web report.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 28.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
4-Month Moving Average
, then click NextYour data model should look something like this:
timeseries_
your_initials
.rdf
.Now that you have created your paper report layout, you can take the same report and generate a JSP-based Web report that looks the same as your paper report.
To modify your JSP-based Web report:
timeseries_
your_initials
.rdf
as a JSP under the same name (timeseries_
your_initials
.jsp
).In the Web Source, you need to change the format mask to match that of the paper report.
formatMask="LNNNGNN0D00"
to the line, so that the line looks like this:Note: The bold text is the new format mask tag that we have added to the Total field. |
Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry key HKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
The report displays the total for each customer, as well as the average over the past four months.
Note: For information on creating a Parameter Form for a JSP-based Web report, refer to the documented example on the Oracle Technology Network (OTN): on the Oracle Reports page ( http://www.oracle.com/technology/products/reports/index.html ), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Index. In the Collateral Type list, choose Examples, and click Search. In the list of examples that displays, click Building a JSP-based Web Report with a Parameter Form. |
Congratulations! You have successfully created a time series calculations report for both paper and Web. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about Enhanced Spreadsheet reports. Oracle Reports generates spreadsheet output using the ENHANCEDSPREADSHEET
format. The ENHANCEDSPREADSHEET
output format is new in Oracle Reports 11g Release 1 (11.1.1) and provides the following benefits:
ENHANCEDSPREADSHEET
output format.ENHANCEDSPREADSHEET
output format allows for bursting and distributing reports to spreadsheet output format.ENHANCEDSPREADSHEET
output, the complete report data is shown as one unbroken chunk of information in Microsoft Excel, not broken up by page breaks, as happens in other output formats, such as PDF and RTF that are restricted by horizontal and vertical page sizes.For more information about Enhanced spreadsheet output, refer to Section 2.8.13, "About Enhanced Spreadsheet output".
By completing the steps in this chapter, you can generate the Enhanced Spreadsheet report output, as shown in Figure 29-1.
Concepts
http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Index. In the Collateral Type list, choose Demonstrations, and click Search. In the list of demos that displays, click Output to Excel with Oracle Reports.Note: The steps in both this chapter and the Getting Started demonstration allow you to use rich formatting, such as colors and fonts so that you generate report layout, not just data, in Microsoft Excel output inside a Web browser. However, you must add custom JSP code to get the output in Microsoft Excel. The Web report can only be run as JSP in Oracle WebLogic Server and not through rwservlet , thus this method can only display the Microsoft Excel output inside a Web browser. |
ENHANCEDSPREADSHEET
output format enables you to burst and distribute reports to spreadsheet format, as well as generate large data sets (up to 75,000 rows) to spreadsheets.The ENHANCEDSPREADSHEET
output formats generate output from paper layout reports to HTML files that can be directly opened with Microsoft Excel 2000. You can:
.rdf
, .xml
, .jsp
), using rwrun
or Reports Server clients (rwclient
, rwservlet
). See the following example scenario.For the steps to implement this functionality to directly generate spreadsheet output, see Section 2.8.13, "About Enhanced Spreadsheet output" and Section 4.7.11, "Generating Enhanced spreadsheet output".
Example Scenario
In this example, you will generate a report to Microsoft Excel output. The output is generated after integrating the paper layout into a Web layout by modifying the Web source of your report.
As you build this example report, you will:
To see a sample report, open the examples folder named papertoexcel
, then open the Oracle Reports example named mypaperreport.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 29-1.
Table 29-1 Example Report Files
File | Description |
---|---|
| The sample paper report. Running this RDF in Reports Builder will display the result of your paper report in the Paper Design view. |
| This JSP-based Web report contains the modifications to the paper report you will make in Reports Builder. |
| The SQL for the query you need to enter. |
To build the example in this chapter, you must have the example files packaged with the Oracle Reports software (see "Example Scenario", above), as well as access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator. You must have Microsoft Excel 2000 or higher to complete this example.
The steps in this section show you how to build a simple data model and report layout in the Report Wizard, which you can then use to generate either a JSP-based Web report or a paper report. In the next section, you will modify the JSP, so that the appropriate information displays in your Web report.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in either of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 29.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
mypaperreport_
your_initials
.rdf
.Now that you have created your paper report layout, you will learn how to take the same report and generate a JSP-based Web report that looks the same as your paper report.
To modify your JSP-based Web report:
In the Web Source view, you need to change the dummy JSP code created by Oracle Reports Builder.
Tip: Choose Edit > Find and Replace, then type dataArea in the Find what text box. |
<rw:dataArea>
tags, and choose Insert > Frame. This inserts the following code in your Web Source view:<rw:include id="include" src="..."> </rw:include>
Note: The rw:include tag enables you to include the outer frame of your paper layout in the Web Source view as JSP code. Adding a rw:include tag to the rw:dataArea tag enables you to include and reuse the existing paper layout in a Web layout. |
src
attribute of rw:include
tag. The line should look like this:The report displays, in Web format, the employee data you specified. Here, you can see employee details, such as their name, email, hire date, salary, department to which they belong and their location.
myexcelreport_
your_initials
.jsp
.Now that you have created your JSP-based Web report, which looks the same as your paper report, you will modify it further to display the report in Microsoft Excel in your Web browser.
First, copy myexcelreport_
your_initials
.jsp
to the deployment directory of your Application Server. For testing purposes, in this example, we will use the Oracle WebLogic Server instance shipped with the Oracle Developer Suite.
For more information on deploying a JSP-based Web report, refer to the section "Deploying Your Reports" in the chapter "Running Report Requests" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual
To modify the report to display in Microsoft Excel:
In the Web Source view, you will change the content type of the HTTP response using the JSP directive contentType
, so that the browser opens Microsoft Excel to display your report output.
and modify it to read as follows:
myexcelreport_
your_initials
.jsp)
into the following directory:For example, the Oracle Classic Instance may be Oracle Classic Instance-asinst_1.
cd $DOMAIN_HOME\bin\startManagedServer.bat WLS_REPORTS
$DOMAIN_HOME\bin\startManagedServer.sh WLS_REPORTS
Tip: The Oracle WebLogic Server instance starts once the containers for Java EE have been initialized. |
In our example, we use:
Note: The connect string you type in the URL is for the database you used to create the data model in Section 29.2, "Create a Query and the Layout". For the purposes of this example, we have used plain text to pass the connect string. For information on using security, refer to the chapter "Securing Oracle Reports Services" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
Note: If you want your report to display the same colors in Excel as in your report definition, you must use colors supported by the Excel color palette. Otherwise, Excel tries to match unsupported colors, but the match may not be what you expect. |
Your final report output should look something like this:
You have created Excel output of your report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include aggregate data, based on value ranges. By following the steps in this chapter, you can generate the report output shown in Figure 30-1.
Concepts
In a report that aggregates, or collects, data within ranges, values from the database are retrieved and formatted based on an aggregate range that you define. You can even use parameters to specify the range over which the data should be collected.
Data Relationships
This report uses two "functions" in its SELECT
statement to specify the aggregate range. The functions are (FLOOR(SAL/1000))*1000)
, which calculates the lowest salary, and (CEIL*((SAL+1)/1000) * 1000)
, which calculates the highest salary. The columns that receive the values of these functions are placed into a break group to produce the control break format of this example report.
Layout
This report uses the Group Left layout style.
Example Scenario
In this example, you will build both a paper and JSP-based Web report that collects and displays names of all employees whose salaries fall within the range of 0 to 999, then collects and displays all employees whose salaries fall within the range of 1000 to 1999, and so on. You will be able to modify this report to display any aggregate range you need.
As you build this example report, you will:
To see a sample report that aggregates data within ranges, open the examples folder named aggregatingdata
, then open the Oracle Reports example named aggregatingdata.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the SCOTT sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to build a simple data model and report layout in the Report Wizard, which you can then use to generate either a JSP-based Web report or a paper report. In the next section, you will modify the JSP so that the appropriate information displays in your Web report.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 30.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Salary Range
.Note: You can also modify the other column headers to make the text more meaningful. |
Tip: To find objects in the Paper Layout view, you can use the Object Navigator. When you click an item name in the Object Navigator, the corresponding object is selected in the Paper Layout view. |
-
" in the text box. The layout should now look like this:Note: Notice how the report displays the employee names per salary range, hence aggregating the data. |
aggregatereport_
your_initials
.rdf
.Now that you have created your paper report layout, you will now learn how to take the same report and generate a JSP-based Web report that looks the same as your paper report.
To modify your JSP-based Web report:
aggregatereport_
your_initials
.rdf
as a JSP under the same name (aggregatereport_
your_initials
.jsp
).In the Web Source, you need to change the column titles to match those of the paper report.
Tip: Choose Edit > Find and Replace, then type " bottom " in the Find what text box. |
Salary
" so that the line now looks like this:Top
" column. Delete the header text so that the line looks like this:Name
" and "Dept
", like so:Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry key HKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
The report should look something like this:
The report displays, in Web format, the aggregate data you specified. Here, you can see which employees fall into the specified salary ranges.
Note: For information on creating a Parameter Form for a JSP-based Web report, refer to the documented example on the Oracle Technology Network (OTN): on the Oracle Reports page ( http://www.oracle.com/technology/products/reports/index.html ), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Index. In the Collateral Type list, choose Examples, and click Search. In the list of examples that displays, click Building a JSP-based Web Report with a Parameter Form. |
Congratulations! You have successfully built a report that aggregates data, for both paper and Web. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that format output as checks with cash amounts spelled out in words. By following the steps in this chapter, you can generate the report output shown in Figure 31-1.
Concepts
To spell out the value of a check, you use a PL/SQL function to split the number into its constituent numerals, then use a formula column to combine the words into the spelled-out cash amount.
Note: Many of the concepts in this example are used in the following example reports:
|
Data Relationships
Layout
This report uses a default Form style.
Example Scenario
In this example, you will use the Report Wizard to create your basic report definition. You will create a PL/SQL function that spells out the numerical value of the check amount. You will also create a formula column that formats the dollar amounts on your checks. You will import an image of a blank check image, and use the tools in the Paper Layout and Paper Design views to rearrange the fields in your report according to how you want them to display on the resulting check printing report. You will also use these tools to create a stub for every check.
As you build this example report, you will:
To see a sample report where the cash amounts are spelled out, open the examples folder named spellcash
, then open the Oracle Reports example named spellcash.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to use the Report Wizard to create a simple report definition.
To create a report definition:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 31.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Table 31-1 Field description of Labels page
Fields | Labels | Width |
---|---|---|
ORDER_ID |
|
|
ORDER_DATE |
|
|
CUSTOMER_ID |
|
|
ORDER_TOTAL |
|
|
CUSTOMER_NAME |
|
|
C_STREET_ADDRESS |
|
|
C_POSTAL_CODE |
|
|
C_CITY |
|
|
C_STATE_PROVINCE |
|
|
C_COUNTRY_ID |
|
|
CHECK_NO |
|
|
Since you have only created the initial report definition, the formatting will not display like a check. It should look something like this:
spellcash_
your_initials
.rdf
.The steps in this section will show you how to create a formula column that is based on a function. The function you create will return verbal or word value for the numerical value of the check. You will then create a formula column that will spell out the numerical value in the designated currency. In this case, we will use dollars and cents.
In this section, you will create a function that simply returns the check amount in word format, such as "twenty-four sixty-five." The formula column you create in the next section will use the information retrieved by this function to spell out the cash amounts on your checks.
To create a PL/SQL function:
Spell
in the Name box.Note: You can enter this code by copying and pasting it from the provided text file called spellcash_code.txt into the PL/SQL Editor. |
Your new function now displays in the Object Navigator:
In this section, you will create a formula column that uses the information retrieved by the Spell function you created in Section 31.3.1, "Create a PL/SQL function". This formula column will use the verbal values of the check amounts and combine the words with the correct currency. For example, the "twenty-four sixty-five" returned by the Spell function will be turned into "twenty-four dollars and sixty-five cents".
To create a formula column:
Your data model should look like this:
Note: You can enter this code by copying and pasting it from the provided text file called spellcash_code.txt into the PL/SQL Editor. |
Your new formula column, called SPELLED_AMOUNT, now displays in the data model.
The steps in this section will show you how to manually create a query in the Data Model view that will return the items in the customer's order. This data retrieved will be used to display the order details in the check stub.
To manually create a query:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
The steps in this section will show you how to adjust the margins of your check printing report and align the fields with an image of a check. You can scan any check and use its image to lay out the objects of your check report. In this section, we use the image we have provided to you, called blankcheck.jpg
. This image is located in the spellcash
example folder.
Before you can insert the check image, you must first rearrange the layout objects.
To rearrange the layout objects:
The layout currently looks like this:
Tip: When you click the center square, notice that a dotted guideline displays while your mouse button is depressed. You can use these guidelines to help place objects exactly where you want them in the Paper Layout view. |
When you are done, it should look something like this:
In this section, you will import an image of a blank check. You can use any check you like. For this example, we have provided an image called blankcheck.jpg
in the spellcash example directory.
To import the blank check image:
blankcheck.jpg
, then click OK to display the blank check image in the Paper Layout view.The steps in this section will show you how to use the various tools in the Paper Layout view to modify the look and feel of your check report. Here, you will learn how to add and modify layout objects and fields according to how you want them to display on the resulting checks. You will create copies of certain fields that you will then use in Section 31.6, "Create a Check Stub With Payment Information and Order Details" to create the check stub.
To set up the check printing fields:
The repeating frame called R_G_ORDER_ID should now be selected in the Paper Layout view. You can also look in the Object Navigator, under Paper Layout, to make sure R_G_ORDER_ID is selected.
Tip: When you click and drag a resize handle in the Paper Layout view, guidelines display along the ruler to help you place your objects. In this case, drag the bottom center resize handle down the page until the horizontal guideline reaches 8.75 inches (22 centimeters). |
You should see a new field called F_ORDER_TOTAL1. If this field displays on top of the other layout objects, click and drag it down below the other layout objects so that your Paper Layout view now looks something like this:
Note: When you copy and paste a field, Reports Builder maintains the size of the field. So, when you copy and paste F_ORDER_DATE, you may not see the full name of the field. While the field is selected, you can click and drag the right border of the field to the right so that you can see the full name of the field, F_ORDER_DATE1. |
Note: Since this field is small, it may be difficult to find. You can use the Object Navigator to find and select the field. When you click a field in the Object Navigator, under Paper Layout, the corresponding field is also selected in the Paper Layout view. |
Note: We have expanded the size of the two new fields (F_CHECK_NO1 and F_CHECK_NO2) to make them easier to see, but you do not need to resize these fields. |
The steps in this section will show you how to use the Paper Design view to rearrange the fields you just created. You will use the blank check image we have provided as a guide.
Note: When you click the Paper Design button while you are in another view (that is, Paper Layout view or Data Model view), Reports Builder runs your query and your layout. If you receive any error messages when you click the Paper Design button, go back to your original view to verify your changes. You can always compare your report against the sample report we have provided, called spellcash.rdf . |
You will see your layout objects, as well as the blank check image:
Note: You will see that the preview does not quite look like a check report. The steps in this section will show you how to move your fields so that your report looks like a proper check. |
Note: If you closed Reports Builder for any reason and are returning to building this report, make sure you click the Flex Off button in the toolbar so that you can move the fields around in the Paper Design view. |
The check should now look like this:
The steps in this section will show you how to change the font, alignment, and formatting of the data on your check.
To modify the look and feel of the check:
Tip: If you have trouble deselecting the objects, go to the Object Navigator and click any item. The objects that were selected in the Object Navigator should display as deselected. |
$46,257.00
.****
", then close the Property Inspector.The amount should now display like this: ****$46,257.00
.
Your report should now look something like this:
Note: You will notice that the other boilerplate text is still overlaying the image. We will rearrange this text later in the chapter. |
When you create a check printing report, you will sometimes want to create a check "stub" that contains the payment information on the check, as well as the details of the order. The steps in this section will show you how to create a check stub that contains the payee, amount, date, check number, and other payment information.
You will then use the information retrieved by the second query in your data model to print a simple tabular report on the check stub that displays the order information associated with the check.
The steps in this section will show you how to use the tools in the Paper Design view to create a check stub for your check report. You will rearrange the fields you created in the previous section so that every time you run the report, a corresponding check stub will display for every check.
You will also create guidelines in the Paper Design view to help you align the check stub information with the data in the check report.
To create a check stub:
Note: The guideline is a broken black line spanning across this image, to the right of "Pay Exactly." |
Note: You can always select your fields in the Object Navigator, under Paper Layout > Main Section > Body, and these fields will appear selected in the Paper Design view. |
The check stub should now look like this:
Note: To create this guideline, click in the left-hand ruler, then drag your mouse until the line is aligned to the left of box containing Date, Check No., and Amount. |
Tip: If you have difficulty fitting the F_CUSTOMER_NAME1 field into the provided space, you may need to resize the field. To do so, select the field, then drag the right middle resize handle to the left, making sure that there is still enough space for the customer name (Harrison Sutherland). |
Your check stub should now look like this:
In the previous section, you created a check stub that displays the payment information, that is a copy of the information on the check itself. The steps in this section will show you how to add the details of the order to the check stub by creating a simple tabular report. You will use the Report Block Wizard to create the simple tabular report, then format the data in the Paper Design view.
To add order details:
Fields | Labels | Width |
---|---|---|
LINE_ITEM_ID | Line | 2 |
PRODUCT_ID | Product ID | 4 |
PRODUCT_NAME | Product Name | 40 |
UNIT_PRICE | Unit Price | 4 |
QUANTITY | Quantity | 4 |
Since the new report block is not formatted, let us format the data to look like the rest of the report.
Your report should now look like this:
Note: You can also compare your results with the example report we have provided, called spellcash.rdf . |
Congratulations! You have successfully built a report with spelled-out cash amounts on the check, as well as the payment and order details on the check stub. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that display output on preprinted forms. By following the steps in this chapter, you can generate the report output shown in Figure 32-1.
Concepts
Using the various tools in the Paper Layout view and the Paper Design view, you can format a report to print on preprinted forms.
Note: Many of the concepts in this example are used in the following example reports:
|
Data Relationships
This report uses two queries linked in a master/detail relationship. You will create a break in the detail group and two summary columns in the master group.
Layout
This report consists of two partial default layouts, one with a mailing label format and one with a tabular format. You will move fields to the correct positions on the page and restrict the master repeating frame to appearing once per form.
Example Scenario
In this example, you will learn formatting techniques for printing reports on preprinted forms when you do not have access to a computer readable version of the forms. Such reports must be designed so that the data prints in exact positions on the form. This example report consists of data formatted such that all values fall precisely within the corresponding fields of a preprinted sales order. The form is on a standard sized 8.5 inches by 11 inches (21.6 centimeters by 27.9 centimeters) page. The employee name and the customer's name and address must display in the region at the top of the page. The order item details must only display 40 characters. Anything over 40 characters will be placed on a second page of the form. At the end of our example, we add page numbers. This section is optional, as your forms may not require page numbers.
Note: The above measurements are for the form we use in this example. If you do not have access to an online, or computer readable version of your preprinted form, you will need to take these measurements yourself, then use the steps below to create your own report definition. |
As you build this example report, you will:
To see a sample report that uses preprinted forms, open the examples folder named preprint
, then open the Oracle Reports example named preprint.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to manually create the data model for your report. Your data model will consist of two linked queries. The first query will retrieve all the customers that have orders in the database. The second query will retrieve all of the order information for each of the customers, and will contain a break group based on the date of each order.
The steps in this section will show you how to manually create two queries in the Data Model view.
To create the queries:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 32.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
The query displays in the Data Model view, and should look something like this:
SELECT
statement:Your data model should now look like this:
Note: In Q_CUSTOMER, the second WHERE clause restricts the values returned to only those customers who have current orders. In Q_ORDERS, we have used "to_char" to account for a new datatype, "Datetime." Since this new datatype is not recognized by Oracle Reports, you cannot use format masks on this particular column yet. |
preprint_
your_initials
.rdf
.The steps in this section will show you how to modify your data model to link the two queries and to cause the data retrieved to break on a particular column.You will also create several summary columns to calculate information for each order.
To modify your data model:
Tip: You can select the group or the query title and use the resize handles to modify the look of your data model. |
Your data model should now look like this:
Note: These two summary columns calculate the total items per page and the total items in the order for the report. |
Your data model is now complete, and should look like this:
The steps in this section will show you how to create a layout that displays the objects in the desired locations on your preprinted form. You will start by adjusting the margin of your report, then creating the mailing label portion that will print at the top of each page that shows the address information for the customer. You will then create the body of the report, which contains the order information that display the date, order number, description, number, price per item, and total price.
Before you can start adding layout objects, you will need to adjust the margin of your layout.
To set up the layout:
Tip: You can use the corner resize handles to adjust the size of your margin. |
Now, you are ready to create your report layout.
In this section, you will use the Report Block Wizard to create a mailing label for the address section of your preprinted form.
To create an address label:
Note: For more information on building a mailing label report, see Chapter 6, "Building a Mailing Label Report". |
In this section, you will add a report block that displays the order items and details that correspond to the customer identified in each mailing label. These items and details are required for your preprinted form.
To add order item details to your report:
Fields and Totals | Labels | Width |
---|---|---|
ORDER_DATE | <none> | 9 |
PRODUCT_ID | <none> | 8 |
PRODUCT_DESCRIPTION | <none> | 40 |
QUANTITY | <none> | 4 |
UNIT_PRICE | <none> | 8 |
ITEM_TOTAL | <none> | 10 |
Note: The Width values are based on the space available on the preprinted form. |
Figure 32-8 Paper Layout view of the preprinted form example with mailing label and order item details
Now that you have added the elements you want displayed on your report, you need to set up the layout so that only records required for the preprinted form display on each page, and that the correct amount of information displays in the available amount of space on the form. Also, the form requires that a summary of each page displays in the same location on the page.
To adjust the layout and add page summaries:
Note: This field, as well as the second field you will create, should not be located within the repeating frame called M_G_ORDER_DATE_GRPFR. If you cannot fit these fields on the page, resize the repeating frame so that you can place the fields below the repeating frame, but still on the same page. |
The steps in this section will show you how to preview your report in the Paper Design view, and make a few last-minute tweaks using the tools in the Paper Design view. It is sometimes easier to use the Paper Design view to finish your report, since you can see actual data displayed.
To format your report in the Paper Design view:
Tip: If you cannot find this field, you can use the Object Navigator to find the field name and click it. When you select an item in the Object Navigator, the corresponding object is selected in the Paper Design view. |
Your report should now look like this:
Note: To see a more complete view of the report, you can open the sample report we have provided, called preprint.rdf . To view the report, open the report and click the Run Paper Layout button in the toolbar. |
Note: The Paper Design view of your report will not look like the image above. We printed our report on a sample preprinted form. The above image is a snapshot of that form. |
Some preprinted forms may require you to print page numbers. The steps in this section will show you how to add page numbers to your output that will display when the number of order items extends beyond a single page.
To add page numbers to your report:
Now that you have created the page number fields, you need to make them visible.
&<F_PAGE_NUMBER> of &<F_TOTAL_PAGES>
.Note: The "&<F_PAGE_NUMBER>" text will replace that text with the current value of the summary field you just created, which determines the page number of the current page. The "&<F_TOTAL_PAGES>" text will replace that text with the current total number of pages of the report, based on the value of the summary field of the same name. |
Your report should now look like the following image. Notice how Reports Builder calculates that this particular report is one page, thus displays "1 of 1" above the order details.
Congratulations! You have successfully built a report that you can print on a preprinted form. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that display output on invoices. By following the steps in this chapter, you can generate the report output shown in Figure 33-1.
Concepts
Note: Many of the concepts in this example are used in the following example reports:
|
Data Relationships
The data for this report is fetched using two queries, linked together in a master/detail relationship. You will also define a break and two summaries.
Layout
This layout is similar to the layout for the preprinted form report, but in this case you will also link to a TIFF image of your form to use as a guide while adjusting the positions of several fields.
Example Scenario
In this example, you will create a report that prints an invoice for each customer, listing the following information:
You will also learn how to import an image of a preprinted form (in this case, a blank invoice image) and use the tools in the Paper Layout view to print your report on this form.
As you build this example report, you will:
To see a sample invoice report, open the examples folder named invoice
, then open the Oracle Reports example named invoice.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
In this case, it is easier to create the data model and layout separately. Hence, we will create an empty report first, then add the queries, and then create the layout.
To create a blank report:
When you create a report with multiple queries, it is typically easier to create all of the queries with the Data Wizard in the Data Model view. In this report, you will create two queries, linked with a group-to-group data link.
To create the queries:
Q_Order
for the Query name, then click Next.SELECT
statement in the Data Source definition field:This query joins the Orders table to the Customers table for customer information and sales representative information.
Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 33.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Q_Item
and use the following SELECT
statement:This query joins Order items to the Product table for product descriptions.
Your data model should now look something like this:
To add the data link:
To provide the necessary information for the invoice, you need to create summary and formula columns for subtotal amounts, a total amount, and due dates.
To create the invoice summary and formula columns:
This summary is used for subtotal amounts on each page of the invoice.
This summary is used for a total amount of each invoice.
This formula is used to calculate the due date, which is 30 days after today.
Your data model should now look something like this:
invoice_
your_initials
.rdf
.The layout for an invoice report is created by importing an image of the invoice form, then creating desired fields and frames on top of the image. First, you need to set up your layout with the invoice form.
To prepare the invoice report layout:
invdemo.tif
. Position the image at the top left corner of the Paper Layout view.You are now ready to create fields on the invoice image to retrieve desired information for the invoice report. When you print the report, the field values will be correctly positioned on the invoice form. As you complete the steps below, use the figure below as a guide (you can also open the provided example report invoice.rdf
in Reports Builder).
To insert the information for the invoice report:
30 days
.Set Name property to F_FIRST_NAME, Source property to CUST_FIRST_NAME.
Set Name property to F_LAST_NAME, Source property to CUST_LAST_NAME.
Set Name property to F_STREET, Source property to C_STREET_ADDRESS.
Set Name property to F_CITY, Source property to C_CITY.
Set Name property to F_STATE, Source property to C_STATE_PROVINCE.
Set Name property to F_POSTAL, Source property to C_POSTAL_CODE.
Set Name property to F_FIRST_NAME1, Source property to CUST_FIRST_NAME.
Set Name property to F_LAST_NAME1, Source property to CUST_LAST_NAME.
Set Name property to F_STREET1, Source property to C_STREET_ADDRESS.
Set Name property to F_CITY1, Source property to C_CITY.
Set Name property to F_STATE1, Source property to C_STATE_PROVINCE.
Set Name property to F_POSTAL1, Source property to C_POSTAL_CODE.
Set Name property to F_SALES_REP_FNAME, Source property to CUST_FIRST_NAME.
Set Name property to F_SALES_REP_LNAME, Source property to CUST_LAST_NAME.
Set Name property to F_SALES_REP_FNAME1, Source property to CUST_FIRST_NAME.
Set Name property to F_SALES_REP_LNAME1, Source property to CUST_LAST_NAME.
Note: This example assumes that the customer contact is same person as the sales representative. |
Note: Using a frame ensures that other objects will not be pushed by the variable horizontal size of the name fields.
Congratulations! You have successfully created an invoice report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that rank data in different way. By following the steps in this chapter, you can generate the report output shown in Figure 34-1.
Concepts
You can create a report that ranks data by comparing it to a user-specified bind parameter. This enables you to rank data in different ways in the same report; for example, by count and by percentage. You can set the ranking criteria at runtime, or let them default to previously specified values.
Data Relationships
This report requires one query to fetch the data. To rank the data, you'll create the following objects:
Layout
This report uses a tabular layout style, with some modifications.
Example Scenario
In this example, you will create a report that displays the names and total purchases of your top three customers and the top 75% of all customers. Furthermore, you will allow end users of your report to set the ranking criteria (that is, the top x customers and the top y% of all customers) at runtime.
As you build this example report, you will:
To see a sample ranking report, open the examples folder named ranking
, then open the Oracle Reports example named rank.rdf
. For details on how to access it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Summit Sporting Goods (SUMMIT) schema. To download the SQL scripts that install the schema, see "Accessing the Data Sources" in the Preface.
When you are creating a single-query report, such as this one, you can use the Report Wizard to create the data model and layout simultaneously.
To create a data model and layout:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 34.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
Fields | Labels | Width |
---|---|---|
CNAME | Customer Name | 35 |
SUM_AMT | Total Purchases | 15 |
Now that your report has a data model and layout, you can add the logic to control the number of customers displayed. First, you will create two parameters that the user can enter values for at runtime. Second, you will create a group filter that uses the parameters to control which data is included.
To create parameters and add a group filter:
Note: You can enter this code by copying and pasting it from the provided text file called rank_code.txt . This code is for the Group Filter. |
This filter increments the counter by 1 each time a record in G_CNAME is fetched, then compares the counter's value to the specified cutoff. When the counter exceeds the cutoff, no more records are fetched.
Tip: Notice that, if the Paper Design view is still open while you add this logic, the report now returns no records in the Paper Design view. To fix this issue, you should display one of the other views (for example, the Data Model view) and then come back to the Paper Design view. You will be prompted by the Runtime Parameter Form to enter values for the two parameters, INCR_CNT and CUTOFF_CNT. |
rank
_your_initials
.rdf
.As a way for users to quickly tell the number of customers displayed in the list, you need to display the value of CUTOFF_CNT in the report. To perform this task, you will create a boilerplate text object that references the parameter.
M_G_CNAME_GRPFR
.Note: You can also use the Find field in the Object Navigator to locate specific objects. When you select an item in the Object Navigator while the Paper Layout view is displayed, the corresponding object is selected in the Paper Layout view. |
-$NNN,NN0.00
By default, both of your user parameters appear in the Runtime Parameter Form. In reality, you only want users to set CUTOFF_CNT. You do not want them to be able to set INCR_CNT (the amount by which your counter is increased for each record). To prevent users from seeing INCR_CNT on the Runtime Parameter Form, you will build your own Parameter Form.
To create a Parameter Form:
# of Top Customers:
Tip: As an additional exercise, you could now change the Initial Value property of CUTOFF_CNT to see its effect on the Runtime Parameter Form. |
Another way to rank customers is by percentage of total sales. The idea is the same as ranking by count, but with an important difference. Since you need to fetch all of the data in order to compute a running percent of total summary, you don't want to use a group filter to weed out data. You need to use a format trigger on the repeating frame to compare the running total to your cutoff parameter.
To fetch the data for the percentage calculation:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
To create a parameter for the percentage cutoff:
To create a second layout for the list of customers by percentage:
Fields | Labels | Width |
---|---|---|
CNAME2 | Customer Name | 35 |
SUM_AMT2 | Total Purchases | 15 |
To add the logic for the percentage cutoff:
R_G_CNAME2
in the Find field to locate that repeating frame.Note: You can enter this code by copying and pasting it from the provided text file called rank_code.txt . This code is for the Percentage Cutoff. |
To update the Parameter Form for the new percentage parameter:
Top Percentage (%):
5
.80
.Congratulations! You have successfully created a ranking report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include a simple table of contents and index.
Note: Generating a table of contents or index is not supported for matrix reports. |
By following the steps in this chapter, you can generate the report output shown in Figure 35-1 and Figure 35-2.
Concepts
Note: Although you can use SRW.SET_FORMAT_ORDER to change the order in which the report is formatted, the report will still display the Header section first, then the Main section, and finally the Trailer section. You can use SRW.SET_FORMAT_ORDER to simply change the formatting order, but not the display order of the report sections. |
For information on creating a multilevel table of contents, refer to Chapter 36, "Building a Paper Report with a Multilevel Table of Contents".
Example Scenario
In this example, you will generate a list of all the e-mail addresses for your customer database, which contains thousands of records. First, you want to categorize the customers (in this case, by country), then generate a table of contents so you can easily find the e-mail address for the desired customer. Then, you will learn how to create an index for your report.
As you build this example report, you will:
To see a sample table of contents and index report, open the examples folder named tocindex
, then open the Oracle Reports example named toc_index.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Sales History sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to create a basic table of contents for a large, multipage report. The table of contents will look like the following:
The steps in this section will show you how to create a table in the database that will hold the page numbers for the records you want to list in the table of contents. If you are not sure whether you have the privileges to create a table in the database, contact the database administrator.
To create a table in the database:
sqlplus
.sh/sh@
database_name connect string).You should see a notification that the table has been created.
The steps in this section will show you how to build a simple group above report in Reports Builder. This group above report will display the country name, then the customers and customer e-mail addresses under each country name. The table of contents you create will then be based on the country name in this report.
To create a simple group above report:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 35.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
toc_
your_initials
.rdf
. You have now created the data model and the basic layout for your report.The steps in this section will show you how to create two triggers. The first trigger will use the SRW.SET_FORMAT_ORDER built-in procedure to format the Main section of the report first, then the Header and Trailer sections. The second trigger will fetch the number of the page on which each country name displays, and place that information into the table you created in Section 35.2.1, "Create a table in the database to hold the TOC data".
An After Parameter Form trigger is a function that executes after the parameter form is executed. In this section, you will set the trigger to change the order of the report execution, so that the Main section runs first.
To create an After Parameter Form trigger:
TOC_
your_initials
), expand the Report Triggers node.Note: You can also copy and paste the code from the provided file, toc_index_code.txt . |
In this section, you will create a format trigger based on the field F_COUNTRY_NAME
. This field displays the country name. This format trigger will fetch the page number for each country name, so that the table of contents will enable the user to navigate to various parts of the report based on the name of the country.
To create a format trigger:
Tip: If you cannot find this field, use the Find field at the top of the Object Navigator. |
Note: You can also copy and paste this code from the provided file, toc_index_code.txt . |
The steps in this section will show you how to create a second query in the data model with a formula column that calculates the page range for the data under each country name. This query will fetch the information from the database table you created in Section 35.2.1, "Create a table in the database to hold the TOC data". You will later create a tabular layout to display this information in your table of contents.
To create a second query with a formula column:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
TOC_pages
, and the Datatype property to Character.Note: You can also copy and paste this code from the provided file, called toc_index_code.txt . |
The steps in this section will show you how to create a tabular report block in the Header section of your report. This report block will display the headings in the table of contents (in this example, the country name), and the page range where the information can be found in the report.
To create a tabular report block in the Header section:
Your report block displays in the Paper Layout view:
To run your report to paper:
Note: To generate the table of contents (TOC), you must click the Run Paper Layout button. If you click the Paper Design view button, the change of format order will not take effect, thus the TOC will not be generated. |
The table of contents displays on the first page of the report, and looks something like the following:
You can navigate to various pages in your report to view the data for each country. For example, when you navigate to page 1, you will see the e-mail addresses for the customers in Argentina:
Note: At this point, you can compare your report against the example file we have provided, toc.rdf . First, compile the PL/SQL by choosing Program > Compile > All, then run the report to paper. |
For information on creating a multilevel table of contents, see Chapter 36, "Building a Paper Report with a Multilevel Table of Contents".
In this section, you will create an index that displays at the end of your report. This index will simply display the customer's name and the page number on which the name appears. This indexing technique is useful when users want to find a specific customer's name, but are not sure what category (for example, country) to reference.
The steps in this section will show you how to create a table in the database that will hold the page numbers for the items you want to list in the index. If you are not sure if you can create a table in the database, contact the database administrator.
To create a table in the database:
You should see a notification that the table has been created.
The steps in this section will show you how to create a format trigger based on the customer's last name. You will use the SRW.GET_PAGE_NUM built-in function to find the page number for the current customer, and insert that page number into the table you created in the previous section.
To create a format trigger:
toc_
your_initials
.rdf
.Note: You can enter this code by copying and pasting it from the provided text file called toc_index_code.txt . |
toc_index_
your_initials
.rdf
.The steps in this section will show you how to add a query to your data model that will retrieve the individual customer names and the page numbers for your index.
To add the query:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
The steps in this section will show you how to display the index information in the Trailer section of your report.
To create a report block in the Trailer section:
Click the Run Paper Layout button in the toolbar. The index displays on the last pages of the report. We chose page 2402
, which (in our example) looks like the following:
Note: To generate the table of contents (TOC), you must click the Run Paper Layout button. If you click the Paper Design view button, the change of format order will not take effect, thus the TOC will not be generated. |
Note: The data on page 2402 in your report may not appear the same as ours, depending on the amount and type of data you have in the schema. |
Congratulations! You have successfully created a report with a table of contents and an index. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include a multilevel table of contents.
Note: Generating a table of contents is not supported for matrix reports. |
By following the steps in this chapter, you can generate the report output shown in Figure 36-1 and Figure 36-2.
Concepts
Note: Although you can use SRW.SET_FORMAT_ORDER to change the order in which the report is formatted, the report will still display the Header section first, then the Main section, and finally the Trailer section. You can use SRW.SET_FORMAT_ORDER to simply change the formatting order, but not the display order of the report sections. |
For more information on the SRW built-in package in Oracle Reports, refer to the Oracle Reports online Help.
Example Scenario
In this example, you have a large paper catalog that lists all the clothing products a company sells. This catalog simply lists all the items in a simple report. Since the product line has become much larger, the catalog report now exceeds 700 pages. You will create a multilevel table of contents that sorts the clothing by department (for example, Boys, Girls), then lists each item under each category.
As you build this example report, you will:
To see a sample report with a multilevel table of contents, open the examples folder named multileveltoc
, then open multilevel_toc.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 36-1.
Table 36-1 Example report files
File | Description |
---|---|
| The source file that contains a basic paper layout and data model for your report. |
| The final RDF version of the report with a multilevel table of contents. |
| The various SQL statements you will use in this report. |
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Sales History sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to create a table in the database that will hold the page numbers for the main and sub-categories in the report. If you are not sure if you can create a table in the database, contact the database administrator.
To create a table in the database:
sqlplus
.sh/sh@
database_name connect string).You should see a notification that the table has been created.
The steps in this section will show you how to create two triggers. The first trigger will use the SRW.SET_FORMAT_ORDER built-in procedure to format the Main section of the report first, then the Header and Trailer sections. The second trigger will fetch the page number for each category, sub-category, and record, and place that information into the table you created in Section 36.2, "Create a table in the database to hold the TOC data".
An After Parameter Form trigger is a function that executes after the Parameter Form is executed. In this section, you will set the trigger to change the order of the report execution, so that the Main section formats first.
To create an After Parameter Form trigger:
multilevel_source.rdf
.Note: You can also copy and paste the code from the provided file, multilevel_code.txt . |
multilevel_
your_initials
.rdf
.In this section, you will create a format trigger based on the field F_PROD_SUBCATEGORY. This field displays the sub-category, which is the product name. This sub-category falls under the main category, which is the product department. This format trigger will fetch the page number for each product name, so that the table of contents will enable the user to navigate to various parts of the report based on the department name, then the product name.
To create a format trigger:
Tip: If you cannot find this field, use the Find field at the top of the Object Navigator. |
Note: You can also copy and paste this code from the provided file, multilevel_code.txt . |
The steps in this section will show you how to create a second query in the data model that retrieves the information stored in the table you created in Section 36.2, "Create a table in the database to hold the TOC data". This query will fetch the data necessary for generating the table of contents in the Header section of your report.
To create a query:
SELECT
statement:Note: You can enter this query in any of the following ways:
|
Subcategory_Page
Your data model should now look like this:
The steps in this section will show you how to create a group above report block in the Header section of your report. This report block will display two levels of headings in the table of contents. You will also add a field to your layout to display the page number where each heading is found in report.
To create a group above report block in the Header section:
Your report block displays in the Paper Layout view:
The steps in this section will show you how to make a few modifications in the Paper Layout view and run your report.
To modify and run your report to paper:
Note: To generate the table of contents (TOC), you must click the Run Paper Layout button. If you click the Paper Design view button, the change of format order will not take effect, thus the TOC will not be generated. |
The table of contents displays on the first page of the report, and looks something like the following:
In this example, under the BOYS product department, the SHIRTS sub-category starts at page 22 and the next sub-category, SHOES, starts at page 38. If you move to any page between page 22 and 38 in the report, you will see the SHIRTS sub-category.
Note: The page numbers may differ depending upon the data used in your report. |
You can navigate to various pages in your report to view the data for each department and sub-category.
Note: At this point, you can compare your report against the example file we have provided, multilevel_toc.rdf . First, compile the PL/SQL by choosing Program > Compile > All, then run the report to paper. |
Congratulations! You have successfully created a report with a multilevel table of contents. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
Oracle Reports enables you to deliver a single report to multiple destinations simultaneously. By taking advantage of this feature, you can create a single report, then send it in any format (layout driven formats, such as PDF or HTML, as well as data model driven formats, such as XML or delimited) to multiple destinations.
In this example, you will modify a simple report we have provided to burst each group to a separate report. You will then modify a sample distribution XML file to send an e-mail to each destination with an attachment based on the separate reports. You will also send multiple e-mails to the same e-mail address with a single attachment (the entire report).
Oracle Reports enables you to deliver a single report to multiple destinations simultaneously. Using the distribution feature, you can set up your report to be distributed to an e-mail destination, a portal, a printer, or anywhere else when the report is run. This feature also enables you to improve performance, since you fetch the data only once for many different formats and destinations. Using distribution also reduces your maintenance overhead because you need only one job request to publish the report to multiple destinations. You can refine this further by sending the Header section to some recipients, the Main section to others, and the entire report to an entirely different recipient list.
For more information on bursting and distribution, see "Creating Advanced Distributions" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual, available .
Example Scenario
In this example, you are the report developer for a manufacturing company who needs to deliver monthly information to its warehouses. You will modify an existing report to burst on each warehouse ID, creating separate PDF reports for each warehouse. You will then edit the distribution XML file we have provided to e-mail each report as an attachment to the corresponding warehouses.
As you build this example report, you will:
distribution.xml
file.To see a sample distribution report, open the examples folder named distribution
, then open source\inventory_report_dist.rdf
for report you will distribute, or result\inventory_report_dist.rdf
for the report you will burst. For details on how to open these reports, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 37-1.
Table 37-1 Example report files
File | Description |
---|---|
| The XML file that controls the distribution properties for your report. |
| The source report you will modify to burst and distribute. |
| The modified report you will burst and distribute. |
| The PDFs that are generated when you distribute and burst your report. |
Note: The distribution.xml file we have provided for this example is specific to building this example report. A more comprehensive distribution.xml is shipped with Oracle Reports in the ORACLE_HOME \samples\demo directory; you can reuse this file for your own purposes so that you do not have to create one from scratch. |
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
For the purposes of this chapter, we have provided an RDF file you can use for bursting. In this section, you will set up the report for bursting by deleting the repeating frame and setting the Repeat On property of the Main section, so that the data bursts on each warehouse ID. This way, you can distribute the data for each warehouse as a report to the corresponding warehouse e-mail ID.
Note: For more information on the Repeat On property, refer the Oracle Reports online Help. |
To set up the report for bursting:
inventory_report_dist.rdf
.The report displays in the Object Navigator.
See Also: For more information on frames and repeating frames, refer the Oracle Reports online Help. |
inventoryreport_dist_
your_initials
.rdf
.You have set up your report to burst based on the warehouse ID.
The Oracle Reports distribution XML file enables you to specify the details of your distribution. For example, if you are distributing through e-mail, you can specify such details as the addressee, the reply to address, and the subject.
In this section, you will learn how to modify a distribution XML file. We have indicated locations where you need to enter your own information to make the distribution work.
When you want to distribute a report, you need to either:
inventory_report_dist.rdf
) and your distribution XML file (for example, distribution.xml
) are in the same directory.OR
Note: For more information on distribution, see the chapter "Creating Advanced Distributions" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
To edit the distribution XML file:
distribution.xml
file we have provided.<YourFilePath>
, and replace it with the location of where your resulting PDFs will be stored.Example: Replacing the placeholder text with:
changes the path to:
Using this complete path places the resulting PDF files in d:\temp
.
<OriginEmailAddress>
, and replace it with the sender's e-mail address.<OriginEmailAddress>
.<DestinationEmailAddress>
, and replace it with the recipient's e-mail address.<DestinationEmailAddress>
.Note: For this example, we show you how to send e-mails to static e-mail addresses. However, if you want to send the report to various e-mail destinations, you must create a recipient field in your data model. Then, in the ex2 section of distribution.xml , replace the placeholder text <DestinationEmailAddress> with &<recipient> . You can then delete the first section of the distribution.xml file (marked ex1 ). |
inventoryreport_dist_
your_initials
.rdf
.Note: It is not required that you save the XML file to the same directory where your RDF is located, as you can specify the location of the XML file at runtime. Either distribution.xml and RDF must be in Reports Path, or provide the complete path in the command line URL. |
You have finished customizing the distribution XML file to send a single e-mail to corporate headquarters with all of the individual warehouse reports, and multiple e-mails with a single attachment each to the individual warehouses.
You can distribute the report using a Web browser. Type the following command in the Location field of your browser:
where
your_path
is where your RDF file and the distribution.xml
file is located. your_login_ID
is your login information for the sample schema you have used with the sample RDF.
The SMTP mail server is set up during the installation process. If you did not specify a server during installation, you can set up the mail server manually before distributing your report to an e-mail destination. You can specify the outgoing mail server using pluginParam
in the server config file.
For more information on setting up the mail server, refer to the chapter "Configuring Oracle Reports Services" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
Running the report creates a file for each warehouse based on the warehouse ID in the specified directory. When the report is distributed, a single e-mail is sent to one address with all of these files attached to the e-mail.
If you set up the distribution.xml
file for multiple e-mail addresses, each warehouse (or each e-mail address) would be sent a single e-mail with a single attachment file that includes the report for that warehouse.
Congratulations! You have distributed a report. You now know how to:
distribution.xml
file.For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include multibyte characters. By following the steps in this chapter, you can generate the PDF report output shown in Figure 38-1 and Figure 38-2.
Concepts
Note: You must have Acrobat Reader installed on your computer to view PDF output. |
Tip: Make sure that you have the necessary licenses for the fonts before embedding them in your output PDF file. |
Note: For more information, see the chapter "Using PDF in Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
Example Scenario
In this example, you have an international business with offices in the United States, Japan, and Poland. In the organization, local managers have control of the inventory of the warehouses. Offices in different locations want to print the list of products in their preferred language. You will create a report in PDF format that contains multibyte characters for the Web and paper output.
As you build this example report, you will:
To see a sample multibyte character set report, open the examples folder named multibyte
, then open the Oracle Reports example named multibyte_utf8.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator. You must also have Acrobat Reader installed on your system.
Note: Due to some limitations of Oracle Reports regarding use of the UTF-8 character set and multibyte fonts on UNIX, it is recommended to build this report only on Windows. To deploy a multibyte report on UNIX, refer the chapter "Resolving Cross-Platform Porting Issues" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
Perform the following set up activities before you run the report:
KEY_OH
in the ORACLE
key, set NLS_LANG
to AMERICAN_AMERICA.UTF8
.Tip: Back up your registry before editing it as working with registry keys can cause the system to become unstable. |
uifont.ali
file and edit it to specify the TrueType font file name. Type "Arial Unicode MS" = "ARIALUNI.TTF"
under the [PDF:Subset]
section. After including the line, the uifont.ali
file should look like:Note: On Windows and UNIX, the uifont.ali file is located in ORACLE_INSTANCE \config\ . The uifont.ali file defines the font aliases used by Oracle Reports and is extremely useful for cross-platform development. This file enables you to define which fonts to substitute when a particular font is unavailable. For more information, see the "Font Related Features" section in the chapter "Using PDF in Oracle Reports" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
Oracle
key and IDS_HOME
, add the location of the ARIALUNI.TTF
TrueType font file to the value of REPORTS_PATH
. For example, C:\WINNT\Fonts
.Note: Install the TrueType font file ARIALUNI.TTF into C:\WINNT\Fonts , if it is not already there. |
When you create a report, you can use either the Report Wizard to assist you or create the report manually.
To build the report in this example, you will use the Report Wizard. Using the wizard you will specify the layout, style, fields, and template details for the report. You will also provide the SQL query that contains the condition with a runtime user parameter. This parameter allows users to specify the language in which they want the report output printed.
To create a simple report:
Product List
.Note: You can enter this query in any of the following ways:
|
where
language_id = :p_lang_id
, after the FROM
clause in the query. This adds the where clause to the query definition The where
clause restricts data based on the language selected by the user at runtime.Your query should now look like this:
Note: The expression, :p_lang_id , when prefixed with a colon is treated as a parameter. If the parameter does not exist, Oracle Reports Builder creates the parameter. From here on, you can access this parameter in the User Parameters section under the Data Model node in the Object Navigator. |
Oracle Reports Builder displays the following message to indicate that an additional parameter is created:
Oracle Reports Builder displays the Runtime Parameter Form because you referenced a user parameter.
JA
, and click the Run Report button to execute the report.The report output is displayed in Paper Design view. It should look something like this:
Tip: If you do not see any results, make sure that the value JA is typed in capital letters so that data is retrieved from the database for the specified condition. |
You will not see any Japanese characters yet since a UTF8 TrueType font has not been selected.
multibyteutf8_
your_initials
.rdf
.Note: When designing a report, it is good practice to save it frequently under a different file name as a precautionary measure. Then, if you need to revisit some of the changes or if you generate an error, you can go back to the previously saved file and make revisions from that point. |
You have successfully created and executed the report. Next, you have to change the font to a UTF8 multicharacter set TrueType font to see the characters of the language chosen in the report output.
To change the font to a multicharacter TrueType font:
The report is executed and the Paper Design view of the report output is displayed in Japanese characters. It should look something like this:
To run the same report in another language:
To run the same report again with a different runtime parameter and see the output in another language, perform the following steps:
PL
, and click the Run Report button to run the report.The Paper Design view of the report output is displayed with Polish characters. It should look something like this:
Oracle Reports Builder supports multibyte characters in the PDF format. By generating the PDF file of your report, you have the advantages of being able to:
Tip: Make sure you perform the following steps before you generate the file:
See Section 38.1, "Prerequisites for This Example" for more details. |
To generate the PDF file:
multibyteutf8_
your_initials
.pdf
.PL
(exactly as shown), and click the Run Report button to execute the report.The Report Progress dialog box is displayed and provides the print status of the PDF output. When the PDF is created, this dialog box disappears.
multibyteutf8_
your_initials
.pdf
) and double-click to open the file.It should look something like this:
Note: You can open the PDF file on any computer and it will look exactly the same, without installing any Unicode font. This is because the PDF file includes the font used in the report. Notice the default rough visual appearance of the characters in the PDF output. You can smooth the characters by using "smoothe lineart" setting in Acrobat Reader. |
Congratulations! You have successfully created a report to support any character set in your enterprise. You have used Oracle Reports Builder to generate a portable PDF file using font subsetting.
You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
The chapters in this Part provide steps to build reports that use PL/SQL code or Java. You can include PL/SQL, PL/SQL libraries, REF CURSOR
s, and barcodes in your reports, and build JSP-based Web reports that include a Parameter Form.
A PL/SQL report uses an external PL/SQL library and PL/SQL within a report to modify formatting and to perform calculations on column values. For example, you can use a PL/SQL procedure in a format trigger to include a space between records similar to a break report or to calculate the total compensation for each employee.
A paper report with REF CURSOR
s helps manage queries. (A REF CURSOR
is a PL/SQL cursor datatype that you can reference from within a PL/SQL query.) For example, if you already have numerous queries built and you want to reuse those queries in your reports, you can use a REF CURSOR
in your report data model to access those queries.
A JSP-based Web report can be modified by adding a Parameter Form to accept user input at runtime that will determine what data will display in the report.
A barcode can be added to a paper or Web report by using the barcode JavaBean. In Oracle Reports Builder, the barcode JavaBean automatically generates a barcode for you based on the data you specify. For example, you can use the barcode to track shipping orders by generating a barcode based on the shipping order code.
Using Oracle Reports and the standards defined in the Web Accessibility Guidelines, you can create a report that produces output that is compatible with assistive technologies such as screen readers. Oracle Reports provides properties and tags to support this effort.
In this chapter, you will learn about the new graph types in Oracle Reports 11g Release 1 (11.1.1) and new features supported by Oracle Reports Builder.
The Graph Wizard provides an easy way for you to add a wide variety of graphs to both paper-based and JSP-based web reports. Oracle Reports Builder uses the information you specify on each page of the wizard to create an XML definition that describes the graph and renders to resulting look-and-feel of the graph at runtime.
Table 39-1 details the new graphing functionality in Oracle Reports 11g Release 1 (11.1.1), along with the equivalent 10g Release 2 (10.1.2) functionality:
Table 39-1 11g Functionality vs. 10g Functionality
11g New Features and Enhancements | Equivalent 10g Functionality |
---|---|
New graph types: New funnel, enhanced pie and curved line graph types allow for more variety in graphing.
| N/A |
Enhancements for existing graph types: Support for number formatting in the Graph Wizard, and plotting irregular time periods on the time-axis.
| Restrictions on plotting time data. |
Scalable Vector Graphic (SVG) image support. SVG provides for high resolution and smaller file size in graph output. Graph image output scales up better without losing resolution. | Support for only PNG, JPG, and GIF output formats. |
New Chart Styles: Support for new pre-defined styles in style panel of Graph Wizard. | Support for only a few chart styles. |
While the Graph Wizard enables you to create and edit the attribute values and layout of a graph, there are additional attributes that are not exposed through the Graph Wizard. To customize your graph XML definition beyond the scope of the Graph Wizard, you can directly edit the XML in the graph's Graph Settings property (for paper-based reports), or in the Web Source view (for JSP-based Web reports). The full list of attributes available is defined in the DTD file, graph.dtd
.
Note: The graph.dtd is available in the following locations:
|
Usage notes
ORACLE_HOME
. However, this is not a supported configuration, and Oracle will not fix bugs that result from this configuration.Primary Graph Types
For most graphing needs, the following primary graph types will provide the best means to represent data:
Secondary Graph Types
These are special usage or less common graphs that are associated with particular data types or ways to display unique cases of data:
See Also, Section 39.3, "New Graph Types"
Access
To display the Graph Wizard for paper reports:
To display the Graph Wizard for JSP-based Web reports:
Re-entrancy
To re-enter the Graph Wizard for an existing graph in paper reports:
To re-enter the Graph Wizard for an existing graph in JSP-based Web reports:
In the Web Source view, place your cursor anywhere between the <rw:graph
> and </rw:graph
> tags, then choose Edit > Settings.
Using the Graph Wizard
For help on the fields on any tab page of the wizard, click Help at the bottom of the tab page.
See also
Section 4.9.8.2, "Adding a graph"
Section 4.9.8.3, "Editing a graph"
Section 4.9.8.4, "Adding a graph hyperlink"
Oracle Reports provides a convenient way for you to add a wide variety of graphs to both paper-based and JSP-based Web Reports.
Oracle Reports 11g Release 1 (11.1.1) supports the following features:
With the new graph types and features, Reports Builder provides the following benefits:
Plotting Irregular Time Periods
Oracle Reports 11g Release 1 (11.1.1) provides support for plotting irregular time periods on time axis. For more information see Figure 39-1, "Plotting Irregular Time Period".
New Chart Styles
Oracle Reports 11g Release 1 (11.1.1) supports the following new chart styles:
For more information, see Figure 39-2, "New Chart Styles".
Oracle Reports 11g Release 1 (11.1.1) supports the following and graph types:
A funnel graph is a visual representation of data related to steps in a process. As the value for a given step of the funnel approaches the quota for that slice, the slice fills. A funnel renders a three-dimensional chart that represents the target and actual values, and levels by color. For more information, see Figure 39-3, "Funnel Graph".
A curved line or fit-to-curve is a graph in which data is represented as a curved line, as a series of data points, or as data points that are connected by a line. Curved line graphs require data for at least two points for each member in a group. For more information, see Figure 39-4, "Curved LIne Graph".
A pie graph represents data as sections of one or more circles, making the circles look like sliced pies. With the enhanced pie, you can include any combination of data value, percent, and text label.
In this chapter, you will learn about reports that include PL/SQL. By following the steps in this chapter, you can generate the report output shown in Figure 40-1.
Concepts
Data Relationships
This report uses one query. You will add a function stored in an external library, a report-level function, two formula columns, and a parameter governing the number of records to display before inserting a space.
Layout
This report uses the tabular layout style, with minor modifications.
Example Scenario
In this example, you will use an external PL/SQL library and PL/SQL within a report to modify formatting to add spacing between records, and calculate the total compensation for each employee. You will manually create a query in the Data Model view, then modify the layout of the report in the Paper Layout view. You will create formula columns, a summary column, and a format trigger that uses a summary column and a user parameter.
As you build this example report, you will:
To see a sample PL/SQL report, open the examples folder named plsql
, then open the Oracle Reports example named plsql.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface.
To build the example in this chapter, you must have access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to create a new PL/SQL library, then create a function that will live in this library.
To create the library:
A new library displays in the Object Navigator below your report name, under the PL/SQL Libraries node.
BONUS_PAY
.Note: You can enter this code by copying and pasting it from the provided text file called plsql_code.txt . |
Your new function displays in the Object Navigator.
bonus.pll
, make sure File System is selected, then click OK.bonus.pll
.Note: If you saved bonus.pll to another directory, you can click Browse to find it on your file system. Just make sure you have selected File System before browsing. |
Note: If you attach a library whose name also includes a path, Reports Builder will inform you that the path names are not portable, and will give you the option of deleting the path. If you choose to continue using a path specification, Reports Builder will only look in that specific location for the library. So, if you move the library, Reports Builder will not be able to find it. If you delete the path, Reports Builder will use a standard search path to locate the library if it is moved. |
The objects in your Object Navigator should now look something like this:
plsqlreport_
your_initials
.rdf
.The steps in this section will show you how to create the query and the formula columns that will define the report and call the code in the bonus.pll external PL/SQL library you created.
We recommend that you create the objects in the order described, as some of the formula columns depend on the functions, and so on.
The steps in this section will show you how to create the query that will retrieve the data necessary for this report.
To create the query:
SELECT
statement in the Data Source definition field:Note: You can enter this query in any of the following ways:
|
Note: If you are not already connected to a database, you will be prompted to connect to the database when you click Query Builder or Next. Ensure that you connect to a database that has the appropriate schema for this example. Section 40.1, "Prerequisites for This Example" describes the sample schema requirements for this example. |
The steps in this section will show you how to create a formula column that will calculate the salary bonus for each employee using the PL/SQL function.
To create the BONUS formula column:
Note: You can enter this code by copying and pasting it from the provided text file called plsql_code.txt . This code is for the Bonus Formula Column. |
Note: If there are compilation errors, compare your code closely against the code we have provided. |
The steps in this section will show you how to write a function that returns the total compensation for each sales representative (the values of columns SALARY plus COMM plus BONUS), as well as other employees (SALARY plus BONUS).
FINAL_CALC
.Note: You can enter this code by copying and pasting it from the provided text file called plsql_code.txt . This code is for Final Calc. |
The new function, FINAL_CALC, now displays in the Object Navigator:
The steps in this section will show you how to create another formula column that will calculate the total compensation. The value calculated by the report-level function FINAL_CALC will be assigned to the column TOTAL_COMP. If you are not sure how to create a formula column, refer to Section 40.3.2, "Create a formula column that calculates bonuses".
To create the TOTAL_COMP formula column:
Note: You can enter this code by copying and pasting it from the provided text file called plsql_code.txt . This code is for the Total Comp Formula Column. |
Now that you have created the necessary formula columns and functions, you can create the layout for your report.
To create the report layout:
Note: If the fields do not display in the correct order, simply click the field name and drag the field to the correct position in the list. |
Fields | Labels |
---|---|
COMMISSION_PCT | Commission |
TOTAL_COMP | Total Compensation |
Tip: You can watch the fields in the Object Navigator as you choose Layout > Move Backward. When you see the two fields are sub-nodes of M_NAME, stop. |
When you are done, the Object Navigator should look like this:
Your report should now look something like this:
To make the report more readable, you can add space between a certain number of records. To do so, you first create the parameter that determines the number of records between which the space will display. Then, you create a summary column in the data model that counts the number of records. You will then modify the paper layout of your report so that the vertical elasticity is variable. Finally, you will create a format trigger that will display the space between the user-determined number of records.
The parameter you will create in this section will determine how many records are displayed before an extra space is printed. Since this parameter is a user parameter, the user can change this value at runtime.
To create a user parameter:
Note: By giving the user parameter an initial value, the user can simply run the report without changing the parameters, and a space will display between every five records. |
The user parameter now displays in the Object Navigator:
In this section, you will create a summary column in the data model that counts the number of employee records. This information will then be used by the format trigger to determine where to add extra space.
To create a summary column:
To allow Reports Builder to insert the vertical spacing, you must modify the layout of your report.
To add vertical elasticity:
Note: If you cannot find the repeating frame in the Paper Layout view, you can click R_G_FIRST_NAME in the Object Navigator. The associated repeating frame will be selected in the Paper Layout view. |
The following image shows the new layout with the invisible rectangle:
Now that you have adjusted the layout, you can create a format trigger based on the new boilerplate rectangle you created in the previous section. This format trigger will display this space after every set number of records, determined by the user parameter.
To create a format trigger on the boilerplate rectangle:
Note: You can enter this code by copying and pasting it from the provided text file called plsql_code.txt . This code is for the Format Trigger. |
Now that you have added space and created your format trigger, your report should display with space after every five records (or the number of records you specify in the Parameter Form).
To run your report:
Your report displays in the Paper Design view, and should look something like this:
Congratulations! You have successfully built a report that uses an external PL/SQL library to calculate employee bonuses, which you can now use in other reports by simply referring to it. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include the PL/SQL datatype REF CURSOR
. By following the steps in this chapter, you can generate the report output shown in Figure 41-1.
Concepts
REF CURSOR
is a PL/SQL datatype that you can use in a query to fetch data. Each REF CURSOR
query is associated with a PL/SQL function that returns a strongly typed REF CURSOR
. The PL/SQL function must ensure that the REF CURSOR
is opened and associated with a SELECT
statement that has a SELECT
list that matches the REF CURSOR
type. You base a query on a REF CURSOR
when you want to:REF CURSOR
s, you receive the added benefits that go along with storing program units in the Oracle database.REF CURSOR
s. For example, if you already have numerous queries built and you want to reuse those queries in your reports, you can simply use a REF CURSOR
in your report data model to access those queries.SELECT
statement in the REF CURSOR
query of the report. It also shows that you can store the SELECT
statement in a package in the database. Then, from the report, you can call the database package allowing you to reuse the package in many reports.Example Scenario
In this example, you will learn how to use REF CURSOR
s in Reports Builder to create a detailed paper report showing information about employees and the job position they hold in each department. You will use the Data Model view to create a multiquery data model, and then use the Report Wizard to create the report layout. You will make fairly extensive manual refinements in the Data Model view.
As you build this example report, you will:
REF CURSOR
s.REF CURSOR
s.REF CURSOR
types.To see a sample report with REF CURSOR
s, open the examples folder named refcursor
, then open ref_emp68.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 41-1.
Table 41-1 Example report files
File | Description |
---|---|
| The different stages of the RDF. You can refer to these files as you complete each section of this chapter. The file ref_emp68.rdf is the final report. |
| The PL/SQL code you will write in this chapter. You can use this file as a reference point to make sure your code is accurate, or you can simply copy and paste from this file into Reports Builder. |
To build the example in this chapter, you must have the example files provided, as well as access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
Note: The use of REF CURSOR queries in Oracle Reports 11g Release 1 (11.1.1) requires that your database version is 10.1.0.5 (for 10.1) or 10.2.0.2 (for 10.2) or higher.Interoperability between a 11g Release 1 (11.1.1) database or Oracle Forms Services client and a 10.1/10.2 database requires a minimum patchset level of 10.1.0.5 (for 10.1) or 10.2.0.2 (for 10.2). An attempt to reference a 10.1 or 10.2 PL/SQL unit or view under the following circumstances will fail with a
|
To create a REF CURSOR
query, you first create a package spec that defines the REF CURSOR
. Then you create a query that uses the REF CURSOR
. The steps in this section will help you create package specs that define REF CURSOR
s.
To define a REF CURSOR type:
concl_cv
in the Name field.This package spec does two things:
REF CURSOR
that returns the data in the format described by the record.Note: You can open the provided file refcursor_code.txt to copy and paste the code into the PL/SQL Editor. |
Note: You can open the provided file refcursor_code.txt to copy and paste the code into the PL/SQL Editor. |
ref61_
your_initials
.rdf
.Note: It is good practice when you are designing your report to save it frequently under a different file name. If you generate an error or if you do not like some of the changes you made, you easily can go back to the previously saved file and make revisions from that point. |
After creating package specs that define the REF CURSOR
s, you are ready to define the queries, as described in this section.
To create a REF CURSOR query:
REF CURSOR
query.Note: You can open the provided file refcursor_code.txt to copy and paste the code into the PL/SQL Editor. |
REF CURSOR
query object (QR_1) to display the Property Inspector.Tip: It is usually a good idea to give objects meaningful names, particularly when building a report with many objects. Later when building the layout, it is helpful to have queries and groups with meaningful names. |
Note: You can open the provided file refcursor_code.txt to copy and paste the code into Reports Builder. |
The Data Model should look similar to the following:
ref_62_
your_initials
.rdf
.Note: You can open the provided file ref_emp62.rdf and display the Data Model to compare your results. |
In this section, you will rename some of the objects in the data model so that they have more meaningful names. You will also create a break group.
To refine the data model:
Note: You can open the provided file ref_emp63.rdf and display the Data Model to compare your results. |
ref_63_
yourinitials
.rdf
.Currently, the queries that you have created are unrelated. To create relationships between them, you need to create group-to-group data links. The steps in this section will help you create the links.
To create links between REF CURSOR
queries:
WHERE
clause of the SELECT
statement to specify which columns are being used as primary and foreign keys:After from job_history
, add the following code:
Be sure that the semicolon (;
) now follows the WHERE
clause.
Note that :department_id
is a bind variable referring to the DEPARTMENT_ID
in G_DEPARTMENT_ID
.
WHERE
clause to the SELECT
statement:Insert your cursor between FROM EMPLOYEES
and the semicolon (;
), and press ENTER or RETURN to create a new line, then add the following code:
Be sure that the semicolon (;
) now follows the WHERE
clause.
Note that :employee_id
is a bind variable referring to the EMPLOYEE_ID
column in G_EMPLOYEE_ID
.
Note: You can open the provided file ref_emp64.rdf and display the Data Model to compare your results. |
ref_64_
your_initials
.rdf
.Now that your queries are complete and linked, the steps in this section will help you to create columns to summarize the data.
To add summary columns:
You have now created a summary that counts up the number of employees. You will not use the summary in this report's layout, but you will use it as the source for other, more interesting summaries later.
Table 41-2 Summary Characteristics
Create in Group | Name | Function | Source | Reset At |
---|---|---|---|---|
G_conlabel | CS_conlabel_classcount | Sum | CS_classcount | G_conlabel |
G_department_id | CS_port_count | Sum | CS_conlabel_classcount | G_DEPARTMENT_ID |
You may not understand these summaries now. Their purpose will become clearer when you create the report layout and preview the live data.
Your data model should look similar to the following:
Note: You can also compare your results to the file we have provided, called ref_emp65.rdf . |
ref_65_
your_initials
.rdf
.Now that you have a working data model, the steps in this section will help you to create a layout.
To create a paper layout:
My Employees
in the Title field, select Group Above.Table 41-3 Field description of Labels page
Fields | Labels | Width |
---|---|---|
DEPARTMENT_NAME |
|
|
EMPLOYEE_ID |
|
|
START_DATE |
|
|
END_DATE |
|
|
JOB_ID |
|
|
CS_port_count |
|
|
Note: You can open the provided file ref_emp66.rdf and display the Paper Design view to compare your results. |
ref_66_
your_initials
.rdf
.In your current report configuration, the SELECT
statements used by the REF CURSOR
queries reside within the report itself. In many cases, it is advantageous to have SELECT
statements reside in the packages that define the REF CURSOR
types. Then, you can simply reference the packages, rather than typing the same SELECT
statement directly into every report that uses it. If you need to change the SELECT
statement (for example, to modify or add clauses), you simply update it once in the package, rather than in every report that uses it.
The steps in this section will help you to move the SELECT
statements to the packages that define the REF CURSOR
types.
To move SELECT statements into a package:
cont_cv
in the Name field.Note: You can open the provided file refcursor_code.txt to copy and paste the code into Reports Builder. |
END;
statement:When you are done, all of the query's logic will reside in the function named query_container
. From now on, when you change query_container
, you will change this and any other queries that reference it.
Note: You can open the provided file refcursor_code.txt to copy and paste the code into Reports Builder. |
ref_67_
your_initials
.rdf
.Optional Exercise:
Repeat the above steps for the other two queries in the report.
If you have many reports that use these same REF CURSOR
types and SELECT
statements, you can move the program units that you created into a PL/SQL library stored in a file, so that other reports can easily share the code. The steps in this section will help you to move the program units to a PL/SQL library.
To move the packages into a library:
DEPT_CONTAINER
as the Library.DEPT_CONTAINER
.Note: If the Paper Design view is open when you delete the packages from the report, you may get some errors. |
.PLL
file extension. After you have found and selected DEPT_CONTAINER, click Open.ref_68_
your_initials
.rdf
.Congratulations! You have finished the REF CURSOR
query sample report. You now know how to:
REF CURSOR
s.REF CURSOR
queries.REF CURSOR
queries.SELECT
statements into packages.For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about JSP-based Web reports that include a simple Parameter Form. To build a Parameter Form for a paper report, refer to the Oracle Reports online Help. By following the steps in this chapter, you can generate the report output shown in Figure 42-1 and Figure 42-2.
Note: The JSP Parameter Form in this image enables the user to choose from a list of departments, connect to a database, then run a report based on the selected parameters. |
Note: The JSP-based Web report in this image displays a graph and a tabular report based on the department selected in the JSP Parameter Form. To see how this report was built, refer to the Oracle Reports Tutorial. |
Concepts
http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Index. In the Collateral Type list, choose Examples, and click Search. In the list of examples that displays, click Building a JSP-based Web Report with a Parameter Form.Example Scenario
In this example, you have an existing JSP-based Web report that shows a bar graph of employee salaries per department, as well as a tabular report that shows the employee details. Your customers want to see the employee information for a specific department at runtime, so that they do not have to read the data for all departments. The steps in this example show you how to add a JSP Parameter Form to this JSP-based Web report.
This example uses the resulting report from the Oracle Reports Tutorial. If you want to learn how to build the Web report that we use in this example, follow the steps in the tutorial.
As you build this example report, you will:
To see a sample JSP-based Web report that includes a simple Parameter Form, open the examples folder named simplejsppf
, then open results\emprev_param.jsp
. For details on how to open it, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 42-1.
Table 42-1 Example report files
File | Description |
---|---|
| An example HTML Parameter Form, which contains an example List of Values, a field, and a button. |
| This JSP-based Web report contains the modifications to the Parameter Form you will make in Reports Builder. |
| The source Web report that will become the target report for the Parameter Form. |
| The final JSP-based Web report with a JSP Parameter Form. |
Note: If you completed the exercises in the Oracle Reports Tutorial, you can also use the emprevb_ your_initials .jsp file you created at the end of Chapter 6. |
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Human Resources sample schema (HR) provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
The steps in this section will show you how to build a simple Parameter Form using plain HTML. You will then modify this HTML Parameter Form in Reports Builder so that you can call the Parameter Form from your JSP-based Web report.
If you do not want to create your own HTML file, you can open the sample HTML file we have provided in the Source directory, called paramform.html
, then view the source code.
To create a simple Parameter Form in HTML:
Note: Although you can use the above code, you will need to change the userid value to reflect the connection information for your data source. You can also copy and paste the HTML code from the provided file, called simplejsppf_code.txt in the simplejsppf/scripts directory, then modify it in a text or HTML editor. |
paramform_
your_initials
.html
. When you display this HTML file in a Web browser, it should look similar to the following image:In this section, you will learn how to modify an HTML Parameter Form in Reports Builder to populate the list of values (LOV) you created with values from a data source. You will use JSP tags for Oracle Reports to enable the Parameter Form to access elements from a data model.
The steps in this section will show you how to create a simple data model for the Parameter Form.
To create a data model:
paramform_
your_initials
.html
.SELECT
statement:Note: You you can enter this query in any of the following ways:
|
paramform_
your_initials
.jsp
.In this section, you will learn how to modify the Web source to pull data into the existing list of values (LOV) in your Parameter Form. This data will rely on the data model you created in the previous section. We will also examine the code to explain how each element operates.
To modify the LOV in the Parameter Form in Reports Builder:
Note: In the above code, the LOV returns a static value. The display name is "a" and the value is "1". |
Since the LOV is currently static, we need to change this HTML element to dynamically retrieve data based on our data model.
Note: You can either type the code manually or copy and paste it from the provided file called simplejsppf_code.txt . |
Examine the JSP elements in the code:
By using JSP tags for Oracle Reports in the above code, we retrieve data into the Parameter Form's LOV by basing the parameters on fields in the data model. Let us examine each element:
<option>
: The display name of the LOV is replaced by the field department_name
from the data model. When the user displays the Parameter Form, the department name will display in the list.<rw:field>
: This element accesses each element of the g_department_name
group.<rw:foreach>
: This element iterates through the results based on the g_department_name
group in the data model.src
: This parameter is used in both <rw:foreach>
and <rw:field>
elements. For the <rw:foreach>
element, src
must match the group name of the data model (G_department_name
). For the <rw: field>
element, it must match the field that is referred (department_name
).id
: This parameter can be any value, but it must be unique. This parameter also applies to both <rw:foreach>
and <rw:field>
elements.Note: For more infomation on these JSP elements and their parameters, refer to the Oracle Reports online Help. |
By making these modifications to the code, we have replaced the return value attribute of the LOV with the field department_id
, based on the data model we created in the previous section. If we now choose a department name from the list of values, its related department ID is returned. Note that the return value is not displayed.
Now that we have modified and examined our Web source, let us view the Parameter Form in a Web browser.
Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry key HKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
Note: In the modified Parameter Form, notice how the list of values for the Department has changed from "a" to "Accounting." |
Now that you have set up the parameters, the next step is to set up the target report to accept the parameters. Then, we will define the action for your Parameter Form. When a user clicks Run Report, the target report will be run based on the Department and User ID parameters.
The target report we use in this section is the sample report for the Oracle Reports Tutorial. If you completed the exercises in the Oracle Reports Tutorial and created emprevb.jsp
, you can use that report in this section. Otherwise, you can use the example file we have provided, called emprev_final.jsp
. We will not show the steps to build this report in this section.
For more information on building the sample JSP-based Web report, refer to the Oracle Reports Tutorial.
To set up the target report:
emprev_final.jsp
.WHERE
clause so that the last line looks like this:Tip: The code we have changed is in bold text. |
emprev_param_
your_initials
.jsp
.To deploy the JSP Parameter Form and the target JSP-based Web report, you must copy paramform_
your_initials
.jsp
and emprev_final_
your_initials
.jsp
to the deployment directory of your Application Server. Once you have placed the target report in the desired directory, you can then modify the Parameter Form to point to the report location.
For more information on deploying a JSP-based Web report, refer to the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual.
To set up and deploy the JSP Parameter Form and the target report:
paramform_
your_initials
.jsp
and emprev_param_
your_initials
.jsp
) into the following directory:$DOMAIN_HOME\servers\WLS_REPORTS\tmp\_WL_user\reports_11.1.1.2.0\dir_name\war
dir_name
is a randomly generated directory name for each deployment instance.
Note: BEA_HOME is the directory in which Reports Builder is installed. |
$DOMAIN_HOME\servers\WLS_REPORTS\tmp\_WL_user\reports_11.1.1.2.0\dir_name\war\paramform_
your_initials
.jsp
.emprev_param_
your_initials
.jsp
report executes based on the selected parameters. The code should look like this:Notes:
|
startWebLogic.cmd
Where, "<your_domain>
" is the domain created by you.
Where, "<your_domain>
" is the domain created by you.
Tip: The Oracle WebLogic Server instance starts once the containers for Java EE have been initialized. |
your_initials
.jsp?userid=userid/password@database nameIn our example, we would use:
your_initials
.jsp?userid=hr/hr@orclNote: The connect string you type in the URL is for the database you used to create the data model in Section 42.3.1, "Create a data model manually for the Parameter Form". For the purposes of this example, we have used plain text to pass the connect string. You can find more information about security in the chapter "Securing Oracle Reports Services" in the Oracle Fusion Middleware Publishing Reports to the Web with Oracle Reports Services manual. |
emprev_param_
your_initials
.jsp
report uses. For example, hr/hr@orcl
:Note: If you are not sure whether your report appears as it should, try using the files we have provided, paramform.jsp and emprev_param.jsp and follow all the steps in this section to deploy the Parameter Form and the Web report. |
Congratulations! You have created a JSP Parameter Form for an existing Web report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include a barcode. By following the steps in this chapter, you can generate the report output shown in Figure 43-1.
Concepts
Note: For information about the Java Importer, and the ORA_JAVA built-in package, see Oracle Reports online Help topics under Reference > Java Importer. |
http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page. In the list of topic sections on the left, click Any Format. In the expanded list of sub-topics, click PL/SQL-Java Bridge.Example Scenario
In this example, you will build two reports, one for paper and one for the Web. The paper report shows an invoice for a single customer who has ordered multiple items from a company. The barcode indicates the tracking information for the order.
As you build these example reports, you will:
To see a sample paper report with a barcode, open the examples folder named barcodebeanpaper
, then open result\shipping_manifest.pdf
. To see a sample Web-based JSP report with a barcode, open the examples folder named barcodebeanweb
, then open result\shipping_manifest_web.jsp
. For details on how to open these reports, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 43-1.
Table 43-1 Example report files
File | Description |
---|---|
| The final PDF version of the paper report, containing the barcode. |
| The final RDF version of the paper report, containing the barcode. |
| The barcode JavaBean. |
| All the code used in this chapter, so you can copy and paste the code from this file instead of typing it manually. |
| The source file for the sample paper report. Running this RDF in Reports Builder will display the final result of your paper report in the Paper Design view. |
| The final JSP version of the Web report, containing the barcode. |
| The final RDF version of the Web report, containing the barcode. |
| The images that Oracle Reports generated when the JSP was run. |
| The SQL for the query you need to enter. |
| All the code used in this chapter, so you can copy and paste the code from this file instsead of typing it manually. |
| The HTML page that you will use as a basis for the Web report. |
| The source file for the sample Web report. Running this RDF in Reports Builder to the Web will display the final result of your Web report in your browser. |
| The images and other files that your JSP-based Web report will require to display properly on the Web. |
| The image you will use in your JSP-based Web report. |
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Order Entry sample schema provided with the . If you do not know if you have access to this sample schema, contact your database administrator.
Before you use a JavaBean (for a paper-based or JSP-based Web report), you need to perform several steps.
In this section, you will update the REPORTS_CLASSPATH
environment variable with the location of the JavaBean. When you launch Reports Builder, it will use this new class path to recognize the location of the barcode bean.
Note: You must follow the steps in this section before you can even run the finished report we have provided, called ShippingManifestPaper.rdf and ShippingManifestWeb.rdf. |
REPORTS_CLASSPATH
environment variable:regedit
and locate the REPORTS_CLASSPATH
environment variable. You may want to make a backup of your registry before modifying it.REPORTS_CLASSPATH
environment variable in ORACLE_HOME
/bin/reports.sh
.oraclebarcode.jar
file to the existing entries in REPORTS_CLASSPATH
, for example:Examples
\BarcodeBeanPaper\scripts\oraclebarcode.jarExamples
/barcodebeanpaper/scripts/oraclebarcode.jarNote: The path depends on where the files are located. If you downloaded the files from the Oracle Technology Network ( http://www.oracle.com/technology/products/reports/ ), you may have to further edit this path. Also, when you edit the Windows registry, make sure you separate your entries with a semicolon (;), with no spaces on either side of the semicolon. |
You are now ready to begin building your report. To learn how to create a paper-based barcode report, refer to Section 43.2, "Create a Barcode Report for Paper". To learn how to create a JSP-based barcode report for the Web, refer to Section 43.3, "Create a Barcode Report for the Web".
In this section, you will import the barcode JavaBean, then create a paper-based report that shows the invoice for a particular customer. This invoice will display the address of the customer, his order, and a barcode that represents the tracking number for the order. The company can scan this barcode to find out the status of the order.
To create a paper report using the barcode JavaBean, you must first import two Java classes into Reports Builder. When you import these Java classes, Reports Builder automatically creates the packages you need to build the report.
Note: You do not need to perform this task if you are creating a Web report, as you will write JSP code that calls the JavaBean. |
To import the Java classes:
Note: You must launch Reports Builder now so that the new REPORTS_CLASSPATH is used. |
Note: If you do not see this class listed, try exiting Reports Builder and make sure the REPORTS_CLASSPATH reads correctly. Then, launch Reports Builder again. |
oracle.apps.barcode.BarCodeMaker
.In this report, you want to create a package where the information will be stored.
To create a package for storing your information:
globals
.Note: You can also enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
Note: If your code does not compile, make sure you have typed in exactly the code we have provided. |
shippingmanifest_
your_initials
.rdf
.You have created a package that will contain the global information for your report.
You can use a Before Report trigger to perform specific tasks before the report is run. Here, you will define the type of barcode you want to use in your report, as well as the temporary directory where your barcode images will be stored.
To create a Before Report trigger:
your_initials
, expand the Report Triggers node, then double-click the icon next to BEFORE REPORT to display the PL/SQL Editor.To modify the type of barcode you want to use, you can change the value BarCodeConstants.BAR_CODE_128
to any other valid value. To determine which values are valid, check the contents of the package by opening the BarCodeConstants package spec in the Object Navigator, under the Program Units node.
Note: You can enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
Note: If you have errors, make sure you have imported the necessary Java classes and compare your code closely with the code above. If you change the code, be sure to compile it again. |
You have created a trigger that will set up the barcode type for you when you run the report.
In this section, you will manually create the query that the report will use to retrieve data from the sample schema.
To create the query:
your_initials
, double-click the view icon next to the Data Model node to display the Data Model view for your report.SELECT
statement:Note: You can enter this query in any of the following ways:
|
If you are not connected to a database that contains the sample schema we have provided, you must log in now. If you are not sure what your connection string is, contact your database administrator. Note that this example uses the Order Entry sample schema.
p_order_id
was created, click OK.The resulting data model should look like this:
In this section, you will create a formula column that will communicate with the JavaBean to create the barcode, then return the file name of the generated image.
To create a formula column:
Note: You can enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
Note: If you have errors, make sure you have imported the necessary Java classes and compare your code closely with the code above. If you change the code, be sure to compile it again. |
To create the second formula column:
Note: You can enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
You have created the data model for your barcode report, which contains a formula column that retrieves the barcode information and displays the barcode image on your report, and another formula column that displays the order total.
Your data model and the PL/SQL for the formula column should look similar to this:
Before you can run your report, you must create a layout.
To create a paper layout:
2354
.M_G_CUST_FIRST_NAME_GRPFR
, then click the Confine Off button and the Flex Off button in the toolbar.shippingmanifest.rdf
example report as a guide, add three rectangles and three text objects for:Note: If you are not sure whether you produced the desired results, you can always open the example report called ShippingManifest.pdf in Acrobat Reader. Or, you can run ShippingManifest.rdf to paper and the report will display in the Paper Design view. |
The steps in this section show you how to build a JSP-based Web report, using the barcode JavaBean you imported in Section 43.2.1, "Import the Java classes into Reports Builder". If you want to build a paper report with a barcode, see Section 43.2, "Create a Barcode Report for Paper".
If you are not familiar with creating a JSP-based Web report and would like to learn how to create one, refer to the Oracle Reports Tutorial.
The report you will create in this section is the same as the one you created for paper. You will create a report that displays the invoice for a particular customer. This invoice will display the address of the customer, his order, and a barcode that represents the tracking number for the order. The company can use this barcode to find out the status of the order.
You can run the final version of the JSP report we have provided to see what you will build in these steps, but please note that you will need to update the location of the images in the source code (see Section 43.3.3, "Initialize the barcode JavaBean and set its properties") before you can run the report to the Web.
Note: Before you begin this section, make sure you have all the necessary files, and that you have imported the Java classes, and set up the class path. See Section 43.1, "Prerequisites for This Example" and Section 43.2.1, "Import the Java classes into Reports Builder". |
When you create a JSP-based Web report, you can use an existing HTML file as a template. The steps in this section will show you how to open an HTML file in Reports Builder and add data to it.
To create a query in an existing HTML file:
Examples
\barcodebeanweb\source\shipping_label.html
.SELECT
statement:Note: You can enter this query in any of the following ways:
|
If you are not connected to a database that contains the sample schema we have provided, you must log in now. If you are not sure what your connection string is, contact your database administrator. Note that this example uses the Order Entry sample schema.
Your data model should look something like this:
ShippingLabel_
your_initials
.jsp
to create the JSP-based Web source for this report.You have now created the query that will pull in the data for your report.
You will need to create three formula columns in your report to retrieve the tracking number for the order, the origin of the order, and the destination for the order.
To create the TrackingNumber formula column:
Note: You can enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
Note: If your code does not compile, make sure you have typed in exactly the code we have provided. |
To create the OriginScan formula column:
Note: You can enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
Note: If your code does not compile, make sure you have typed in exactly the code we have provided. |
To create the DestinationScan formula column:
Note: You can enter this code by copying and pasting it from the provided text file called barcode_code.txt . |
Note: If your code does not compile, make sure you have typed in exactly the code we have provided. |
You have created the three formula columns that will hold the values for the tracking number, the origin, and the destination of the order. Your data model should look something like this:
To enable your JSP-based Web report to communicate with the JavaBean, you need to initialize it in the JSP. Unlike using the JavaBean with a paper report, you do not need to use the Java importer to import the Java classes.
In this section, you will also learn how to set the properties for the bean so that the correct data is being used to produce the barcode.
If you do not want to bother with typing the code in yourself, you can always open the source file (Examples
/barcodebeanweb/source/shipping_manifest_web.rdf
) and copy the appropriate pieces of the Web source into your report.
To ensure that the JavaBean references the correct barcode images, you must first update your report with the correct path.
To update the paths:
ShippingLabel_
your_initials
) to display the Web Source view.Define Path information for your barcode images
.d:\\temp\\docroot\\images\\
). Be sure to maintain the integrity of the paths we have provided.Note: The directory where these files are located must be accessible by the Web server. This directory is typically located somewhere below the directory where you keep your JSPs. Make sure that this directory exists on your computer before you run the report to the Web. |
To initialize the JavaBean:
initialize the java beans
.Note: You can enter all the code in this section by copying and pasting it from the provided text file called barcode_code.txt . |
To set the barcode JavaBean properties:
setting the barcodes properties.
To define the barcode variables:
Define variables to hold the data for the three barcodes.
To create a For Each loop:
replace this with your RW:FOREACH open tag.
replace this with your RW:FOREACH close tag.
To code the formula columns to render the barcodes:
**BARCODEShippingTrackingNumber**
.Note: The lines beginning with "<!--" are comments. If you do not want comments in your code, you do not have to add these lines. |
**BARCODEOriginScan**
.**BARCODEDestinationScan**
.Since you have created a Web report, you must run this report to the Web to see your results.
your_initials
.Note: If Netscape 7.0 is your default browser, and the browser does not display, set the registry key HKEY_CURRENT_USERS\Software\Oracle\Toolkit\Tkbrowser to the default browser location. Ensure that the BrowserName and the BrowserPath keys reflect the correct values. For example: BrowserName=Netscape 7 ; BrowserPath=C:\Program Files\Netscape\Netscape\Netscp.exe . |
Your report displays in your Web browser, and should look something like this:
Note: If you are not sure whether you produced the desired results, you can always open the file we provided in the results directory, called ShippingManifestWeb.html in your Web browser. Or, once you have updated the images path, you can run ShippingManifestWeb.jsp to the Web, and the report will display in the your browser. |
Congratulations! You have created a paper report and a JSP-based Web report that use the barcode JavaBean to generate barcode images.
You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
Using Oracle Reports and the standards defined in the Web Accessibility Guidelines, you can create a report that produces output that is compatible with assistive technologies such as screen readers. Oracle Reports provides properties and tags to support this effort.
On the Oracle accessibility site (http://www.oracle.com/accessibility
), you can learn more about accessibility and find the Creating Accessible Enterprise Reports using Oracle Reports white paper.
To learn more about creating accessible Web reports, refer to the example on the Oracle Technology Network (OTN):
http://www.oracle.com/technology/products/reports/index.html
), click Getting Started to display the Getting Started with Oracle Reports home page.This part introduces reports that use data sources other than the SQL data source accessing relational data in an Oracle database. These reports use data sources available with Oracle Reports or combine information from one or more of these data sources to publish meaningful information.
This part contains the following chapters:
A report with an XML pluggable data source enables you to connect to any data source that is available with Oracle Reports, for example XML data. Usage of alternate data sources is possible due to the pluggable data source (PDS) architecture of Oracle Reports Builder.
A report can contain a text pluggable data source, such as a report that uses character-delimited text as a data source.
In this chapter, you will learn about reports that include data from an XML pluggable data source (PDS), which is provided with Oracle Reports. By following the steps in this chapter, you can generate the report output shown in Figure 45-1.
Concepts
WAREHOUSE_ID
first, and PRODUCT_ID
second. In this scenario, WAREHOUSE_ID
must come before PRODUCT_ID
in your XML data file, too. The names of the elements do not need to match. For example, given the following XML data file:A valid XML schema with suffix xsd
for the above XML is as follows:
Example 45-1 shows an XML data file that includes G_DEPTNO
elements with nested G_EMPNO
elements. Oracle Reports parses all the departments, but not all the employees within each department. For each department, only one employee record would be shown.
Example 45-2 shows how you can modify this XML data file to "flatten" the data. In the example, you will see that the G_DEPTNO
elements include the G_EMPNO
data, without nesting. Now, Oracle Reports parses all the departments, including all the employees within each department.
Example 45-3 and Example 45-4 show the corresponding XML schema files for "nested" and "flattened" XML data, respectively.
Example 45-1 "Nested" XML Data File
Example 45-2 "Flattened" XML Data File
Example 45-3 Corresponding "Nested" XML Schema File
Example 45-4 Corresponding "Flattened" XML Schema File
Example Scenario
In this example, you have an international business with warehouses in the United States and overseas. These warehouses are running a decentralized management system that stores the operational data locally at each site. The inventory of the warehouses are managed by the local managers. However, for planning purposes, a team at corporate headquarters needs to access the inventory data (in SQL), including the most recent data, of every warehouse. The warehouse data is only available as an XML stream. You will learn how to combine data from a local database (that is, the warehouse data) and data from an XML feed to create a Web report. You will use static XML files that are provided.
As you build this example report, you will:
To see a sample report that uses an XML PDS, open the examples folder named xml_pds
, then open inventory_report.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 45-1.
Table 45-1 Example report files
File | Description |
---|---|
| The final PDF version of the paper report. |
| The final RDF version of the paper report. |
| The various SQL statements you will use in this report. |
| The XML data source for the query in your report. |
| The XML data stream for your report. |
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above), as well as access to the Order Entry sample schema provided with the Oracle Database. If you do not know if you have access to this sample schema, contact your database administrator.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. To build this report, you will need to create two queries: a SQL query and an XML query.
To create a SQL query:
Your new report displays in the Object Navigator as something like MODULE 2. You will also see the Data Model view of your new report.
SELECT
statement:Note: You can enter this query in any of the following ways:
|
Note: If the Connect dialog box displays, enter the user ID, password, and name of the database that contains the sample schema. |
The data model displays in the Data Model view, and should look something like this:
inventoryreport_xml_
your_initials
.rdf
.You have created a SQL query to retrieve the data for your report.
In this section, you will create a query to access the XML data source. You can view the resulting report we have provided to make sure your query is correct. Please note that you must update the paths to the Data Definition files with the location of the example files we provided.
To create an XML query:
warehouse_inventory.xsd
and open it.warehouse_inventory.xml
and open it.If you want to compare your data definition to the one we provided, make sure that you replace the data definition locations with the locations of your files.
You have created an XML query to access the XML data source we have provided.
You will now need to link the SQL query and the XML query so that you can access your corporate data as well as the data for each of the local warehouses.
To create a data link:
Your data model should now look something like this:
You will notice that the WAREHOUSE_ID column is now highlighted at the bottom of Q_1, with a line pointing to the WAREHOUSE_ID1 column.
You have created a data link between the WAREHOUSE_ID columns in the two queries.
Before you can run any report, you must define a layout. The easiest way to do this is to use the Report Wizard.
To create a paper layout:
You have created the layout for your paper report.
Note: You can also run the provided report inventory_report.rdf . Before you can run the report, double-click the XML query in the Data Model view, and point the XML data source to the appropriate XSD and XML files. |
Now that you have created the report, you can make it more user-friendly by using a summary column to apply alternating row colors.
To create a summary column to count the rows:
If you are still in the Paper Design view, you can click the Data Model button in the toolbar to display the Data Model view.
To create a procedure that changes the row colors:
linecolors
as in the Name field.Note: You can copy and paste this code from the procedure provided in the xmlpds_code.txt file. Just copy the text under Line Colors Procedure . |
If any errors display, make sure the code is correct, and that you created the summary column in the steps above.
Note: Optionally, you can also change the fill colors of the alternating rows by following the steps in the above section, and using the following PL/SQL code. In this example code, we have changed the fill color of alternating rows to red and blue: PROCEDURE LineColors IS BEGIN if (:LineNo mod 2=0) then srw.set_foreground_fill_color('blue'); srw.set_fill_pattern('solid'); else srw.set_foreground_fill_color('red'); srw.set_fill_pattern('solid'); end if; END; |
To create a format trigger for each field that calls the procedure:
Note: If you cannot find a particular field, use the Find field at the top of the Object Navigator. |
Note: Make sure you do not touch the boldface text. Simply type in the code below this text to create the format trigger. You can copy and paste this code from the procedure provided in the xmlpds_code.txt file. Just copy the text under Format Trigger Code. |
You have now applied alternating row colors to your report.
If you have a lot of data in your XML file, you might want to consider sorting and filtering it. You can do so by creating a group filter and a hierarchy. The steps in this section will show you how to create a filter that will only show the inventory items for a user-defined quantity amount. The filter will be based on a parameter that the user can enter at runtime. You will then create a hierarchy in your data model to group the data in your report.
To create a user parameter and a group filter:
P_MAXQTY
, with a Datatype of Number, Width of 20, and Initial Value of 50 (see Section 4.11.2, "Creating a user parameter").Note: You can also copy and paste this code from the provided file called xmlpds_code.txt . Copy the code under the heading "Group Filter Code." |
Note: If you are not familiar with compiling PL/SQL, refer to a PL/SQL reference manual. |
You can also run the provided report inventoryreport.rdf
to view the results in Reports Builder.
To create a hierarchy for the XML query:
Your data model should look like this:
Note: Notice in the above image that a green circle displays above G_WAREHOUSE_ID1. This circle indicates that a group filter has been created for the group. |
To run your paper report:
inventoryreport_xml_
your_initials
.rdf
) is selected.Congratulations! You have successfully used an XML data source for a paper report. You now know how to:
For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
In this chapter, you will learn about reports that include data from a Text pluggable data source (PDS), which is provided with Oracle Reports. By following the steps in this chapter, you can generate the report output shown in Figure 46-1.
Concepts
Example Scenario
In this example, you have downloaded the US Census Bureau data in CSV (comma-separated values) format and want to generate a report. You will learn how to use character-delimited text as a data source to create a paper report.
As you build this example report, you will:
To see a sample report that uses a Text PDS, open the examples folder named text_pds
, then open census_report.rdf
. For details on how to open it, see "Accessing the Example Reports" in the Preface. The example files used in this chapter are listed and described in Table 46-1.
Table 46-1 Example report files
File | Description |
---|---|
| The finished RDF for your report. |
| A PDF version of your finished report. |
| The character-delimited data downloaded from the US Census Bureau Web site. |
| Code for the |
To build the example in this chapter, you must have the example files we have provided (see "Example Scenario", above).
Before you can use a text file as a data source, you must set up the Text PDS configuration file (textpds.conf
) with your text file's format information. With this data definition in the configuration file, Oracle Reports Builder can recognize your text file as a valid data source.
Note: You must edit your configuration file before you launch or restart Reports Builder for the changes to take effect. |
To set up your textpds.conf:
textpds.conf
, located in the ORACLE_HOME
/reports/conf
directory.Note: ORACLE_HOME is where Reports Builder is installed on your computer. |
config.txt
file.config.txt
and paste it into textpds.conf
before the </textPDS>
entry, so that the resulting textpds.conf
file contains an entry like this:Note: The fileFormat entry in textpds.conf enables Reports Builder to recognize your text file as a data source. When you choose Text PDS in the Report Wizard, the defined format (CensusCSV , in this example) displays as an option. In the fileFormat entry, you also define the properties of each column in the file. |
textpds.conf
file.You have set up your textpds.conf
file for the character-delimited text data source.
When you create a report, you can either use the Report Wizard to assist you or create the report yourself. To build the simple report in this example, you can use the Report Wizard.
Before you use a Text pluggable data source, you might want to examine the text file first to see what it looks like. You can open the census_csv.txt
file in a text editor, like Notepad or WordPad, to see the data we will be using in this example.
To create a simple report:
textpds.conf
file, launch Reports Builder.Tip: If Reports Builder was already open when you modified the textpds.conf file, you must shut down Reports Builder and restart it for Reports Builder to recognize your text file as a valid data source. |
If you get an error message and cannot display the Define Text Query dialog box, check your configuration file (textpds.conf
) to confirm the code you added.
Note: The CensusCSV format displays in this list because you added it to the textpds.conf file. |
census_csv.txt
.If you do not see the file listed in your directory, make sure you have selected TXT files in the Files of Type list in the Open dialog box.
census_csv.txt
file displays in the Location field, click OK.In the Report Wizard, the data source definition displays in the Data Source definition field.
census_report_
your_initials
.rdf
.Note: You can compare your results against the report we have provided in the examples directory. Before you can run the report, however, follow these steps:
|
Congratulations! You have successfully used a Text pluggable data source for a paper report. You now know how to:
textpds.conf
file.For more information on any of the wizards, views, or properties used in this example, refer to the Oracle Reports online Help, which is available in Oracle Reports Builder or hosted on the Oracle Technology Network (OTN), as described in Section 4.1.1, "Using the Oracle Reports online Help".
This appendix provides descriptions of the buttons and tools in the Reports Builder main toolbar and tool palettes.
The main toolbar is located at the top of the Oracle Reports Builder window, directly beneath the menu bar, as shown in Figure A-1:
The name and purpose of each button is as follows:
Icon | Description |
---|---|
![]() | New button. Displays the New Report dialog box. |
![]() | Open button. Displays the Open dialog box. |
![]() | Save button. Saves the report. If you have not saved the report before, the Save As dialog box displays. |
![]() | Print button. Prints the paper report. |
![]() | Mail button. Displays the Mail dialog box. |
![]() | Connect button. Displays the Connect dialog box. |
![]() | Cut button. Deletes the currently selected item and temporarily places it in the clipboard. Use Paste to paste the selected item. |
![]() | Copy button. Temporarily places a copy of the selected item in the clipboard. Click the Paste button to paste the selected item. |
![]() | Paste button. Pastes the item in the clipboard in current location of the cursor. |
![]() | Undo button. Undoes the last action performed. |
![]() | Redo button. Performs the last action again. |
![]() | Run Web Layout button. Runs the current report to your Web browser. |
![]() | Run Paper Layout button. Runs the current report to the Paper Design view in Reports Builder. |
![]() | Help button. Displays the Oracle Reports online Help. |
The Data Model view tool palette is a vertical group of tools located on the left-hand side of the Data Model view, as shown in Figure A-2.
The name and purpose of each tool is as follows:
Icon | Description |
---|---|
![]() | Select tool. Deselects any selected tool to "turn off" the current tool, and allow you to select any object in the Data Model view. |
![]() | Magnify tool. Zooms in the view on the clicked object. Hold down the SHIFT key when you click the Magnify tool to zoom out. |
![]() | Summary Column tool. Creates a summary column in the query. |
![]() | Data Link tool. Creates a master-detail relationship between queries when you drag a line to define the relationship between the key columns in the two queries. |
![]() | Formula Column tool. Creates a formula column in the query. |
![]() | Cross Product tool. Creates a matrix (cross-product) group. |
![]() | Placeholder Column tool. Creates a placeholder column which you can modify later. |
![]() | SQL Query tool. Displays the SQL Query Statement dialog box where you can enter a SQL query SELECT statement or use Query Builder to create a query. |
![]() | Ref Cursor Query tool. Displays the PL/SQL Editor where you can type a REF CURSOR query. |
![]() | XML Query tool. Displays the Define XML Query dialog box, where you can specify the XML data definition and data source. |
![]() | JDBC Query tool. Displays the JDBC Query dialog box, where you can define the SQL or stored procedure to define the data for the query. |
![]() | Text Query tool. Displays the Text Query dialog box, where you can specify a text data definition and data source. |
The Paper Layout view tool palette is a vertical group of tools located on the left-hand side of the Paper Layout view, as shown in Figure A-3.
The name and purpose of each tool is as follows:
Icon | Description |
---|---|
![]() | Select tool. Deselects any selected tool to "turn off" the current tool, and allow you to select any object in the Paper Layout view. |
![]() | Magnify tool. Zooms in the view on the clicked object. Hold down the SHIFT key when you click the Magnify tool to zoom out. |
![]() | Frame Select tool. Selects all objects within the selected frame or repeating frame, depending upon their explicit anchors (first click the tool, then the frame). |
![]() | Reshape tool. Enables you to reshape the selected objects. |
![]() | Text tool. Creates a boilerplate text object. |
![]() | Rotate tool. Enables you to rotate the direction of the selected boilerplate text and graphic objects. |
![]() | Line tool. Draws a line boilerplate object. |
![]() | Rectangle tool. Draws a rectangle boilerplate object. |
![]() | Arc tool. Draws an arc boilerplate image. |
![]() | Rounded Rectangle tool. Draws a rounded rectangle boilerplate object. |
![]() | Polyline tool. Draws an open multilined boilerplate object. Use your mouse to create the multiple lines. |
![]() | Polygon tool. Draws a multisided boilerplate object. The object must be closed, unlike a polyline object. |
![]() | Freehand tool. Draws a line where you drag your mouse. |
![]() | Ellipse tool. Draws an ellipse boilerplate object. |
![]() | Frame tool. Draws a frame. |
![]() | Repeating Frame tool. Draws a repeating frame. |
![]() | Graph tool. Displays the Graph Wizard so that you can to define a graph that will be inserted into your layout. |
![]() | Field tool. Creates a field object. |
![]() | Anchor tool. Creates an anchor between two objects in your layout. |
![]() | File Link tool. Creates a link file object that you can use to link an external file to your report. |
![]() | Report Block tool. Displays the Report Block wizard so that you can add a new report block to your layout. |
AFM
Acronym for Adobe Font Metrics. AFM and PPD files are supplied by Adobe and by printer vendors. These files contain information about the printer. Along with other parameters, these files are read for the information about the available fonts for the printer, which Oracle Reports will use. For all the fonts listed in the PPD file, Oracle Reports searches for the corresponding AFM file according to the font name and loads all of the fonts for which there is an available AFM.
CGI
Acronym for Common Gateway Interface. A standard for transferring information between a Web server and a CGI program. CGI specifies how to pass arguments to the program as part of the HTTP request, and defines a set of environment variables that are made available to the program. The program then generates output to pass back to the browser. CGI provides server-side processing to allow Web servers to interact dynamically with users.
column
data model
A relational model that defines what data should be fetched from the data source(s), what values should be computed, and how data should be ordered in a report. Reports Builder objects that define the data model are queries, groups, columns, parameters, and links.
Data Model view
One of the views of the Report Editor that displays a structural representation of the data in a report. The objects do not appear in the report output, but the structure determines the layout style, and the data objects provide the values that appear in the layout objects.
database
A source for data returned by a query, including database objects such as tables, views, synonyms, snapshots, and queries stored as views. Oracle Reports Services enables you to access any data source.
A set of dictionary tables and user tables that are treated as a unit.
data source
A source for data returned by a query, including database objects such as tables, views, synonyms, snapshots, and queries stored as views. Oracle Reports Services enables you to access any data source.
The pluggable data source (PDS) architecture replaces Oracle Open Client Adapter (OCA), and the Open Database Connectivity (ODBC) drivers are obsolete in Oracle Reports. However, Java Database Connectivity (JDBC) is one of the pluggable data sources available that can utilize the JDBC-ODBC bridge, allowing access to other data sources.
detail query
When defining a master/detail report, the detail query retrieves all related records for each record retrieved by the master, or parent, query.
dialog box
A partial screen or window that prompts you to enter information necessary to complete an operation.
disabled
An interface element state that means a menu item, button, and so on, cannot be used in the current context (that is, it does not respond to keyboard or mouse input).
enabled
An interface element state that means that a menu item, button, and so on, can be used in the current context (that is, it responds to keyboard or cursor/mouse input).
field
foreign key
A value or column in one table that refers to a primary key in another table.
format mask
A setting that defines the appearance of the value of a field. For example, a format mask is used to specify the display of currency amounts and dates.
format trigger
A PL/SQL function that enables you to dynamically change the formatting attributes of an object.
formula column
A user-created column that gets its data from a PL/SQL function or expression, a SQL statement, or a combination of these.
frame
A layout object used to enclose other layout objects and control the formatting, frequency, and positioning of several objects simultaneously.
group
HTML
Acronym for HyperText Markup Language. A tag-based ASCII language used to specify the content and links to other documents on Web servers on the Internet. End users with Web browsers view HTML documents and follow links to display other documents.
HTTP
Acronym for HyperText Transfer Protocol. The protocol used to carry Web traffic between a Web browser computer and the Web server being accessed.
hyperlink
A reference (link) from some point in one document to (some point in) another document or another place in the same document. A Web browser usually displays a hyperlink in some distinguishing way (in a different color, font or style). When users activate hyperlinks (by clicking on them with a mouse) the browser displays the target of the link.
IANA
Acronym for Internet Assigned Numbers Authority. An organization working under the auspices of the Internet Architecture Board (IAB) that is responsible for assigning new Internet-wide IP addresses. IANA-defined character sets refers to those character sets that can be defined for the charset
tag and may be used in the Internet.
icon
A graphic representation of a window or tool.
image
A bitmapped object that can be stored and loaded into an application. The client cannot modify an imported image.
intranet
An internal TCP/IP network, access to which is restricted (through a firewall) to individuals inside the company or organization. An intranet provides similar services within an organization to those provided by the Internet, but is not necessarily connected to the Internet. A common example of an intranet is when a company sets up one or more Web servers on an internal network for distribution of information or applications within the company.
Java
A computer language that supports programming for the Internet in the form of platform-independent "servlets" or "applets".
Java EE
Acronym for Java Platform, Enterprise Edition. An environment for developing and deploying enterprise applications in Java consisting of a set of services, application programming interfaces, and protocols that provide for developing multitiered, Web-based applications.
JAR
Acronym for Java ARchive. A file used for aggregating many files (Java class files, images, and so on) into one file.
JSP
Acronym for JavaServer Page. JSP technology is an extension to the Java Servlet technology from Sun Microsystems that provides a simple programming vehicle for displaying dynamic content on a Web page. JSP is a server-side technology. A JSP is an HTML page with embedded Java source code that is executed in the Web server or application server. The HTML provides the page layout that is returned to the Web browser, and the Java provides the business logic.
margin
An optional report region that appears at the top and bottom of each logical page in a report section (Header, Main, or Trailer). The margin may include any layout object, but typically contains boilerplate and fields (for page numbers, page totals, grand totals, and current date and time).
object
Object Navigator
A hierarchical browsing and editing interface that enables you to locate and manipulate application objects quickly and easily. Features include:
Oracle Fusion Middleware (OracleAS)
A strategic platform for network application deployment. By moving application logic to application servers and deploying network clients, organizations can realize substantial savings through reduced complexity, better manageability, and simplified development and deployment. OracleAS provides the only business-critical platform that offers easy database Web publishing and complete legacy integration while transitioning from traditional client/server to network application architectures.
Oracle Developer Suite
A pre-11g suite of components that combined leading Oracle application development and business intelligence tools into a single, integrated product. Built on Internet standards such as Java and XML, the suite provided a complete and highly productive development environment for building applications for Oracle Application Server and the Oracle database. In Oracle Fusion Middleware, you can install the Developer Tools to install the 11g Release 1 (11.1.1) versions of these components (Oracle Oracle Reports Builder, Oracle Forms Builder, and so on).
ORACLE_HOME
An alternate name for the top directory in the Oracle directory hierarchy on some directory-based operating systems. An environment variable that indicates the root directory of Oracle products.
You can refer to the directory specified by ORACLE_HOME
in syntax:
On UNIX: $ORACLE_HOME
On Windows: %ORACLE_HOME%
Oracle Portal
A browser-based development tool for building scalable, secure, extensible HTML applications and Web sites. Oracle Reports Services uses Oracle Portal to control end user access to reports published on the Web by storing information about report requests, the secured server, and any Oracle Reports Services printer used to print report output.
Oracle Reports Bridge
Oracle Reports Bridge (rwbridge
) provides functionality for discovering a Reports Server across Farms.
Oracle Reports Client (rwclient
)
An Oracle Reports component that provides a command-line interface to send a report to a remote Reports Server (rwserver
).
Oracle Reports Builder (rwbuilder
)
An Oracle Reports component that provides the report building component of Oracle Reports. Report developers use the Oracle Reports Builder design-time user interface to create and maintain report definitions. For more information, refer to the Oracle Reports Online Help (select Help > Contents in Oracle Reports Builder), and the Oracle Reports Building Reports manual.
Oracle Reports Runtime (rwrun
)
An Oracle Reports component that runs a report using the Oracle Reports Services in-process server.
Oracle Reports Services
The runtime environment that executes, distributes, and publishes your reports for enterprise wide reporting. Using Oracle Reports Services to deploy your reports results in gains of flexibility, time savings, and processing capacity.
Oracle Reports Servlet (rwservlet
)
A component of Oracle Reports Services that translates and delivers information between either a Web Server or a Java EE Container (for example, Oracle WebLogic Server) and the Reports Server, enabling you to run a report dynamically from your Web browser.
Oracle Reports Queue Manager (rwrqm
)
(Windows only) Maintains timestamp and status information about reports jobs managed by the Reports Server (rwserver
).
Paper Design view
One of the views of the Report Editor that displays output for paper reports and enables you to make many commonly required, simple modifications to the layout, such as spacing, formatting fields, color, and editing text, without having to open the Paper Layout view.
Paper Layout view
One of the views of the Report Editor that displays the layout objects in a paper report and enables you to make many modifications to any layout object. All layout objects have properties that you can modify using the Property Inspector. The hierarchy of the layout objects is determined by the Data Model.
Paper Parameter Form view
Displays the layout of the Parameter Form that, at runtime, allows user input of parameter values in the Runtime Parameter Form.
Acronym for Portable Document Format. A file format (native for Adobe Acrobat) for representing documents in a manner that is independent of the original application software, hardware, and operating system used to create the documents. A PDF file can describe documents containing any combination of text, graphics, and images in a device-independent and resolution independent format.
PL/SQL
Oracle's proprietary extension to the SQL language. Adds procedural and other constructs to SQL that make it suitable for writing applications.
PPD
Acronymn for PostScript Printer Definition. PPD and AFM files are supplied by Adobe and by printer vendors. These files contain information about the printer. Along with other parameters, these files are read for the information about the available fonts for the printer, which Oracle Reports will use. For all the fonts listed in the PPD file, Oracle Reports searches for the corresponding AFM file according to the font name and loads all of the fonts for which there is an available AFM.
Property Inspector
A window that enables you to view, locate, and set the properties of the currently selected object(s) in the Object Navigator, Report Editor, and Template Editor. Every Reports Builder object (query, group, frame, parameter, and so on) has associated properties that can be viewed using the Property Inspector. The Property Inspector features:
To get help on any property, click the property in the Property Inspector and press F1.
query
A SQL SELECT statement that specifies the data you wish to retrieve from one or more tables or views of a database.
RDF file
A file that contains a single report definition in binary format. .RDF files are used to both run and edit reports.
record
One row fetched by a SQL SELECT statement.
REP file
A file that contains a single report definition in binary format. .REP files are used solely to run reports; you cannot edit a .REP file.
repeating frame
A layout object used to display rows of data that are fetched for a group.
Reports CGI (rwcgi
)
Note: Reports CGI ( rwcgi ) is deprecated (maintained only for backward compatibility); instead, use Reports JSPs, rwservlet (Reports Servlet), or Reports Web Services. |
An Oracle Reports component, also known as the Common Gateway Interface (CGI) or Reports Web Cartridge, that translates and delivers information between either a Web Server or a Java EE Container (for example, Oracle WebLogic Server) and the Reports Server, to run a report dynamically from your Web browser.
Report Editor
The Oracle Reports Builder window that provides different views to help you handle the data objects and layout objects for Web and paper reports. The views are:
Reports Engine
A component of Oracle Reports Services that fetches data from the data source, formats the report, send output to cache, and notifies the Reports Server that the job is ready.
Reports Server (rwserver
)
Reports Server (rwserver
) is an Oracle Reports component that provides reporting services to execute, distribute, and publish your reports for enterprise-wide reporting. A component of Oracle Reports Services that processes client requests, including user authentication, scheduling, caching, and report distribution. Use Oracle Reports clients such as Oracle Reports Servlet (rwservlet
), Reports JSP, and Oracle Reports Client (rwclient
) to send a report to Reports Server.
row
One set of field values in a table; for example, the fields representing one employee in the example table EMP.
Runtime Parameter Form
A screen or window appearing optionally at runtime in which a user can modify print options and parameters prior to report execution.
schema
A collection of related database objects, usually grouped by database user ID. Schema objects include tables, views, sequences, stored program units, synonyms, indexes, clusters, and database links.
SELECT statement
A SQL statement that specifies which rows and columns to fetch from one or more tables or views.
servlet
A Java application that runs in a Web server or application server and provides server-side processing, typically to access a database or perform e-commerce processing. Because they are written in Java, servlets are portable between servers and operating systems.
The Reports Servlet (rwservlet
) and JSP are components of Oracle Reports Services that process custom (JSP) report tags and deliver information between the Oracle HTTP Server and the Reports Server.
SQL
A standard interface for storing and retrieving information in a relational database. SQL is an acronym for Structured Query Language.
SQL file
A file that contains a query stored in text (for example, ASCII or EBCDIC) format.
SQL script
A file containing SQL statements that you can run to perform database administration quickly and easily. Several SQL scripts are shipped with Oracle products.
SQL statement
A SQL instruction to Oracle. A SELECT statement is one type of SQL statement.
style sheet
HTML extensions that provide powerful formatting flexibility in HTML documents. To view an HTML document that takes advantage of style sheets, display it in a browser that supports style sheets.
table
A named collection of related information, stored in a relational database or server, in a two-dimensional grid that is made up of rows and columns.
tabular
A default layout displaying labels at the top of the page and rows of data underneath the labels.
template
A skeleton definition containing common style and standards, and may include graphics. A template provides a standard format to enable quick and easy development of professional standard look-and-feel reports.
Template Editor
A work area in which you can define objects and formatting properties for your templates. It is similar to the Paper Layout view of the Report Editor. You can create, delete, and modify objects (for example, page numbers, text, and graphics) in the margin area. You cannot create and delete objects in the body area, but you can modify the properties of body objects in the Property Inspector.
tool
An iconic button used to create and manipulate objects in an application.
tool palette
A collection of tools represented by iconic buttons in the user interface that allow a report developer to perform tasks, such as drawing a rectangle in the Paper Layout view or creating a query in the Data Model view.
toolbar
A collection of iconic buttons that perform product commands. Usually aligned horizontally along the top, or vertically down the side of a window.
URL
Acronym for Uniform Resource Locator. A compact string representation of the location for a resource that is available through the Internet. It is also the text string format clients use to encode requests to OracleAS.
view
Web browser
A program that end users utilize to read HTML documents and programs stored on a computer (serviced by a Web server).
Web server
A server process (HTTP daemon) running at a Web site which sends out Web pages in response to HTTP requests from remote Web browsers.
Web Source view
One of the views of the Report Editor that displays the HTML or JSP source for a report. You can use this view to add dynamic content to a Web page using the Report Block Wizard and the Graph Wizard. Experienced Java developers can edit the Web source directly in this view.
A step-by-step interface for commonly performed tasks. The wizards in Reports Builder are:
XML
Acronym for Extensible Markup Language. A metalanguage using SGML to define and structure data. Reports Builder supports XML output to enable Web publishing as well as electronic data exchange with third-party applications. You can also use XML to build report definitions that can be merged with other report definitions at runtime or run separately.
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